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ΚΕΦΑΛΑΙΟ 1: ΛΗΨΗ ΑΠΟΦΑΣΕΩΝ 

 

ΕΙΣΑΓΩΓΗ 

Κάθε οργανωμένο κοινωνικό σύνολο, δηλαδή κάθε επιχείρηση αλλά και κάθε 

μεμονωμένο άτομο αντιμετωπίζουν καθημερινά μία πληθώρα προβλημάτων που 

έχουν τη μορφή διλημματικών καταστάσεων, απαιτούν δηλαδή την επιλογή μίας 

μεταξύ περισσότερων εναλλακτικών λύσεων. Ο τρόπος επίλυσης αυτών των 

προβλημάτων και η λύση που προκρίνεται σε κάθε περίπτωση καθορίζουν την 

αποτελεσματικότητα της λειτουργίας και την κατεύθυνση εξέλιξης του κοινωνικού 

συνόλου ή/και των συστημάτων και ατόμων που απαρτίζουν το σύνολο αυτό. Η 

επιλογή λύσης συνιστά μία απόφαση, ενώ η προσέγγιση που ακολουθείται για την 

εύρεση της λύσης αποτελεί τη διαδικασία λήψης απόφασης. 

Σε πολλές περιπτώσεις, ο διλημματικός χαρακτήρας των αποφάσεων δεν είναι 

εμφανής. Για παράδειγμα, όταν εξετάζεται η αποδοχή μίας συγκεκριμένης 

επενδυτικής πρότασης, το δίλημμα που τίθεται στην πραγματικότητα είναι η 

υιοθέτηση ή απόρριψη αυτής της πρότασης. Αντίστοιχα, η απουσία δράσης ή 

απόφασης υποδηλώνει επίσης μία προγενέστερη απόφαση, την απόφαση να μην 

υιοθετηθεί οποιαδήποτε δράση και να παραμείνουν τα πράγματα ως έχουν. Σε κάθε 

περίπτωση επιδιώκεται η απόφαση να οδηγεί σε βελτίωση της παρούσας 

κατάστασης, πολύ περισσότερο δε να οδηγεί στη μέγιστη δυνατή βελτίωση. 

 

1.1 ΔΥΣΚΟΛΙΕΣ ΔΙΑΔΙΚΑΣΙΑΣ ΛΗΨΗΣ ΑΠΟΦΑΣΕΩΝ 

Στη σύγχρονη πραγματικότητα η λήψη των αποφάσεων (ΛΑ) αντιμετωπίζει 

πολλές δυσκολίες, έτσι ώστε να μην είναι πάντα προφανές αν μία λύση οδηγεί σε 

βελτίωση της υπάρχουσας κατάστασης και κυρίως, ποια από τις περισσότερες 

εναλλακτικές λύσεις οδηγεί στο βέλτιστο αποτέλεσμα 

Οι βασικοί παράγοντες που δημιουργούν αυτές τις δυσκολίες είναι :  

1. Η πολυπλοκότητα των σύγχρονων συστημάτων και η ύπαρξη 

πολλαπλών αλληλεξαρτώμενων παραμέτρων που δυσχεραίνουν τον εντοπισμό 
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των διαθέσιμων λύσεων και κυρίως την εκτίμηση των επιπτώσεων από την 

εφαρμογή τους.  

2. Η αβεβαιότητα που ενυπάρχει στις περισσότερες καταστάσεις ΛΑ. Η 

αβεβαιότητα αυτή πηγάζει από την έλλειψη ή ανεπάρκεια των αναγκαίων 

δεδομένων, την αδυναμία πρόβλεψης της μελλοντικής εξέλιξης κρίσιμων 

παραμέτρων, την περιορισμένη επιστημονική γνώση σε σχέση με φαινόμενα και 

μηχανισμούς, αλλά και από την ίδια την αδυναμία αυτών που λαμβάνουν τις 

αποφάσεις να προσδιορίσουν τους στόχους και τις προτιμήσεις τους 

3. Η πολλαπλότητα στόχων τους οποίους συνειδητά ή ασυνείδητα 

επιδιώκουν οι λαμβάνοντες τις αποφάσεις που δυσχεραίνει την επίλυση του 

προβλήματος, καθώς κατά κανόνα δεν υπάρχει μία λύση που να επιτυγχάνει 

πλήρη ικανοποίηση όλων των στόχων ταυτόχρονα. Κατά συνέπεια, η ΛΑ 

προϋποθέτει την αναγνώριση και επίλυση των σχετικών διλημμάτων, 

προσδιορίζοντας την ανεκτή απομάκρυνση από έναν στόχο προκειμένου να 

προσεγγισθεί περισσότερο ένας ή περισσότεροι άλλοι στόχοι.  

4. Ο μεγάλος αριθμός των εμπλεκομένων, δηλαδή όσων συμμετέχουν 

στη ΛΑ ή επηρεάζονται -άμεσα ή έμμεσα- από τις συνέπειες αυτής της απόφασης 

περιπλέκει τη διαδικασία καθώς κάθε πλευρά έχει ιδιαίτερη αντίληψη για τη φύση 

του προβλήματος, τις ενδεδειγμένες λύσεις και τη σχετική σημαντικότητα των 

επιπτώσεων κάθε λύσης. Η συμμετοχή όλων των εμπλεκομένων στη διαδικασία 

διευρύνει την οπτική θεώρησης του προβλήματος και συμβάλλει στην αναγκαία 

για την επιτυχή εφαρμογή της λύσης συναίνεση. 

 

1.2  ΣΥΣΤΗΜΙΚΗ ΠΡΟΣΕΓΓΙΣΗ 

Η συστημική προσέγγιση παρέχει το αναλυτικό υπόβαθρο μέσα στο οποίο θα 

πρέπει να αναπτυχθεί η διαδικασία ΛΑ. Οι αρχές και απαιτήσεις μίας συστημικής 

προσέγγισης απορρέουν από την ίδια την έννοια του συστήματος που ορίζεται ως 

ένα περίπλοκο  και οργανωμένο σύνολο περισσότερων διακριτών αλλά 

αλληλεξαρτώμενων ή/και αλληλεπικαλυπτόμενων τμημάτων/υποσυστημάτων.  

Η συστημική προσέγγιση ενός προβλήματος επιβάλλει τη διερεύνηση του σε 

συνάρτηση με τα χαρακτηριστικά του συστήματος μέσα στο οποίο το πρόβλημα αυτό 

ανακύπτει και με βάση τις σχέσεις αλληλεξάρτησης μεταξύ των υποσυστημάτων του. 

Συνεπάγεται δηλαδή τη διεύρυνση της οπτικής θεώρησης του προβλήματος, γεγονός 
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που επιτρέπει την πιο ολοκληρωμένη, άρα και περισσότερο αποτελεσματική 

αντιμετώπιση του. Τα όρια του συστήματος εξαρτώνται από τις ιδιαιτερότητες του 

εξεταζόμενου προβλήματος και από το είδος των σχέσεων αλληλεξάρτησης μεταξύ 

των υποσυστημάτων. Είναι φανερό ότι και οι δύο αυτοί παράγοντες επιδέχονται μίας 

υποκειμενικής ερμηνείας, επομένως το αναγκαίο εύρος του συστήματος δεν μπορεί 

πάντα να ορισθεί μονοσήμαντα και απόλυτα. 

 

ΔΙΑΣΤΑΣΕΙΣ ΑΝΑΛΥΣΗΣ  

Με δεδομένα τα όρια του συστήματος, το επόμενο βήμα σε μία συστημική 

προσέγγιση είναι η ανάλυση και μοντελοποίηση του, δηλαδή ο καθορισμός των 

παραμέτρων και η διατύπωση των σχέσεων που προσδιορίζουν την λειτουργία του.  

Διακρίνονται 4 διαστάσεις ανάλυσης:  

1. Οριζόντια διάσταση: αναφέρεται στη συσχέτιση του μερικού με το συνολικό, 

δηλαδή των επιμέρους υποσυστημάτων με το ευρύτερο σύστημα στο οποίο αυτά 

εντάσσονται. Με την ανάλυση κατά την οριζόντια διάσταση ελέγχεται η επίδραση 

στο σύνολο του συστήματος μίας απόφασης που αφορά σε ένα συγκεκριμένο 

υποσύστημα, ή, αντίστροφα, οι επιπτώσεις σε επιμέρους υποσυστήματα από μία 

γενικότερη μεταβολή στο σύστημα.  

2. Κάθετη διάσταση: αναφέρεται στη συσχέτιση μεταξύ διαφορετικών επιπέδων 

σχεδιασμού και λήψης απόφασης. Διακρίνονται 3 διαφορετικά επίπεδα 

σχεδιασμού:  

• Το επίπεδο λειτουργίας  

• Το επίπεδο διοίκησης  

• Το επίπεδο του στρατηγικού σχεδιασμού  

Τα τρία αυτά επίπεδα αναφέρονται σε στόχους με διαδοχικά μειούμενη σαφήνεια 

αλλά ταυτόχρονα, με διαδοχικά αυξανόμενη ευρύτητα και χρονική εμβέλεια. Στο 

πλαίσιο δηλαδή ενός στρατηγικού σχεδιασμού οι αποφάσεις υπαγορεύονται από 

μακροπρόθεσμους και γενικά διατυπωμένους στόχους, ενώ μία λανθασμένη 

απόφαση είναι δυνατό να έχει σοβαρότερες και δυσκολότερα ανατρέψιμες αρνητικές 
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επιπτώσεις επηρεάζοντας τόσο τις αποφάσεις διοίκησης, όσο και τις λειτουργικές 

αποφάσεις.  

3. Χρονική διάσταση: αναφέρεται στη συσχέτιση μεταξύ διαφορετικών χρονικών 

στιγμών και ειδικότερα μεταξύ της στιγμής στην οποία λαμβάνεται η απόφαση και 

της στιγμής (ή του χρονικού ορίζοντα) στην οποία αυτή υλοποιείται και 

προκύπτουν οι όποιες –αρνητικές ή θετικές- επιπτώσεις. Ειδικότερα, η προσοχή 

εστιάζεται σε ορισμένες κρίσιμες παραμέτρους η μεταβολή των οποίων επιδρά 

αποφασιστικά στο σύστημα, επηρεάζοντας έτσι την αποτελεσματικότητα της 

απόφασης.  

4. Πρακτική διάσταση: αναφέρεται στη συσχέτιση μεταξύ του αναλυτικού μοντέλου 

και της πραγματικότητας και αποσκοπεί στο συνεχή έλεγχο και την αξιολόγηση 

των αποτελεσμάτων του πρώτου με βάση την υπάρχουσα εμπειρία. 

 

1.3 ΣΤΟΙΧΕΙΑ ΑΠΟΦΑΣΗΣ 

Ανεξάρτητα από το αντικείμενο της απόφασης και το επίπεδο σχεδιασμού στο 

οποίο αναφέρεται –λειτουργικού, διοικητικού ή στρατηγικού-, όλα τα προβλήματα ΛΑ 

περιλαμβάνουν συγκεκριμένα δομικά χαρακτηριστικά τα οποία σε μεγάλο βαθμό 

προσδιορίζουν και την ενδεδειγμένη μεθοδολογική προσέγγιση που θα ακολουθηθεί 

για την επίλυση τους.   

Τα στοιχειά αυτά είναι: 

1. Ο αποφασίζων: ο όρος αποδίδεται στο άτομο ή την ομάδα που 

αντιμετωπίζει το πρόβλημα και αναζητά τη λύση του. Ο αποφασίζων (decision 

maker) δεν είναι ικανοποιημένος από την υπάρχουσα κατάσταση ή από την 

προοπτική μελλοντικής εξέλιξης αυτής της κατάστασης και έχει την επιθυμία αλλά 

και την αρμοδιότητα να την αλλάξει ή να τη βελτιώσει. Ο αποφασίζων είναι εκείνος 

που θα ορίσει το πρόβλημα, δηλαδή θα καθορίσει το αντικείμενο και το στόχο της 

απόφασης, τα όρια του συστήματος, και τα υπόλοιπα στοιχεία του προβλήματος. 

Τα προβλήματα ΛΑ μπορεί να αφορούν:  

• Έναν αποφασίζοντα  

• Πολλούς αποφασίζοντες  
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Στη δεύτερη περίπτωση, η επίλυση του προβλήματος θα πρέπει να λάβει υπόψη 

τους στόχους και τις προτιμήσεις όλων των αποφασιζόντων και να αναζητηθεί μία 

λύση συμβιβασμού.   

2. Στόχος της απόφασης: η αλλαγή της υπάρχουσας κατάστασης στην 

οποία προσβλέπει ο αποφασίζων και ειδικότερα η βελτίωση της σε σχέση ορίζεται 

με βάση έναν ή περισσότερους στόχους. Έτσι, ο στόχος της απόφασης είναι το 

πρωταρχικό στοιχείο ενός προβλήματος ΛΑ, απ’ όπου θα προκύψουν και οι 

πιθανές λύσεις που σε μικρότερο ή μεγαλύτερο βαθμό ικανοποιούν αυτό το 

στόχο. Λόγω της πολυπλοκότητας και αλληλεξάρτησης των σύγχρονων 

συστημάτων, η επίτευξη ενός στόχου, μπορεί να συνοδεύεται από δυσμενείς 

επιπτώσεις σε άλλα χαρακτηριστικά του συστήματος. Για το λόγο αυτό, τίθενται εξ 

αρχής περισσότεροι στόχοι, ή ένας γενικός στόχος που αναλύεται σε 

περισσότερους υποστόχους ή κριτήρια απόφασης. Για παράδειγμα, ο στόχος της 

ανάπτυξης μίας περιφέρειας αναλύεται σε οικονομικούς, κοινωνικούς και 

περιβαλλοντικούς στόχους, και με τη σειρά του κάθε ένας από τους στόχους 

αυτούς μεταφράζεται σε ειδικότερες επιδιώξεις ή κριτήρια. Επίσης, είναι δυνατό 

ορισμένοι στόχοι να εκφράζονται με τη μορφή περιορισμών, δηλαδή η λύση του 

προβλήματος δεν θα πρέπει να παραβιάζει συγκεκριμένα όρια τιμών ως προς 

άλλες παραμέτρους-στόχους του προβλήματος. Για παράδειγμα, ο στόχος 

μεγιστοποίησης της οικονομικής αποτελεσματικότητας μπορεί να υπόκειται στο 

στόχο διατήρησης των αποβλήτων της παραγωγικής διαδικασίας κάτω ενός 

ορίου, έτσι ώστε οποιαδήποτε λύση παραβιάζει το στόχο αυτό να απορρίπτεται εκ 

των προτέρων.  

3. Οι εναλλακτικές λύσεις: η ύπαρξη περισσότερων εναλλακτικών 

λύσεων ή επιλογών (alternatives), μαζί με ένα στοιχείο αμφιβολίας ως προς το 

ποια απ’ αυτές είναι η καλύτερη, συνιστούν την καρδιά κάθε προβλήματος ΛΑ. 

Είναι προφανές ότι στην περίπτωση που η λύση που εξετάζεται είναι μία (ή σε 

περίπτωση πολλών επιλογών μία υπερέχει εμφανώς των υπολοίπων), το 

πρόβλημα ανάγεται στο δίλημμα υιοθέτησης ή απόρριψης αυτής της επιλογής.  

 

Με βάση το στοιχείο αυτό η βασική διάκριση των προβλημάτων ΛΑ είναι:  

• Διακριτές εναλλακτικές λύσεις: η επίλυση του προβλήματος συνίσταται στην 

επιλογή μεταξύ ενός συγκεκριμένου αριθμού εναλλακτικών λύσεων. Το 
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σύνολο των διακριτών λύσεων μπορεί να είναι εξ αρχής ορισμένο, ή να 

μεταβάλλεται (να εμπλουτίζεται ή/και να μειώνεται) κατά τη διαδικασία της 

ανάλυσης. Η επιλογή μεταξύ εναλλακτικών επενδυτικών σχεδίων, 

εναλλακτικών θέσεων χωροθέτησης μίας μονάδας αποτελούν 

χαρακτηριστικά παραδείγματα προβλημάτων με διακριτές εναλλακτικές 

λύσεις. 

• Συνεχείς μεταβλητές απόφασης: στην περίπτωση αυτή κάθε εναλλακτική λύση 

δεν είναι εκ των προτέρων ορισμένη, αλλά προκύπτει κατά την επίλυση του 

προβλήματος ως η βέλτιστη τιμή μίας παραμέτρου ή ο βέλτιστος 

συνδυασμός περισσότερων παραμέτρων οι οποίες ονομάζονται μεταβλητές 

απόφασης ή ελεγχόμενες μεταβλητές με την έννοια ότι υπόκεινται στον 

έλεγχο του αποφασίζοντα. Ο αριθμός των τιμών που μπορούν να πάρουν οι 

μεταβλητές αυτές είναι άπειρος και κατ’ επέκταση, άπειρος είναι και ο 

αριθμός των υποψήφιων εναλλακτικών λύσεων. Ο προσδιορισμός της τιμής 

πώλησης ενός προϊόντος, ή του μίγματος προϊόντων μίας βιομηχανικής 

επιχείρησης αποτελούν παραδείγματα προβλημάτων με συνεχείς 

μεταβλητές απόφασης. Συχνά προβλήματα αυτής της κατηγορίας ανάγονται 

σε προβλήματα διακριτών λύσεων με τον εντοπισμό των πιο 

αντιπροσωπευτικών τιμών των αντίστοιχων μεταβλητών απόφασης.  

4. Οι παράμετροι της απόφασης: Σε όλα τα προβλήματα ΛΑ η 

ενδεδειγμένη λύση εξαρτάται από την τιμή ορισμένων παραμέτρων του 

εξωτερικού περιβάλλοντος οι οποίες δεν υπόκεινται στον έλεγχο του 

αποφασίζοντα και γι’ αυτό ονομάζονται μη ελεγχόμενες μεταβλητές. Το ύψος της 

ζήτησης ενός προϊόντος, ή η εξέλιξη των τιμών των πρώτων υλών αποτελούν 

παραδείγματα μη ελεγχόμενων μεταβλητών οι οποίες επηρεάζουν την απόφαση 

για την προώθηση ενός νέου προϊόντος στην αγορά ή για τον καθορισμό της 

δυναμικότητας παραγωγής. 

 Οι παράμετροι σε ένα πρόβλημα ΛΑ μπορεί να είναι:  

• Γνωστές: η επίλυση του προβλήματος οδηγεί σε σταθερή και κατά κανόνα 

λιγότερο αμφισβητούμενη λύση.  

• Ανεπαρκώς γνωστές ή άγνωστες: εφαρμόζονται τεχνικές για να προσδιορισθεί 

μία λύση συμβατή με τις πιθανές ή δυνατές τιμές που μπορεί να λάβουν οι 
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συγκεκριμένες παράμετροι ή/και για να εξετασθεί η σταθερότητα της σε 

τυχόν διακυμάνσεις.  

 

1.4 ΔΙΑΔΙΚΑΣΙΑ ΛΗΨΗΣ ΑΠΟΦΑΣΗΣ 

Τα βήματα που ακολουθούμε είναι τα εξής: 

1. Ταυτοποίηση του προβλήματος και των στόχων της απόφασης: στο στάδιο αυτό 

προσδιορίζεται η φύση του προβλήματος, τα όρια του συστήματος και οι 

επιδιώξεις του αποφασίζοντα. Το στάδιο αυτό, αν και φαίνεται αυτονόητο, είναι 

συχνά το πιο σημαντικό σε μία διαδικασία λήψης απόφασης, καθώς η ελλιπής 

κατανόηση του προβλήματος και η εσφαλμένη τοποθέτηση των ορίων του 

συστήματος μπορεί να οδηγήσει σε αναποτελεσματικές ή και τελείως 

λανθασμένες λύσεις. Κυρίως όμως, η διερεύνηση και σαφής διατύπωση των 

στόχων και περιορισμών της απόφασης είναι αυτή που θα διασφαλίσει μία 

ρεαλιστική λύση που βελτιώνει σφαιρικά τη συνολική λειτουργία και 

αποτελεσματικότητα του συστήματος. 

2. Προσδιορισμός των εναλλακτικών λύσεων: στο στάδιο αυτό –που μπορεί να 

εντάσσεται και στο στάδιο της ταυτοποίησης- καθορίζεται το σύνολο των 

επιλογών που αποτελούν πιθανές λύσεις στο εξεταζόμενο πρόβλημα και 

ορίζονται είτε ως διακριτά αλληλοαποκλειόμενα στοιχεία, είτε ως συνδυασμός 

τιμών (όχι εκ των προτέρων γνωστός) περισσοτέρων συνεχών μεταβλητών. Και 

στις δύο περιπτώσεις ο προσδιορισμός των εναλλακτικών λύσεων βασίζεται και 

υποστηρίζεται από τους στόχους της απόφασης, με την έννοια ότι ορισμένες 

λύσεις είναι δυνατό να αποκλεισθούν εκ των προτέρων ως μη συμβατές με τους 

στόχους. Αντίθετα, μία δημιουργική σκέψη και προβληματισμός πάνω στους 

στόχους μπορεί να αποκαλύψει νέες υποψήφιες λύσεις που δεν ήταν άμεσα 

εμφανείς.  

3. Μοντελοποίηση: στο στάδιο αυτό το πρόβλημα αναλύεται στις συνιστώσες του και 

διατυπώνονται οι λογικές ή/και μαθηματικές σχέσεις που προσδιορίζουν αφ’ ενός 

τη δομή του συστήματος, αφ’ ετέρου την οπτική και τις αξίες του αποφασίζοντα. 

Το μοντέλο κατασκευάζεται με βάση τις αρχές και τεχνικές που αντιστοιχούν στη 

μεθοδολογία ΛΑ που έχει επιλεγεί για το συγκεκριμένο πρόβλημα.  

Το στάδιο της μοντελοποίησης περιλαμβάνει κατά κανόνα δύο φάσεις:  
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• Μοντελοποίηση του προβλήματος: αποτυπώνονται τα στοιχεία και δομικά 

χαρακτηριστικά του, δηλαδή οι εναλλακτικές λύσεις, οι στόχοι, περιορισμοί 

και τα κριτήρια της απόφασης, σε συνάρτηση με τις παραμέτρους που 

χαρακτηρίζουν τη διάρθρωση και λειτουργία του εξεταζόμενου συστήματος. 

• Μοντελοποίηση των προτιμήσεων: προσδιορίζεται το σύστημα αξιών του 

αποφασίζοντα και ειδικότερα η συμπεριφορά του απέναντι στο ρίσκο, οι 

προτεραιότητες του ως προς την επίτευξη διαφορετικών στόχων, τα 

κατώφλια αδιαφορίας που προσδιορίζουν τη στάση του μεταξύ επιλογών με 

παρόμοιες επιδόσεις κλπ.  

Και στις δύο φάσεις, η μοντελοποίηση μπορεί να ενσωματώσει την αβεβαιότητα που 

χαρακτηρίζει είτε τις τιμές των παραμέτρων είτε τη συμπεριφορά του αποφασίζοντα 

(π.χ. κατασκευή σεναρίων ή χρήση ασαφών αριθμών). Εναλλακτικά, η διαχείριση της 

αβεβαιότητας μπορεί να γίνει σε επόμενο στάδιο με αναλύσεις ευαισθησίας ως προς 

κρίσιμες τιμές παραμέτρων ή προτιμήσεων του αποφασίζοντα.  

4. Επίλυση μοντέλου: στο στάδιο αυτό επιλύεται το μοντέλο και καταγράφονται τα 

στοιχεία που συνθέτουν τη λύση. Τα στοιχεία αυτά αξιολογούνται και ελέγχονται 

ως προς τη ρεαλιστικότητα και την αποτελεσματικότητα τους. Επιπλέον, ανάλογα 

και με την τεχνική διαχείρισης της αβεβαιότητας που έχει υιοθετηθεί μπορεί να 

γίνει ανάλυση ευαισθησίας για να διερευνηθεί η σταθερότητα της λύσης.  

5.  Επιλογή και υλοποίηση της λύσης: Τα αποτελέσματα του μοντέλου είτε κρίνονται 

ικανοποιητικά, οπότε λαμβάνεται η απόφαση και δρομολογείται η  υλοποίηση της, 

είτε δεν γίνονται αποδεκτά και ακολουθεί επιστροφή σε ένα από τα τρία πρώτα 

στάδια. Η απόρριψη μίας λύσης μπορεί δηλαδή να οφείλεται είτε σε εσφαλμένη 

ταυτοποίηση του προβλήματος και λάθος επιλογή στόχων, είτε στη θεώρηση 

ακατάλληλων ή ανεφάρμοστων λύσεων, ή τέλος στη λανθασμένη διατύπωση του 

μοντέλου  
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ΚΕΦΑΛΑΙΟ 2: ΔΙΑΔΙΑΚΑΣΙΑ ΑΝΑΛΥΤΙΚΗΣ ΙΕΡΑΡΧΙΣΗΣ 

 

ΕΙΣΑΓΩΓΗ 

Η αναλυτική ιεραρχική διαδικασία είναι μια δομημένη τεχνική για την λήψη 

αποφάσεων. Ανακαλύφθηκε στα τέλη της δεκαετίας του 1970 από τον Thomas 

L.Saaty και είναι βασισμένη στα μαθηματικά και την ανθρώπινη ψυχολογία.  

Η αναλυτική ιεραρχική διαδικασία έχει εφαρμογές σε πολλά πεδία όπως το 

κυβερνητικό, επιχειρηματικό, βιομηχανικό, υγείας και εκπαίδευσης. Χρησιμοποιείται 

κυρίως σε σύνθετα προβλήματα με πολλές εναλλακτικές επιλογές και πολλά 

κριτήρια. 

Ακόμα είναι ιδιαιτέρα χρήσιμη όταν εφαρμόζεται από ομάδες εργασίας σε 

πολύπλοκα προβλήματα και ειδικά σε αυτά που εμπλέκεται σε μεγάλο βαθμό η 

ανθρώπινη κρίση και που τα αποτελέσματα τους έχουν μακροχρόνιες συνέπειες.  Και 

αυτό γιατί η αναλυτική ιεραρχική διαδικασία επιτρέπει στους λήπτες αποφάσεων να 

μοντελοποιήσουν ένα σύνθετο πρόβλημα σε μια ιεραρχική δομή όπου θα φαίνονται 

οι σχέσεις του στόχου με τα κριτήρια, τα υπό – κριτήρια και τις εναλλακτικές, μια 

τυπική μορφή ιεραρχικής δόμησης φαίνεται πιο κάτω.  
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2.1 ΑΡΧΕΣ ΚΑΙ ΑΞΙΩΜΑΤΑ ΤΗΣ ΑΝΑΛΥΤΙΚΗΣ ΙΕΡΑΡΧΙΚΗΣ 
ΔΙΑΔΙΚΑΣΙΑΣ 

 

Η αναλυτική ιεραρχική διαδικασία βασίζεται σε τρεις θεμελιώδεις αρχές και 

τέσσερα αξιώματα, τα οποία διέπουν την λειτουργία της. 

Οι τρεις αρχές της οποίες βασίζεται η αναλυτική ιεραρχική διαδικασία είναι η 

αρχή της αποσύνθεσης (decomposition)  εφαρμόζεται στην δόμηση της συνθέτου 

προβλήματος σε μια ιεραρχία κλάσεων, υπό – κλάσεων κλπ. Η δεύτερη αρχή είναι οι 

Κρίσεις συγκρίσεων (Corporative judgments), εφαρμόζεται για την δημιουργία 

δυαδικών συγκρίσεων όλων των συνδυασμών των στοιχείων μιας κλάσης των 

συνδυασμών των στοιχείων μιας κλάσης ως της τον ˝γονίο˝ της κλάσης.  Τέλος είναι 

η Ιεραρχική σύνθεση (Hierarchic composition or synthesis) εφαρμόζεται στον 

πολλαπλασιασμό των τοπικών προτεραιοτήτων των στοιχείων μιας κλάσης με την 

συνολική προτεραιότητα του πατρικού στοιχείου, παραγωγή ολικών προτεραιοτήτων 

μέσα από (κατά μήκος) την ιεραρχία και μετά η πρόσθεση των ολικών 

προτεραιοτήτων για το χαμηλότερο επίπεδο στοιχείων (εναλλακτικές).   

Τα αξιώματα της αναλυτικής ιεραρχικής διαδικασίας είναι : 

1. Αξίωμα της αμοιβαιότητας. Αν PC ( EA, EB ) είναι ένας δυαδικός συνδυασμός των 

στοιχείων Α και Β ως προς το πατρικό στοιχείο C, ο οποίος αναπαριστά πόσες 

φορές το στοιχείο Α κατέχει μια ιδιότητα από το από το στοιχείο Β, τότε 

( ) ( )BAC
ABC EEPEEP ,

1, =  , δηλαδή αν το Α είναι πέντε φορές μεγαλύτερο τότε το 

Β είναι το 1/5. 

2. Αξίωμα της ομοιογένειας. Το αξίωμα αυτό ορίζει ότι το στοιχείο το οποίο 

συγκρίνεται δεν θα πρέπει να διαφέρει πάρα πολύ, αλλιώς θα εμφανιστούν 

μεγάλα λάθη κατά τις κρίσεις. Κατά την δόμηση λοιπόν της ιεραρχίας θα πρέπει 

να αποφεύγεται η συσσώρευση στοιχείων σε μια μόνο κλάση. 

3. Ορίζεται οι κρίσεις ή οι προτεραιότητες των στοιχείων σε μια ιεραρχία εξαρτώνται 

από χαμηλότερα επίπεδα στοιχείων. 

4. Άτομα τα οποία έχουν λόγο θα πρέπει να βεβαιωθούν ότι οι ιδέες τους 

εκφράζονται επαρκώς στο αποτέλεσμα.   
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2.2  ΑΝΑΛΥΤΙΚΗ ΙΕΡΑΡΧΙΚΗ ΔΙΑΔΙΚΑΣΙΑ 

 

Η αναλυτική ιεραρχική διαδικασία αναλύεται στα εξής στάδια : 

1. Την ιεραρχική ανάλυση του προβλήματος απόφασης σε στοιχεία 

απόφασης. 

2. Την συλλογή προτιμήσεων από τον αποφασίζοντας σχετικά με τα στοιχεία 

απόφασης. 

3. Τον υπολογισμό επιμέρους προτεραιοτήτων για τα στοιχεία απόφασης. 

4. Την σύνθεση των επιμέρους προτεραιοτήτων σε γενικές προτεραιότητες 

των εναλλακτικών λύσεων. 

 

Στο πρώτο στάδιο ο απώτερος στόχος είναι το υπό μελέτη πρόβλημα 

απόφασης να αναλυθεί σε επιμέρους υποστόχους, οι οποίοι στην συνέχεια 

αναλύονται όλο και περισσότερο στα πρότυπα μιας ιεραρχικής δομής.  Στην κορυφή 

της ιεραρχικής αυτής δομής βρίσκεται ο απώτερος στόχος (goal) , που είναι τόσο 

γενικός όσο η απόφαση που θα ληφθεί να είναι η καλύτερη δυνατή.  Παραδείγματα 

τέτοιων στόχων θα μπορούσε να είναι  η επιλογή τοποθεσίας για την εγκατάσταση 

μιας επιχείρησης, όποτε ο απώτερος στόχος της επιχείρησης είναι η «επιλογή της 

άριστης τοποθεσίας», άλλη περίπτωση θα μπορούσε να είναι η επιλογή και η 

εγκατάσταση ενός ολοκληρωμένου  πληροφοριακού συστήματος (ΟΠΣ) από έναν 

Οργανισμό με ανοιχτό διαγωνισμό, ο απώτερος στόχος του οργανισμού είναι η 

«επιλογή του καλύτερου πληροφοριακού συστήματος» από τα προσφερόμενα.  

Είναι προφανές ότι οι εναλλακτικές λύσεις σε ένα πρόβλημα απόφασης ως 

προς ένα τόσο γενικό στόχο – κριτήριο είναι πάρα πολλές. Έτσι ο απώτερος στόχος 

αναλύεται σε έναν αριθμό περισσότερο συγκεκριμένων υποστόχων. Η ανάλυση αυτή 

γίνεται έτσι ώστε η ικανοποίηση των επιμέρους στόχων να έχει ως αποτέλεσμα την 

εξυπηρέτηση του γενικότερου στόχου.  Στην περίπτωση της επιλογής τοποθεσίας για 

παράδειγμα ο απώτερος στόχος μπορεί να αναλυθεί σε υποστόχους που να 

αναφέρονται σε «προσβασιμότητα του κτιρίου», «μέγεθος του κτιρίου», «κόστος 

κτήσης του κτιρίου». Προσδίδεται έτσι μια ιεραρχική δομή στο πρόβλημα απόφασης 

στην οποία τα ανώτερα επίπεδα αναφέρονται  σε γενικούς στόχους – κριτήρια και 

όσο κατεβαίνει κανείς προς τα κάτω, τα κριτήρια εξειδικεύονται όλο και περισσότερο 
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μέχρι του σημείου που να μπορούν να χρησιμοποιηθούν αποτελεσματικά για την 

σύγκριση των εναλλακτικών λύσεων.   

Ο βαθμός λεπτομέρειας (βάθος και εύρος) που προσδίδεται στην ιεραρχική 

δομή κατά την ανάλυση του προβλήματος απόφασης εξαρτάται από την 

πολυπλοκότητα του. Η ιεραρχική δομή κατασκευάζεται με μια διαδικασία καταιγισμού 

ιδεών  (brain storming) από ένα σύνολο ατόμων, καθένα από τα οποία 

αντιπροσωπεύει και μια ξεχωριστή όψη του προβλήματος.   

 
ΣΥΛΛΟΓΗ ΠΡΟΤΙΜΗΣΕΩΝ ΓΙΑ ΤΑ ΣΤΟΙΧΕΙΑ ΑΠΟΦΑΣΗΣ 

 

Σε κάθε επίπεδο της ιεραρχίας συγκρίνονται κατά ζεύγη τα στοιχεία αυτής ως 

προς το βαθμό προτίμησης του ενός στοιχείου έναντι του άλλου σε σχέση με το 

κριτήριο του αμέσως ανώτερου επίπεδου (γονικό στοιχείο απόφασης. 

Δημιουργούνται έτσι πίνακες κατά ζεύγη συγκρίσεων, των οποίων ο αριθμός 

ταυτίζεται με το πλήθος των κόμβων του δέντρου. Δυο τέτοιοι πίνακες που μπορούν 

να εξαχθούν από το ανωτέρω σχήμα είναι οι ακόλουθοι :  

 

Α.Σ. Σ.Α.1 Σ.Α.2 Σ.Α.3 

Σ.Α.1    

Σ.Α.2    

Σ.Α.3    

 

Στον πρώτο πίνακα συγκρίνονται τα στοιχεία απόφασης ( Σ.Α.1, Σ.Α.2, Σ.Α.3) 

σε σχέση με τον βαθμό συμμετοχής του στον απώτερο στόχο (Α.Σ.). Στον δεύτερο 

πίνακα συγκρίνονται οι εναλλακτικές λύσεις ( Α,Β,Γ) ως προς το κριτήριο 2.1. 

Στα πλαίσια τέτοιων πινάκων ο αποφασίζων δηλώνει τις προτιμήσεις του για 

κάθε συγκρινόμενο ζεύγος στοιχείων απόφασης Χ και Υ με βάση την ακόλουθη 

διαβάθμιση: 

2.1 Α Β Γ 

Α    

Β    

Γ    



20 
 

• I.Το Χ είναι ισοδύναμο με το Υ (ΧIΥ) 

• WP.Η προτίμηση του Χ έναντι του Υ είναι ασθενής (weak preference – XWPY) 

• SP.Η προτίμηση του Χ έναντι του Υ είναι πολύ ισχυρή (strong preference – 

XSPY) 

• DP. Η προτίμηση του Χ έναντι του Υ είναι πολύ ισχυρή (very strong preference 

– XDPY) 

• AP. Η προτίμηση του Χ έναντι του Υ είναι απόλυτη (absolute preference – 

XAPY) 

Σύμφωνα με τον Saaty, οι παραπάνω διαβαθμίσεις R = {I, WP, SP, DP, AP} 

αντιστοιχίζονται στην αριθμητική κλίμακα 1, 3, 5, 7, 9. Πάνω σε αυτή  την διαβάθμιση 

είναι δυνατή και η χρησιμοποίηση των ενδιάμεσων τιμών 2, 4, 6 και 8, για την 

έκφραση ενδιάμεσων προτιμήσεων. Επιπλέον είναι δυνατή η χρησιμοποίηση των 

αντίστροφων τιμών ½, 1/3, ¼, 1/5, 1/6, 1/7, 1/8, 1/9, για την διατύπωση αντίστροφων 

(αρνητικών) προτιμήσεων. Το σύνολο λοιπόν των δυνατών αριθμητικών 

διαβαθμίσεων κατά τον Saaty είναι : 

R = {1, 2, 3, 4, 5, 6, 7, 8, 9, ½, 1/3, ¼, 1/5, 1/6, 1/7, 1/8, 1/9} 

Συνεπώς κατά την εκδήλωση των προτιμήσεων του αποφασίζοντα ένας πίνακας 

συγκρίσεων συμπληρώνεται με τις τιμές αij , ισχύει : 

 

 

 

 

 

1. αij = 1, αφού αναφέρονται σε συγκρίσεις με τον εαυτό τους 

2. αij > 1, όταν το στοιχείο i προτιμάται έναντι του j  

3. αij < 1, όταν το στοιχείο j προτιμάται έναντι του i 

4. αij = 1/ αij για κάθε i, j.  

Κάθε μια από αυτές τις τιμές μπορεί να θεωρηθεί ότι εκφράζει πρακτικά πόσες 

φορές είναι πιο σημαντικό ένα στοιχείο από ένα άλλο. Τα δεδομένα λοιπόν των 

Α.Σ. Σ.Α.1 Σ.Α.2 Σ.Α.3 

Σ.Α.1 α11 α12 α13 

Σ.Α.2 α12 α22 α23 

Σ.Α.3 α13 α23 α33 
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συγκρίσεων συλλέγονται για τα μισά στοιχεία του πίνακα. Έτσι για έναν πίνακα n×n ο 

αριθμός των συγκρίσεων είναι n(n-1) / 2. 

 
ΕΚΤΙΜΗΣΗ ΠΡΟΤΕΡΑΙΟΤΗΤΩΝ ΓΙΑ ΤΑ ΣΤΟΙΧΕΙΑ ΑΠΟΦΑΣΗΣ  

Σε αυτό το στάδιο υπολογίζονται για κάθε πίνακα συγκρίσεων οι σχετικές 

προτεραιότητες w (σχετικά βάρη) των συγκρινόμενων στοιχείων απόφασης σε σχέση 

πάντα με το γονικό στοιχείο.  

Έστω ο πίνακας: 

Α.Σ. Σ.Α.1 Σ.Α.2 Σ.Α.3 βάρη 

Σ.Α.1 1 2 7 w1 

Σ.Α.2 1/2 1 3 w2 

Σ.Α.3 1/7 1/3 1 w3 

 

Ο τρόπος υπολογισμού των σχετικών βαρών στηρίζεται στο ακόλουθο 

σκεπτικό. Έστω ότι ο αποφασίζων είναι σε θέση να γνωρίζει τα πραγματικά σχετικά 

βάρη των στοιχείων απόφασης, ο πίνακας θα είχε τη ακόλουθη μορφή : 

 

 
 

 

 

 

 

Για έναν τέτοιο πίνακα, Α, ισχύει : Aw =  nw 

Α.Σ. Σ.Α.1 Σ.Α.2 Σ.Α.3 Βάρη  

Σ.Α.1 w1/w1 w1/w2 w1/w3 w1 

Σ.Α.2 w2/w1 w2/w2 w2/w3 w2 

Σ.Α.3 w3/w1 w3/w2 w3/w3 w3 
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όπου w το διάνυσμα των πραγματικών σχετικών βαρών και n το πλήθος των 

συγκρινόμενων στοιχείων. 

Σύμφωνα με την γραμμική άλγεβρα τα n και w είναι αντίστοιχα η μέγιστη 

ιδιοτιμή και το αντίστοιχο ιδιοδιάνυσμα του πίνακα Α. Αν για τα στοιχεία ενός πίνακα 

Α ισχύει ότι : ikjkij ααα =×  για κάθε (i,j,k), τότε ο πίνακας Α ονομάζεται συνεπής. 

Στην πραγματικότητα όμως ο αποφασίζων δεν γνωρίζει τα πραγματικά βάρη w και 

άρα δεν είναι σε θέση να προσδιορίσει με ακρίβεια τα στοιχεία του πίνακα Α. 

συνεπώς ο πίνακας θα εμπεριέχει ανακολουθίες, στην περίπτωση αυτή η εκτίμηση 

των βαρών γίνεται από τη σχέση : ww ˆˆˆ
maxλ=Α , όπου ŵ,,ˆ

maxλΑ , είναι αντίστοιχα ο 

πίνακας των κατά ζεύγη συγκρίσεων, η μέγιστη ιδιοτιμή του πίνακα αυτού και το 

αντίστοιχο ιδιοδιάνυσμα. Το εκτιμούμενο διάνυσμα ŵ  αποτελεί προσέγγιση του 

διανύσματος των πραγματικών σχετικών βαρών w. Επίσης η ιδιοτιμή λmax μπορεί να 

θεωρηθεί ως μια εκτίμηση του n, δηλαδή του πλήθους των συγκρινόμενων στοιχείων 

. Ενώ το λmax και n συνδέονται με την σχέση : λmax ≥ n.  Όσο πιο μεγάλη η διαφορά 

τους τόσες περισσότερες οι ασυνέπειες μεταξύ των τιμών του πίνακα.  

Σε αυτήν την ιδιότητα στηρίζεται ο δείκτης συνέπειας (consistency index – CI)  

CI = (λmax – n) / (n- 1) 

Και ο λόγος συνέπειας (constancy ratio – CR) 

CR = (CI/ACI) * 100 

Όπου ACI είναι μια μέση τιμή δεικτών συνέπειας που υπολογίζεται βάση 

βαρών που δημιουργούνται με τυχαίο τρόπο στα πλαίσια προσομοίωσης. Ένας 

πρακτικός κανόνας είναι ότι μια τιμή του CR μικρότερη ή ίση του 10% είναι αποδεκτή. 

Αλλιώς ο αποφασίζων θα πρέπει να επανεξετάσει τον πίνακα. 

Οι ανακολουθίες που εμφανίζονται κατά την σύγκριση των στοιχείων ανά δυο 

έχουν δύο πηγές προέλευσης, τον αποφασίζοντα και την ίδια την κλίμακα έκφρασης 

των προτιμήσεων. Οι ανακολουθίες αυτές ελέγχονται από τον βαθμό στον οποίο 

παραβιάζονται οι ακόλουθες ιδιότητες : 

• Αν αij > 1 και αjk τότε και αik >(1) 

• ikjkij ααα =× για κάθε i, j, k  



23 
 

Η πρώτη ιδιότητα εκφράζει την μεταβατικότητα των προτιμήσεων και η 

παραβίαση της υποδηλώνει εσφαλμένη εκτίμηση του αποφασίζοντα. Η δεύτερη 

ιδιότητα της οποίας όταν εκφράζεται η καθολική ισχύς εκφράζει την απόλυτη 

συνέπεια  των απαντήσεων του αποφασίζοντα, δεν επαληθεύεται πολλές φορές 

λόγω της φραγμένης κλίμακας των διαβαθμίσεων στις προτιμήσεις.  

 

2.3  ΥΠΟΛΟΓΙΣΜΟΣ ΙΔΙΟΔΙΑΝΥΣΜΑΤΟΣ Ŵ  

 

Ο υπολογισμός του ιδιοδιανύσματος  ŵ  από τον πίνακα κατά ζεύγη 

συγκρίσεων γίνεται με την εξής επαναληπτική διαδικασία : 

 

1. Αθροίζονται τα στοιχεία του πίνακα ( αρχικά του πίνακα Α) κατά γραμμή : 

∑=
j

iji as για κάθε i  

2. Για κάθε γραμμή του πίνακα γίνεται προσέγγιση του βάρους του αντίστοιχου  

στοιχείου με το πηλίκο si δια του αθροίσματος των στοιχείων όλου του πίνακα: 

ij
ji

ii sw αΣΣ= / . Λαμβάνεται έτσι το ŵ , του οι συνιστώσες είναι 

κανονικοποιημένες, δηλαδή έχουν άθροισμα την μονάδα.  

3. Υψώνεται ο πίνακας στο τετράγωνο και η διαδικασία επαναλαμβάνεται από το 

βήμα 1, μέχρις ότου δυο διαδοχικές προσεγγίσεις του ŵ  να μην διαφέρον 

σημαντικά στα πλαίσια μιας επιθυμητής ακρίβειας.  

 
ΣΥΝΘΕΣΗ ΤΩΝ ΕΠΙΜΕΡΟΥΣ ΒΑΡΩΝ ΣΕ ΓΕΝΙΚΕΣ 
ΠΡΟΤΕΡΑΙΟΤΗΤΕΣ ΤΩΝ ΕΝΑΛΛΑΚΤΙΚΩΝ ΛΥΣΕΩΝ  
 

Στο στάδιο αυτό που είναι επίσης καθαρά υπολογιστικό, γίνεται σύνθεση των 

τοπικών βαρών των στοιχείων, όπως αυτά προκύπτουν από τους επιμέρους πίνακες 

συγκρίσεων, σε γενικές προτεραιότητες των εναλλακτικών λύσεων ( φύλλα της 

δενδροειδούς δομής) ως προς τον απώτερο στόχο (ρίζα). Η πράξη σύνθεσης των 



24 
 

βαρών είναι στην ουσία πράξεις πολλαπλασιασμού μεταξύ πινάκων βαρών από 

κάτω προς τα πάνω, δηλαδή από το κατώτερο προς το ανώτερο ιεραρχικό επίπεδο.  

 
2.4 ΑΣΥΝΕΠΕΙΑ 

 

Η θεωρία της αναλυτικής ιεραρχικής διαδικασίας δεν απαιτεί τέλεια συνέπεια. 

Η αναλυτική ιεραρχική διαδικασία επιτρέπει την ασυνέπεια άλλα παρέχει ένα  μέτρο 

μέτρησης της ασυνέπειας σε κάθε ζεύγος κρίσεων. Αυτό το μέτρο είναι ένα σημαντικό 

υπό-προϊόν της διαδικασίας εξαγωγής προτεραιοτήτων βασισμένων σε δυαδικές 

συγκρίσεις.  

Οι αιτίες που προκαλούν την ασυνέπεια είναι πρώτον το γραφικό λάθος που 

είναι και το πιο συνηθισμένο . Το λάθος αυτό μπορεί να συμβεί όταν εισάγουμε μια ή 

περισσότερες κρίσεις σε  έναν υπολογιστή η εισαγωγή λάθος τιμής ή ίσως η 

εισαγωγή της αντιστροφής της.  

Η δεύτερη αιτία ασυνέπειας είναι η έλλειψη πληροφόρησης. Αν κάποιος από 

τους αποφασίζοντες έχει ελλιπή ή και καθόλου ενημέρωση για κάποιον από τους 

παράγοντες που συγκρίνονται, τότε οι κρίσεις θα είναι τυχαίες και θα εμφανίζεται μια 

μεγάλη αναλογία ασυνέπειας.   

Η τρίτη αιτία  ασυνέπειας είναι η έλλειψη συγκέντρωσης κατά την διαδικασία 

των συγκρίσεων.  

Η τέταρτη αιτία ασυνέπειας είναι ότι ο ίδιος ο πραγματικός κόσμος δεν είναι 
σταθερός.  

Η τελευταία αιτία ασυνέπειας είναι η ανεπάρκεια του μοντέλου δόμησης, 

καθώς  ιδεατά  η δόμηση μιας σύνθετης απόφασης σε μια ιεραρχική μορφή όπου οι 

συντελεστές είναι συγκρίσιμοι σε κάθε επίπεδο, ωστόσο αυτό πρακτικά δεν ισχύει 

αφού σε κάθε επίπεδο μπορεί να υπάρχουν πολύ διαφορετικοί μεταξύ τους 

παράγοντες.  
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ΚΕΦΑΛΑΙΟ 3: EXPERT CHOICE 

 

ΕΙΣΑΓΩΓΗ 

Το E. C. Software είναι ένα εργαλείο υποστήριξης αποφάσεων πολλαπλών 

επιλογών, το οποίο είναι βασισμένο στην μεθοδολογία της αναλυτικής ιεραρχικής 

προσέγγισης. Τα κύρια βήματα που ακολουθούνται κατά την διαδικασία ανάλυσης 

ενός προβλήματος απόφασης είναι όπως και στην αναλυτική ιεραρχική προσέγγιση 

τα εξής : 

• Διαδικασία καταιγισμού ιδεών και δόμηση του προβλήματος απόφασης σαν 

ιεραρχικό μοντέλο.  

• Κατά ζεύγη σύγκριση των κριτηρίων και υπό-κριτηρίων για την σημαντικότητα 

τους στην εκπλήρωση του προβλήματος απόφασης. 

• Κατά ζεύγη σύγκριση των εναλλακτικών λύσεων για την επιλεκτικότητα τους 

έναντι των  κριτήριων επιλογής.  

• Ανάλυση για την εκλογή της άριστης εναλλακτικής επιλογής.    

• Πραγματοποίηση ανάλυση ευαισθησίας. 

 

3.1 ΧΤΙΣΙΜΟ ΕΝΟΣ ΜΟΝΤΕΛΟΥ 

ΑΝΟΙΓΜΑ ΤΟΥ EXPERT CHOICE 

Για να ανοίξει το πρόγραμμα ακολουθείται η εξής διαδικασία :  Windows start 

key → Programs → Expert Choice.  

Για συντόμευση χρόνου υπάρχει η δυνατότητα δημιουργίας εικονιδίου στην 

επιφάνεια εργασίας. 

 
ΔΗΜΙΟΥΡΓΙΑ ΝΕΟΥ ΜΟΝΤΕΛΟΥ 

Για την δημιουργία νέου μοντέλου το πρόγραμμα παρέχει δύο επιλογές. Η 

πρώτη επιλογή είναι από το παράθυρο διαλόγου το οποίο εμφανίζεται με το άνοιγμα 
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του προγράμματος. Σε αυτό το παράθυρο ο χρήστης επιλέγει  : Create new model → 

OK. 

  

Στην δεύτερη επιλογή χρησιμοποιείται η γραμμή εργαλείων : File → New → 

nameofthefile. 

Στην συνέχεια εμφανίζεται ένα παράθυρο διαλόγου στο οποίο ορίζεται  ο γενικός ή 

απώτερος στόχος.  
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Εν συνεχεία το πρόγραμμα οδηγεί τον χρήστη στην κύρια σελίδα του 

προγράμματος. 

 

Το περιβάλλον εργασίας χωρίζεται σε τρία μέρη. Το  πρώτο μέρος, το οποίο 

καταλαμβάνει και το μεγαλύτερο μέρος της σελίδας, ονομάζεται Tree View pane – 

στο οποίο αναγράφεται η ιεραρχία του προβλήματος, με τα κριτήρια και τα υπό – 

κριτήρια του προβλήματος απόφασης. Κάθε στοιχείο αναφέρεται σαν κόμβος.  

Στο δεύτερο μέρος, το οποίο βρίσκεται στο πάνω δεξιό μέρος της οθόνης, 

αναγράφονται οι εναλλακτικές λύσεις.  

Τέλος στο τρίτο μέρος παρατίθενται ορισμένες πληροφορίες για τον απώτερο 

στόχο ή για τις εναλλακτικές λύσεις του προβλήματος.   

 

ΠΡΟΣΘΗΚΗ ΚΡΙΤΗΡΙΩΝ ΣΤΗΝ ΙΕΡΑΡΧΙΑ 

Για να την προσθήκη κριτηρίων στο δέντρο ακολουθείται η έξης διαδικασία :  

1. Edit  → Insert Child of the current node → Εισάγω το κριτήριο →  

enter → Εισαγωγή του επόμενου κριτηρίου. 

2. Αφού εισαχθούν όλα τα κριτήρια , πατάει ξανά enter και μετά esc για 

τον τερματισμό της διαδικασίας. 



28 
 

Αν σε κάποιο κριτήριο χρειάζεται η προσθήκη υπό – κριτηρίων τότε δεξί κλικ 

πάνω στο συγκεκριμένο κριτήριο → insert child of the current node. Εναλλακτικά  της 

διαδικασίας αυτής μπορεί να ακολουθηθεί η εξής : κλικ πάνω στο κριτήριο → Edit  → 

Insert Child of the current node → Εισαγωγή του κριτήριου →  enter → Εισαγωγή του 

επόμενου κριτηρίου.  

 

ΠΡΟΣΘΗΚΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΛΥΣΕΩΝ ΣΤΟ ΠΡΟΒΛΗΜΑ 
ΑΠΟΦΑΣΗΣ 

Για την προσθήκη των εναλλακτικών λύσεων υπάρχουν τρείς δυνατότητες.  Η 

πρώτη : Edit → Alternative → Insert → Εισαγωγή του ονόματος της εναλλακτικής 

επιλογής → Enter. 

Η δεύτερη : Δεξί κλικ μέσα στο πλαίσιο των εναλλακτικών  επιλογών → Insert → 

Εισαγωγή του ονόματος της εναλλακτικής επιλογής → Enter. 

Η τρίτη είναι από το κουμπί Add Alternative  

 

ΣΥΓΚΡΙΣΕΙΣ ΑΝΑ ΖΕΥΓΗ ΤΩΝ ΕΝΑΛΛΑΚΤΙΚΩΝ ΛΥΣΕΩΝ 

Το πρόγραμμα παρέχει την δυνατότητα τριών εναλλακτικών μορφών ανά 

ζεύγη συγκρίσεων. Οι συγκρίσεις μπορούν να πραγματοποιηθούν λεκτικά, 

αριθμητικά και γραφικά. Οι λεκτικές κρίσεις χρησιμοποιούν τις λέξεις Equal, 

Moderate, Strong, Very Strong, Extreme.  Οι γραφικές συγκρίσεις 

πραγματοποιούνται με  την επιλογή του μήκους των μπαρών ώστε αυτές να 

αναπαριστούν τις επιλογές του αποφασίζοντα. Τέλος στις αριθμητικές συγκρίσεις 

χρησιμοποιείται η αριθμητική κλίματα εννέα σημείων του Saaty. Ακόμα οι συγκρίσεις 

μπορούν να πραγματοποιηθούν με δύο τρόπους. Στον πρώτο ο χρήστης ξεκινά από 

τον στόχο και κατευθύνεται προς τα κάτω, προς τις εναλλακτικές λύσεις (top – down).  

Στον δεύτερο τρόπο ξεκινά από τις εναλλακτικές και ανεβαίνει προς τον στόχο 

(bottom-up).  



29 
 

Για να πραγματοποιηθούν  οι πρώτες συγκρίσεις των εναλλακτικών επιλογών 

σε σχέση με το πρώτο κριτήριο : 

 κλικ πάνω στο πρώτο κριτήριο της ιεραρχίας → Assessment → Pairwise 

 

Μεταφέρεται στον πίνακα συγκρίσεων : 

Στον πίνακα αυτόν συγκρίνονται  ανά ζεύγη τα κριτήρια επιλογής.  

Εναλλακτικά οι συγκρίσεις μπορούν να πραγματοποιηθούν από την γραμμή 

εργαλείων, όπου απλώς ο χρήστης επιλέγει τον τρόπο με τον επιθυμεί να 

πραγματοποίηση τις συγκρίσεις.  

 

 

 

 

 

 

 

Αριθμητικές 
συγκρίσεις Λεκτικές 

συγκρίσεις 

Γραφικές 
συγκρίσεις 
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Οι αντιστοιχίες των λεκτικών και των αριθμητικών συγκρίσεων αναφέρονται στον 

παρακάτω πίνακα : 

 

 

 
 
 
 
 
 
 
 

 

3.2 ΔΥΑΔΙΚΕΣ ΣΥΓΚΡΙΣΕΙΣ 

Ένα πολύ σημαντικό πλεονέκτημα της μεθόδου της Αναλυτικής Ιεράρχησης  

και του προγράμματος Expert Choice στο οποίο εφαρμόζεται αυτή, είναι η ανά ζεύγη 

σύγκριση των στοιχείων (εναλλακτικών και κριτηρίων). 

 Τα κριτήρια συγκρίνονται όλα ανά δύο  και σε κάθε σύγκριση εκτιμάται το 

ποιο είναι πιο σημαντικό,  ποιο έχει δηλαδή μεγαλύτερη βαρύτητα στην λήψη της 

απόφασης και την επίτευξη του τελικού στόχου αυτής.   

Οι εναλλακτικές επιλογές απόφασης συγκρίνονται κι αυτές ανά ζεύγη και 

εκτιμάται ποια είναι πιο σημαντική ή προτιμήτέα με γνώμονα το κάθε κριτήριο 

ξεχωριστά.  

Η σύγκριση όλων των στοιχείων μας  βοηθά στο να  προκύψουν ακριβή 

συμπεράσματα, όπως θα γινόταν και αν ακολουθούταν μια πιο παραδοσιακή 

προσέγγιση για τη λήψη μίας απόφασης. 

Οι συγκρίσεις είναι τριών ειδών:  

Σημαντικότητας (Importance), Προτίμησης (Preference) και Πιθανότητας 
(Likelihood). 

Λεκτική περιγραφή Αριθμητική περιγραφή 

 Extreme 9 

Very Strong 7 

Strong 5 

Moderate 3 

Equal 1 
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Γενικά, όταν θέλουμε να συγκρίνουμε τα κριτήρια ενός στόχου, η πιο 

κατάλληλη σύγκριση είναι η σύγκριση  με βάση τη Σημαντικότητα (Importance). 

Αντίστοιχα, καλύτερο είναι να επιλέξουμε την σύγκριση βάσει Προτίμησης 

(Preference) όταν θέλουμε να συγκρίνουμε εναλλακτικές λύσεις. Τέλος, 

χρησιμοποιούμε την σύγκριση  Πιθανότητας (Likelihood) όταν συγκρίνουμε τις 

πιθανότητες αβέβαιων γεγονότων και σεναρίων, όπως στην Ανάλυση Ρίσκου (Risk 

Analysis). 

Οι συγκρίσεις γίνονται με τρεις τρόπους και ονομάζονται: 

1. Αριθμητικές, όπου σε μία κλίμακα του 1-9 αναπαρίσταται το πόσες 

φορές ένα στοιχείο είναι σημαντικότερο από αυτό με το οποίο συγκρίνεται. 

2. Λεκτικές, όπου με τη χρήση των λέξεων Equal, Moderate, Strong, 

Very Strong, Extreme εκφράζεται το αποτέλεσμα της σύγκρισης το οποίο μπορεί 

να είναι από «Equal» το οποίο σημαίνει ότι τα δύο συγκρινόμενα στοιχεία είναι 

ίσης σημασίας μέχρι και «Extreme» το οποίο σημαίνει ότι το πρώτο στοιχείο από 

τα δύο που συγκρίνονται είναι απόλυτα πιο σημαντικό από το άλλο. Φυσικά, 

μπορεί να δοθεί και οποιοσδήποτε άλλος ενδιάμεσος χαρακτηρισμός. 

3. Γραφικές, όπου η σύγκριση γίνεται σε οριζόντιες ραβδους οι οποίες 

δείχνουν  το πόσες φορές ένα στοιχείο είναι σημαντικότερο από ένα άλλο, 

ανάλογα με το που θα μετακινήσουμε το δείκτη καθεμιάς. 

Για να επιλέγεί το είδος της σύγκρισης που θα ακολουθηθεί, πρέπει να γίνει 

επιλογή στο μενού: Αssessment  Type και μετά γίνεται η επιλογή του τύπου 

(Importance,Preference ή Likelihood.) 

 

ΛΕΚΤΙΚΕΣ ΣΥΓΚΡΙΣΕΙΣ ΤΩΝ ΚΡΙΤΗΡΙΩΝ 

 
Γενικά, επειδή η σχετική σημαντικότητα των κριτηρίων μπορεί να εξαρτηθεί 

από τις εναλλακτικές επιλογές, καλό είναι οι συγκρίσεις να γίνονται από «κάτω προς 

τα πάνω», δηλ. πρώτα να γίνονται για τις εναλλακτικές, ύστερα για τα υποκριτήρια 

και τέλος για τα κριτήρια. Σε αυτό το κεφάλαιο θα χρησιμοποιηθεί για λόγους 

κατανόησης η αντίθετη μέθοδος, δηλ. οι συγκρίσεις θα γίνουν από «πάνω προς τα 

κάτω». (κριτήρια υποκριτήρια      εναλλακτικές). 
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• Στο TreeView, κάνουμε κλικ στον τελικό μας στόχο (Goal) μέχρι να φωτιστεί. 

• Ύστερα, επιλέγουμε από το  μενού: Assessment à Pairwise,  

ή μπορούμε απλώς να πατήσουμε στην δεύτερη καρτέλα των συγκρίσεων 

από την γραμμή εργαλείων.  

 

 

 

 

Ακολούθως, θα εμφανιστεί το παράθυρο που δείχνει την λεκτική σύγκριση, όπως 

φαίνεται παρακάτω: 

 

 

Στο συγκεκριμένο παραδειγμα, υποθέτουμε ότι θέλουμε να αγοράσουμε έναν 

υπολογιστή. Τα κριτήρια που ορίσαμε, είναι η Αξιοπιστία, η Απόδοση, η 
Εξυπηρέτηση μετά την πώληση και η Τιμή. Βλέπουμε στο παράθυρο, ότι θα 

κάνουμε σύγκριση ανα ζεύγη κριτηρίων. Έτσι, πρώτα μας ζητείται να συγκρίνουμε 

την Απόδοση με την Αξιοπιστία. Αν θεωρούμε ότι το κριτήριο της Απόδοσης είναι 

εξαιρετικά σημαντικότερο από αυτό της αξιοπιστίας, μετακινούμε το δείκτη της 
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μπάρας στο πιο υψηλό σημείο, όπου αναγράφεται το Extreme. Στην αντίθετη 

περίπτωση, κατεβάζουμε το δείκτη στο χαμηλότερο σημείο. Φυσικά, μπορούμε να 

επιλέξουμε και οποιαδήποτε ενδιάμεση επιλογή που νιώθουμε ότι εκφράζει καλύτερα 

αυτή τη σύγκριση. 

Μετακινώντας τον δείκτη, βλέπουμε στο κάτω μέρος του παραθύρου ότι 

αποδίδονται αριθμοί στις συγκρίσεις. Αν επιλέξουμε π.χ. το Moderate στην επάνω 

πλευρά, θα εμφανιστεί ο αριθμός 3. Αυτό σημαίνει ότι η Απόδοση είναι πιο σημαντική 

από την Αξιοπιστία τρεις φορές, δηλαδή μέτρια σημαντικότερη. 

 

Μετά, θα προχωρήσουμε στην επόμενη σύγκριση πηγαίνοντας δίπλα. Για να μας 

οδηγεί το πρόγραμμα απευθείας μετά από κάθε σύγκριση στην επόμενη, πρέπει να 

επιλέξουμε Τools à Options àCalculation και να ενεργοποιήσουμε την ανάλογη 

επιλογή. 



34 
 

 

Μπορούμε αν θέλουμε, αντί να κάνουμε τις συγκρίσεις λεκτικά, απλά να 

εισάγουμε τους ανάλογους αριθμούς συγκρίσεων, αφού όπως είναι κατανοητό, η 

έκφραση Extreme εκφράζεται από τον αριθμό 9 της κλίμακας των αριθμητικών 

εκφράσεων και το Εqual από το 1 και όλες οι ενδιάμεσες εκφράσεις από τους 

ενδιάμεσους αριθμούς της κλίμακας 1-9. 

Όταν λοιπόν γίνουν όλες οι συγκρίσεις μεταξύ των στοιχείων, θα εμφανιστεί το 

παράθυρο διαλόγου στο οποίο θα μας ζητηθεί να αποθηκεύσουμε τα στοιχεία μας. 

Μετά την αποθήκευση  επιστρέφουμε στο ModelView όπου θα δούμε αμέσως και τα 

αποτελέσματα.  

Αν θέλουμε να κάνουμε κάποια αλλαγή, θα πατήσουμε πάλι την καρτέλα των 

Λεκτικών συγκρίσεων και θα μεταφερθούμε στο ανάλογο παράθυρο.  

Μπορούμε επίσης, να δούμε σε γράφημα τις προτεραιότητες που προέκυψαν 

από τις συγκρίσεις αν πατήσουμε την καρτέλα προτεραιοτήτων.  
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Αποτελέσματα 

 

Προτεραιότητες-Γράφημα 

 

 

 

 

 

 

ΠΑΡΑΘΥΡΟ ΓΡΑΦΗΜΑΤΟΣ ΠΡΟΤΕΡΑΙΟΤΗΤΩΝ 

Το παράθυρο στο οποίο βλέπουμε τις προτεραιότητές, μας δίνει τη 

δυνατότητα να κάνουμε ταξινόμηση σε αυτές, είτε φθίνουσα με τα αριθμητικά 

δεδομένα είτε αλφαβητική με τους τίτλους των κριτηρίων. 

Σημείωση: Όσο κάνετε τις συγκρίσεις μπορείτε επίσης, να πατήσετε το κουμπί 

από την μπάρα εργαλείων Calculate για να αποθηκεύσετε και να υπολογίσετε τις 

προτεραιότητές σας. Το κουμπί θα είναι χρωματισμένο κίτρινο ή πράσινο. Αν 

είναι κόκκινο σημαίνει ότι δεν έχουν γίνει επαρκείς συγκρίσεις για να 
υπολογιστούν οι προτεραιότητες. Όταν είναι πράσινο, σημαίνει ότι έχουν γίνει 

όλες και όταν είναι κίτρινο δείχνει ότι λείπουν κάποιες αλλά υπάρχει επαρκής 

αριθμός, έτσι ώστε να γίνουν οι υπολογισμοί. 
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Παρατηρούμε επίσης ότι υπάρχει ένα checkbox με τίτλο Normalize. Αν το 

τσεκάρουμε θα δούμε ότι δίνεται στην μεγαλύτερη προτεραιότητα η τιμή 1,000 και οι 

υπόλοιπες παίρνουν τιμή αναλογική προς αυτή.  

 

 

 

 

 

 

Αν σε κάποιο σημείο θέλουμε να βελτιώσουμε το ποσοστό Ασυνέπειας που 

έχει προκύψει, επιστρέφουμε στο παράθυρο συγκρίσεων που εργαστήκαμε και 

επιλέγουμε στο μενού: 

1. Incοnsistencyà1st.για να δούμε ποια είναι η πιο ασυνεπής σύγκριση 

που έχουμε κάνει. Το κελί που θα είναι επιλεγμένο (κίτρινο), είναι το εν λόγω κελί 

που δημιουργεί την ασυνέπεια. 

2. Ιnconsistency à Best fit, όπου θα μας υποδείξει το πρόγραμμα ποια 

είναι η πιο σωστή τιμή που μπορεί να δοθεί στην ασυνεπή σύγκριση. 
 

ΓΡΑΦΙΚΕΣ ΣΥΓΚΡΙΣΕΙΣ ΓΙΑ ΤΑ ΥΠΟΚΡΙΤΗΡΙΑ 

• Επιστρέφουμε στην καρτέλα Model View.  

• Κλικάρουμε το κριτήριο που περιέχει τα υποκριτήρια. (Στο συγκεκριμένο 

παράδειγμα, το Performance (Απόδοση)). 

• Ακολούθως, πατάμε την καρτέλα Graphical Tab. 

 
Αφού μεταφερθούμε στο παράθυρο των γραφικών συγκρίσεων, βλέπουμε τα 

δυο υποκριτήρια και δύο μπάρες μία μπλε και μία κόκκινη όπου μπορούμε να 

Inconsistency: η έννοια αυτή εκφράζει την ασυνέπεια, δίνεται δηλαδή για να εκφραστεί 

το ποσοστό ασυνέπειας που υπάρχει στις συγκρίσεις που κάναμε. Ελέγχει λοιπόν τα 

λάθη που μπορεί να έγιναν και έτσι να μην προκύπτει ένα λογικό συμπέρασμα. Ένα π.χ. 

λάθος μπορεί να είναι το εξής: Υποθέτουμε ότι το Α είναι πιο σημαντικό από το Β και το 

Β πιο σημαντικό από το Γ. Συνεπώς, αν μετά πούμε ότι το Γ είναι πιο σημαντικό από το 

Α, πέφτουμε σε ένα λάθος, σε ασυνέπεια. Όταν κάνουμε calculate στο πρόγραμμα και 

ζητήσουμε τα αποτελέσματα, το ποσοστό της Inconsistency θα είναι μεγάλο και θα 

πρέπει να επιστρέψουμε στο παράθυρο των συγκρίσεων, για να κάνουμε διορθώσεις.   

Γενικά, η Inconsistency θα πρέπει να φτάνει σε ποσοστό μέχρι 0,1. 
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μετακινήσουμε ανάλογα με την σύγκριση που θέλουμε να κάνουμε, με σεβασμό 

πάντα προς το κριτήριο «Απόδοση». 

Τραβώντας την επάνω μπάρα προς τα δεξιά, σημαίνει ότι το πάνω κριτήριο 

είναι πιο σημαντικό από το κάτω και αντιστρόφως. 

 

Τελειώνοντας, θα εμφανιστεί το παράθυρο διαλόγου που θα μας ρωτά αν 

θέλουμε να αποθηκευτούν τα στοιχεία μας. Αν επιλέξουμε το «ναι», θα επιστρέψουμε 

στο Model View. Aν επιλέξουμε το «όχι»,  μπορούμε να πατήσουμε το κουμπί 

Calculate και να δούμε το Γράφημα προτεραιοτήτων. 

 

ΑΡΙΘΜΗΤΙΚΕΣ ΣΥΓΚΡΙΣΕΙΣ ΓΙΑ ΤΙΣ ΕΝΑΛΛΑΚΤΙΚΕΣ ΕΠΙΛΟΓΕΣ 

Αφού λοιπόν έχουμε κάνει όλες τις συγκρίσεις για τα κριτήρια και τα 

υποκριτήρια, πρέπει να κάνουμε και τις συγκρίσεις για τις εναλλακτικές επιλογές. 

• Από το Treeview, την ιεραρχική απεικόνιση, επιλέγουμε το πιο χαμηλά στη 

δομή του «δέντρου» στοιχείο, το υποκριτήριο. (Στο παράδειγμά μας, το 

SPEED.) 

• Κλικάρουμε την καρτέλα της Αριθμητικής σύγκρισης. 



38 
 

 

Βλέπουμε ότι εμφανίζεται το παράθυρο της αριθμητικής σύγκρισης, όπου θα 

πρέπει να συγκρίνουμε τις εναλλακτικές επιλογές της απόφασης, λαμβάνοντας 

υπ΄όψιν το υποκριτήριο που επιλέξαμε στο Treeview. (To Speed στο συγκεκριμένο 

παράδειγμα.) 

Οι συγκρίσεις μπορούν να γίνουν είτε μετακινώντας το δείκτη της μπάρας 

δεξια- αριστερά, είτε κλικάροντας τους αριθμούς της διαβαθμισμένης μπάρας. 

Αφού γίνουν όλες οι συγκρίσεις, θα ζητηθεί από το πρόγραμμα να 

αποθηκευτούν και θα επιστρέψει πάλι στο ModelView. Εκεί, θα κάνουμε την ίδια 

διαδικασία για να γίνουν οι συγκρίσεις με το επόμενο υποκριτήριο, καθώς και με όλα 

τα κριτήρια που έχουμε εισάγει στην ιεραρχία του δέντρου. 

Eναλλακτικά, μπορούμε να επιλέξουμε:  

Στο μενού Go à Next Unassesed και να οδηγούμαστε απευθείας στο επόμενο 

κριτήριο που δεν έχει εκτιμηθεί. 

 

 

  

Όταν έχουν γίνει όλες οι συγκρίσεις, όλων των κριτηρίων, τότε οι κύκλοι που 

αναφέραμε πιο πάνω θα αντικατασταθούν από τα Priority Fills, πράσινα 

τετραγωνάκια τα οποία δείχνουν γραφικά τις προτεραιότητες που έχουν προκύψει 

από τις συγκρίσεις. 

Μπορούμε να πηγαίνουμε από τη μορφή αυτή με τα τετραγωνάκια στους 

κύκλους και αντίστροφα, με την εντολή View από το μενού. 

 

 

Σημείωση: Δίπλα από κάθε κριτήριο υπάρχει ένας κύκλος με ένα κόκκινο σημείο 
μέσα του. Αυτό υποδεικνύει ότι το συγκεκριμένο κριτήριο δεν έχει εκτιμηθεί, δεν 
έχει συγκριθεί με τα υπόλοιπα. Όταν γίνουν όλες οι συγκρίσεις για κάθε κριτήριο, το 
κόκκινο σημείο εξαφανίζεται και μένει μόνο ο μαύρος ή ο κίτρινος κύκλος. 
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Τελική μορφή μετά από όλες τις συγκρίσεις 

 

 

3.3 ΚΑΘΙΣΤΩΝΤΑΣ ΕΝΑ ΣΤΟΙΧΕΙΟ ΑΝΕΝΕΡΓΟ 

Το μοντέλο μας στο Expert Choice έχει πλέον ολοκληρωθεί. Μπορούμε 

λοιπόν, να εξάγουμε τα συμπεράσματα μας. Πριν από αυτό όμως, καλό θα ήταν να 

μάθουμε την έννοια της απενεργοποίησης ενός κριτηρίου ή μιας εναλλακτικής. 

Έχουμε τη δυνατότητα στο Expert Choice να καταστήσουμε ανενεργό ένα 

στοιχείο (κριτήριο ή εναλλακτική) και έτσι να μην λάβει μέρος στη διαδικασία του 

ορισμού προτεραιοτήτων (όταν γίνονται οι συγκρίσεις). Επίσης, μπορούμε να 

καταστήσουμε ανενεργό ένα στοιχείο ενώ έχει μπει στη διαδικασία των 

προτεραιοτήτων, αποκλείοντάς το από τη διαδικασία της εξαγωγής των τελικών 

αποτελεσμάτων. 

Αυτό, μπορεί να γίνει με τον εξής τρόπο: από οποιαδήποτε παράθυρο συγκρίσεων, 

• Πατάμε Ctrl και κρατώντας το πατημένο, κλικάρουμε το στοιχείο που θέλουμε. 

Έτσι, το στοιχείο μπλοκάρεται και μαζί με αυτό και κάθε σύγκριση που το 

περιελάμβανε. 

• Για να απενεργοποιήσουμε το «μπλοκάρισμα» του στοιχείου που αναφέραμε, 

αρκεί να κάνουμε την ίδια διαδικασία, δηλ. Ctrl και κλικ στο στοιχείο. 
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3.4 ΣΥΝΘΕΣΗ ΣΤΟΙΧΕΙΩΝ – ΕΞΑΓΩΓΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ ΑΠΟ ΤΟ 
ΜΟΝΤΕΛΟ ΤΟΥ EXPERT CHOICE 

Αφού μάθαμε πώς θα φτιάξουμε το μοντέλο μας στο Expert Choice, ήρθε η 

ώρα να λάβουμε και τα αποτελέσματα για το πρόβλημά απόφασης: 

• Βρισκόμενοι στο ModelView, επιλέγουμε από το μενού: 

 Synthesize à With Respect to Goal . 

Εμφανίζεται η παρακάτω εικόνα: 

 

Μπορούμε επίσης, να κάνουμε σύνθεση προς εξαγωγή αποτελεσμάτων από 

οποιονδήποτε κόμβο θέλουμε, επιλέγοντας στο μενού Synthesis à With respect to 

Current Node (έχοντας κλικάρει τον κόμβο τον οποίο θέλουμε). 

 

3.5 ΠΑΡΑΤΗΡΗΣΕΙΣ 

Στο επάνω μέρος αριστερά του παραθύρου υπάρχουν δύο επιλογές. Η Ideal 

mode που είναι και η προεπιλεγμένη και η Distributive Mode. 
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• Η Ideal mode είναι η ιδανική σύνθεση, η οποία υποδεικνύει την καλύτερη 

εναλλακτική λαμβάνοντας υπ΄ όψιν πλήρως όλες τις συγκρίσεις που έγιναν 

και τις προτεραιότητες που προέκυψαν. Έτσι, η εναλλακτική που προτείνεται 

πρώτη είναι η καλύτερη και οι υπόλοιπες παίρνουν κάποια αριθμητικά 

ποσοστά αναλογικά προς αυτήν. Είναι σωστό να χρησιμοποιούμε αυτή τη 

μέθοδο σύνθεσης όταν επιθυμούμε να επιλέξουμε μόνο μία από τις 

εναλλακτικές. 

• Η Distributive Mode, χρησιμοποιείται όταν θέλουμε να θέσουμε σε μία σειρά 

προτεραιότητας τις εναλλακτικές μας και να επιλέξουμε περισσότερες από 

μία, εξ αυτών. Έτσι, ενώ στην Ιδανική σύνθεση προκύπτει μία ιδανική λύση 

με ένα αριθμητικό ποσοστό και οι υπόλοιπες παίρνουν ποσοστό αναλογούν 

σε αυτό, εδώ το ποσοστό μοιράζεται στις εναλλακτικές και τις θέτει σε μία 

σειρά προτεραιότητας για να επιλέξουμε τις πιο σημαντικες. 

 

Συνήθως, θα παρατηρήσουμε κάποιες μικρές αλλαγές αλλά γενικότερα τα 

αποτελέσματα της μίας και της αλλης σύνθεσης θα μοιάζουν πολύ. 

Στο παράθυρο υπάρχουν δύο καρτέλες: η Summary και η Details. 

• Η Summary, μας δείχνει ραβδογράμματα των εναλλακτικών λύσεων και τη 

σειρά προτεραιότητας που έχουν πάρει αυτές, αφού έχουν γίνει όλες οι 

συγκρίσεις. Η εμφάνιση αυτής της επιλογής φαίνεται στην πιο πάνω εικόνα. 

• Η Details, εμφανίζει έναν πίνακα ο οποίος παρουσιάζει αριθμητικά όλες τις 

προτεραιότητες που έχουν προκύψει από τις συγκρίσεις των κριτηρίων και 

των εναλλακτικών. 

 

 

 

Aποτελέσματα- Details 
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Για να επιστρέψουμε στο παράθυρο της ιεραρχίας, επιλέγουμε File àClose. 

 

3.6 ΑΝΑΛΥΣΗ ΕΥΑΙΣΘΗΣΙΑΣ 

Η Ανάλυση Ευαισθησίας σε ένα μοντέλο μπορεί να γίνει: 

• Στον κόμβο του στόχου, για να παρατηρήσουμε τις αλλαγές που θα 

προκύψουν στις εναλλακτικές αν αλλάξουν τα δεδομένα κάποιων κριτηρίων 

• Σε κάποιον άλλο κόμβο του δέντρου της ιεραρχίας, αν το μοντέλο μας έχει 

περισσότερα από τρία επίπεδα, για να παρατηρήσουμε την ευαισθησία των 

εναλλακτικών ως προς την αλλαγή ενός κριτηρίου ή υποκριτηρίου. 

Tα είδη της Ανάλυσης Ευαισθησίας είναι πέντε: 

1. Dynamic (Δυναμική): Χρησιμοποιείται όταν γίνονται δυναμικές 
αλλαγές στις προτεραιότητες των κριτηρίων, για να δούμε πόσο θα επηρεαστούν 

οι προτεραιότητες των εναλλακτικών. 

Για να την υλοποιήσουμε,  

• Κλικάρουμε τον στόχο 

• Από το μενού επιλέγουμε Sensitivity_Graphs à Dynamic και  

εμφανίζεται το ακόλουθο παράθυρο: 



43 
 

 

Σε αυτό το παράθυρο μπορούμε μετακινώντας τις μπάρες αριστερά και δεξιά, να 

αλλάζουμε τις προτεραιότητες και να βλέπουμε κάθε φορά πώς επηρεάζονται οι 

προτεραιότητες των εναλλακτικών λύσεων. 

 Για να επιστρέψουμε στις αρχικές προτεραιότητες, επιλέγουμε από το μενού Options 

à Home ή κλικάρουμε το κουμπί Home που βρίσκεται πρώτο αριστερά στην γραμμή 

εργαλείων. 

Στη γραμμή εργαλείων βλέπουμε ότι υπάρχει η δυνατότητα να ανοίξουμε και άλλα 

παράθυρα ανάλυσης ευαισθησίας, πατώντας στα ανάλογα κουμπιά. Μπορούμε να 

έχουμε ταυτόχρονα ανοιχτά μέχρι και τέσσερα παράθυρα ανοιχτά. 

 

2. Performance (Απόδοσης): Γράφημα που δείχνει το πώς οι 

εναλλακτικές τέθηκαν σε σειρά προτεραιότητας μεταξύ τους με σεβασμό προς 

κάθε κριτήριο ξεχωριστά, αλλά και προς όλα τα κριτήρια συνολικά. 

Για να την υλοποιήσουμε, 

• Κλικάρουμε τον στόχο 

• Από το μενού επιλέγουμε Sensitivity_Graphs à Performance και  

εμφανίζεται το ακόλουθο παράθυρο: 
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Για να συγκρίνουμε τον πρώτο υπολογιστή με τους υπόλοιπους, θα 

κοιτάξουμε ποια είναι η συνολική προτεραιότητα από τον άξονα δεξιά και το 

OVERALL που  δείχνει τη συνολική προτεραιότητα κάθε εναλλακτικής. Στο 

συγκεκριμένο παράδειγμα, βλέπουμε ότι ο υπολογιστής της Sony έχει ποσοστό 0.44, 

ο Toshiba 0.39 και ο Acer 0.17. Παρατηρούμε ότι το άθροισμα των ποσοστών, 

ισούται βεβαίως με τη μονάδα. 

Για να δούμε τις προτεραιότητες των κριτηρίων μετά τις συγκρίσεις που έγιναν, 

θα κοιτάξουμε στον άξονα αριστερά. Στο παράδειγμά μας, το κριτήριο Reliability 

πήρε ποσοστό 0.54, το Performance 0.32, το Αfter Sales 0.05 και το Price 0.10. 

Για να δούμε τις προτεραιότητες κάθε κριτηρίου για κάθε μία εναλλακτική, 

κοιτάζουμε στον άξονα δεξιά. 

Εδώ π.χ., οι τιμές του κριτηρίου Reliability είναι για τον υπολογιστή Sony 0.68, 

για τον Toshiba 0.20 και για τον Acer περίπου 0.12.  Για να βρούμε αυτές τις τιμές, 

κοιτάμε στη γραμμή που αναπαριστά τις προτεραιότητες κάθε υπολογιστή στο σημείο 

που βρίσκεται το κριτήριο που μας ενδιαφέρει και μετά τραβώντας μία νοητή ευθεία 

προς τον άξονα δεξιά, βλέπουμε το ποσοστό που αντιστοιχεί.  

Φυσικά, τα ποσοστά αυτά μπορούμε με ακρίβεια να δούμε στο ModelView, 

όπου κλικάροντας σε κάθε κριτήριο, βλέπουμε τις προτεραιότητες αυτού για κάθε 
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εναλλακτική, στο πλαίσιο των εναλλακτικών επιλογών που βρίσκεται επάνω δεξιά 

στην οθόνη.  

Το συγκεκριμένο γράφημα είναι δυναμικό, έτσι μπορούμε να κάνουμε όποιες 

αλλαγές θέλουμε προσωρινά μετακινώντας τις μπάρες των κριτηρίων προς τα πάνω 

ή προς τα κάτω για να δούμε τις επιπτώσεις στις προτεραιότητες των εναλλακτικών. 

Για να επανέλθουμε στις αρχικές προτεραιότητες, θα κλικάρουμε το κουμπί Home ή 

από το μενού θα επιλέξουμε Options à Home. 

 

3.7 ΔΟΜΗ ΜΟΝΤΕΛΟΥ 

Το Expert Choice προσφέρει μια ελεύθερη, διαδραστική τεχνική για την 

κατασκευή ενός μοντέλου. Υπάρχουν δυο τεχνικές προσέγγισης για την κατασκευή 

του μοντέλου.  

Η top – down κατασκευή ταιριάζει καλύτερα σε αποφάσεις στρατηγικής 

φύσεως όπου τα κριτήρια είναι περισσότερο κατανοητά ή γνωστά απ’ ότι οι 

εναλλακτικές. Τα υψηλότερου επιπέδου κριτήρια προκύπτουν από την αναγνώριση 

των υπό – κριτηρίων. 

Η bottom-up κατασκευή είναι πιο ταιριαστή σε προβλήματα όπου οι 

εναλλακτικές είναι περισσότερο κατανοητές απ’ ότι τα κριτήρια. Τα πλεονεκτήματα 

και τα μειονεκτήματα των εναλλακτικών χρησιμοποιούνται για να αναγνωριστούν τα 

κριτήρια τα οποία μπορούν να ομαδοποιηθούν σε ομάδες. 

 

ΘΕΩΡΗΤΙΚΗ ΘΕΜΕΛΙΩΣΗ ΤΗΣ ΔΟΜΗΣΗΣ 

Όταν χρησιμοποιείται  η δόμηση ατομικά ή σε ομάδα, ακολουθώντας την top-

down ή την bottom-up, η δόμηση παρέχει ένα πλαίσιο όπου ο λήπτες της απόφασης 

χρησιμοποιούν τις γνώσεις τους για το πρόβλημα για να αναγνωρίσουν και να 

οργανώσουν τους παράγοντες της απόφασης.  
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Με μια ομάδα ο Συντονιστής οδηγεί την συζήτηση, εισάγοντας κριτήρια και 

εναλλακτικές, θετικά ή αρνητικά. Τότε ο Συντονιστής ομαδοποιεί τα περιεχόμενα 

σύμφωνα με τους συμμετέχοντες.  

Αυτά τα στοιχεία μετά τοποθετούνται σε ένα ιεραρχικό μοντέλο το οποίο 

αποτελείται από κριτήρια, υπό – κριτήρια και εναλλακτικές.  

Κάθε εναλλακτική μπορεί να έχει θετικά (pros) και / ή μειονεκτήματα (cons) τα 

οποία μερικές φορές περιπλέκονται από το γεγονός ότι τα πλεονεκτήματα μιας 

εναλλακτικής μπορεί να είναι μειονεκτήματα μιας άλλης. Χρησιμοποιώντας την 

Δόμηση, οι λήπτες της απόφασης θα παραθέσουν σε λίστα τις θετικές και αρνητικές 

όψεις κάθε εναλλακτικής στο μοντέλο απόφασης.  

Η ομάδα των θετικών και  αρνητικών είναι μια ″πισίνα″ ιδεών η οποία βοηθά 

στην αναγνώριση των σημαντικών κριτηρίων που πρέπει να επιτευχθούν 

προκειμένου να επιλυθεί το ζήτημα. Από την στιγμή που τα κριτήρια εμπεριέχουν 

αυτές τις ιδέες, τα πλεονεκτήματα και τα μειονεκτήματα θα χρησιμοποιηθούν για την 

δημιουργία των κριτηρίων. 

Η μετατροπή των πλεονεκτημάτων και των μειονεκτημάτων σε κριτήρια 

σημαίνει την οργάνωση των πλεονεκτημάτων και των μειονεκτημάτων κάθε 

εναλλακτικής σε σχέση με τον κύριο στόχο ή κριτήριο. Τα  πλεονεκτήματα και τα 

μειονεκτήματα αξιολογούνται για τις εναλλακτικές και παράγεται μια λίστα κριτηρίων. 

Η διεπάφη της Δόμησης περιέχει τα ακόλουθα οικεία στοιχειά για την δημιουργία του 

ιεραρχικού  μοντέλου, θετικά – αρνητικά, κριτήρια και υπό-κριτήρια.  

O λήπτης της απόφασης είναι αυτός που θα μετατρέψει τα πλεονεκτήματα και 

τα μειονεκτήματα σε κριτήρια. Ωστόσο η μετατροπή των πλεονεκτημάτων και των 

μειονεκτημάτων σε κριτήρια απαιτεί έναν τρόπο σκέψης σχετικά με το ποια κριτήρια 

στοχεύουν τα πλεονεκτήματα και τα μειονεκτήματα. Πιο συγκεκριμένα, 

χρησιμοποιώντας τα πλεονεκτήματα και τα μειονεκτήματα για να παραχθούν κριτήρια 

πρέπει να αντιληφθούμε ξανά  τα πλεονεκτήματα και τα μειονεκτήματα έτσι ώστε να  

περιγράφονται με αριθμητικούς όρους, παρά με τον αρνητικό και θετικό τρόπο που 

εκφράζουν τα πλεονεκτήματα και τα μειονεκτήματα. Να προσδιορίζονται με έναν 

γενικό τρόπο, υπάρχουν 2 τεχνικές Δόμησης για το χτίσιμο του μοντέλου, top-down 

και bottom-up.  
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Αυτοί οι δυο όροι δεν βασίζονται στην θεωρία της Αναλυτικής Ιεραρχικής 

Προσέγγισης αλλά οι χρήστες του Expert Choice δεν θα πρέπει να ερμηνεύουν 

αυτούς τους όρους άκαμπτα για 2 λόγους, η bottom-up δόμηση σημαίνει ότι ο 

χρήστης αρχίζει την κατασκευή του μοντέλου απόφασης με τις εναλλακτικές και 

εργάζεται προς τον στόχο. Ενώ  η top- down δόμηση σημαίνει ότι αρχίζει από την 

παράθεση σε λίστα και οργάνωση των αντικειμενικών.  

 

3.8 ΚΑΤΑΣΚΕΥΗ ΜΟΝΤΕΛΟΥ ΜΕΣΩ ΤΗΣ TOP-DOWN ΤΕΧΝΙΚΗΣ 

Η συγκεκριμένη τεχνική παρέχει μια απλή τυποποίηση για τον προσδιορισμό 

κριτήριων και υπό – κριτήριων και για την αξιολόγηση των εναλλακτικών.  

Για την υλοποίηση της συγκεκριμένης τεχνικής ακολουθείτε η εξής διαδικασία : 

• Ανοίγουμε το Expert Choice 

• File → New, από την γραμμή εργαλείων. 

• Στο παράθυρο διαλόγου εισάγουμε  το όνομα του αρχείου, στην συγκεκριμένη 

περίπτωση : Vehicle. Κατόπιν Enter. 

• Στην περιγραφή του στόχου εισάγουμε  : To purchase the most preferred 

vehicle.  

Για μετάβαση στην Δόμηση : 

• Tools → Options → General  

• Στο Structuring box επιλέγουμε  Enable button → Close. 

• Από την γραμμή εργαλείων επιλέγουμε View → ClusterView pane ή απλώς 

κλικ στο εικονίδιο . 

Η οθόνη πλέον έχει την παρακάτω μορφή: 
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ΠΡΟΣΘΗΚΗ ΚΡΙΤΗΡΙΩΝ 

Η διαδικασία για την προσθήκη κριτήριων είναι η ακόλουθη.  

• Κλικ πάνω στο objective/criterion/group, το ποίο βρίσκετε στο 

κεντρικό παράθυρο.  

• Στο παράθυρο διαλόγου που θα εμφανιστεί εισάγουμε ένα 

κριτήριο. Εδώ θα εισάγουμε το κριτήριο Style. 

• Στο κεντρικό παράθυρο θα εμφανιστεί το κριτήριο που εισάχθηκε, 

το οποίο θα βρίσκεται μέσα σε ένα χρωματισμένο τετράγωνο, ενώ η κόκκινη 

κουκίδα προσδιορίζει το που θα τοποθετηθεί το επόμενο κριτήριο.   
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Τώρα επαναλαμβάνεται η ίδια διαδικασία για την εισαγωγή των υπόλοιπων  

κριτήριων. Τα οποία είναι τα κάτωθι : 

• Engine performance 

• Safety 

• Price 

• Horsepower 

• Acceleration 

• Crash test score 

• Braking distance 

• Initial cost 

• Resale value 

Αν δεν εμφανίζεται ολόκληρο το όνομα του κριτηρίου τότε ακολουθείται η  εξής 

διαδικασία : 

• Tools → Options  

• View → Στο δεύτερο κουτί του παραθύρου. 

• Αλλάζουμε των αριθμό χαρακτήρων σε 20  

• Ένα φωτεινό κουτί θα εμφανιστεί  στο ClusterView και θα TIP 

 

Η εικόνα απεικονίζει την οθόνη μετά την εισαγωγή όλων των κριτηρίων 

 

Για να τοποθετηθεί ένα υπάρχων κριτήριο, σύρουμε στο σημείο που επιθυμεί ο 
χρήστης. Για να προσδιορισθεί η τοποθέτηση ενός νέου κριτήριου κάνουμε ένα 
κλικ οπουδήποτε μέσα στο ClusterView σύρει ένα κουτί με το ποντίκι. Κατόπιν 
εισάγουμε το κριτήριο.   
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ΟΜΑΔΟΠΟΙΗΣΗ ΙΔΕΩΝ 

Από την στιγμή που ο χρήστης είναι ικανοποιημένος  με την λίστα των 

κριτηρίων, είναι έτοιμος να ομαδοποιήσει τα κριτήρια αναγνωρίζοντας αυτά τα 

κριτήρια τα οποία ανήκουν στην ίδια κλάση και κατόπιν τοποθετώντας τα κριτήρια 

μέσα σε αυτήν την κλάση. Ένα κριτήριο το οποίο δεν μπορεί να τοποθετηθεί μέσα σε 

κάποια κλάση τότε το συγκεκριμένο κριτήριο μπορεί να αυτονομηθεί.  

Προκείμενου να ομαδοποιηθούν τα κριτήρια σε κλάσεις ακολουθούνται τα εξής : 

• Κλικ πάνω στο κριτήριο το οποίο επιθυμούμε να μετακινηθεί, εδώ το «Engine 

Performance», το κριτήριο θα φωτιστεί. 

• Σύρουμε το κριτήριο στα δεξιά της λίστας των κριτηρίων.  

• Κλικ πάνω στο επόμενο κριτήριο, « Horsepower», το οποίο τώρα θα φωτιστεί. 

• Σύρουμε το κριτήριο και το τοποθετούμε  πάνω στο «Engine Performance». 

Τώρα το Horsepower έχει ομαδοποιηθεί στο κουτί του Engine Performance 

• Τώρα ομαδοποιούνται και τα υπόλοιπα κριτήρια . οι κλάσεις που θα 

δημιουργηθούν είναι οι : Acceleration to engine Performance, Crash Test 

Score και Braking distance με το Safety, Initial Cost και Resale Value και 

Price.  
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Η εικόνα πλέον θα είναι η εξής : 
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αχθεί ένα κριτήριο είναι ο εξής : κλικ οπουδήποτε μέσα στο ClusterView και να σύρουμε το ποντίκι 

μέχρι που να σχεδιαστεί ένα ορθογώνιο κουτί, ταυτόχρονα θα εμφανιστεί ένα παράθυρο διαλόγου, 

που θα προτρέπει να εισαχθεί το κριτήριο. 

 

ΕΙΣΑΓΩΓΗ ΕΝΑΛΛΑΚΤΙΚΩΝ 

Τώρα που τα κριτήρια και τα υπό-κριτήρια είναι ομαδοποιημένα πρέπει να εισαχθούν 

οι εναλλακτικές.  

Κλικ στο «Add Alternative» κουμπί  ή επιλέγουμε Edit → Insert → Alternative, 

από την γραμμή εργαλείων. 

Για τις ανάγκες του παραδείγματος εισάγονται τις εξής εναλλακτικές λύσεις : 

Clydesdale, Arabian, Palomino.  
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ΠΑΡΟΥΣΙΑΣΗ ΤΗΣ ΙΕΡΑΡΧΙΑΣ 

 Για να παρουσιαστεί η ιεραρχία κλικ πάνω στο  ή επιλέγουμε από την μπάρα 

εργαλείων : View → TreeView pane.  

  

Από το σημείο αυτό και μετά πραγματοποιούνται οι δυαδικές συγκρίσεις όπως έχει 

ήδη αναφερθεί.  

 

ΟΜΑΔΟΠΟΙΗΣΗ ΚΟΜΒΩΝ ΣΤΗΝ ΙΕΡΑΡΧΙΑ 

Αν έχει ήδη κατασκευαστεί η ιεραρχία και επιθυμούμε να δημιουργηθεί άλλο ένα 

υψηλού επιπέδου κριτήριο τότε πραγματοποιείται η εξής διαδικασία :  

• Από την TreeView όψη μεταφερόμαστε  στην Cluster View μορφή κάνοντας 

ένα αριστερό κλικ στο εικονίδιο :  

• Σύρουμε  το Style και το Engine Performance το ένα κοντά στο άλλο. 

• Με το ποντίκι σύρουμε  και δημιουργούμε ένα κουτί γύρω από αυτά. 

• Στο παράθυρο διαλόγου που θα εμφανιστεί πληκτρολογούμε  ένα όνομα για 

το κριτήριο όπως Features. 
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Για να διαγράφει η προηγούμενη ενέργεια : 

• Σύρουμε το Style και το Engine Performance από την ομάδα features  

• Κλικ στο  features και κατόπιν  Delete. 

 

3.9 ΚΑΤΑΣΚΕΥΗ ΜΟΝΤΕΛΟΥ ΜΕ ΤΗΝ ΧΡΗΣΗ ΤΗΣ «ΑΠΟ ΚΑΤΩ 
ΠΡΟΣ ΤΑ ΠΑΝΩ» ΚΑΤΑΣΚΕΥΗΣ 

Σε αυτή την διαδικασία κατασκευής μοντέλου, αρχίζουμε να δομούμαι το μοντέλο 

απόφασής μας με τις εναλλακτικές. Αυτή είναι μια καλή προσέγγιση όταν οι 

περισσότερες εναλλακτικές είναι γνωστές σε σχέση με τα κριτήρια. 

Για να μπορέσουμε να χρησιμοποιήσουμε αυτό το είδος κατασκευής μοντέλου, θα 

πρέπει πρώτα να εισάγουμε τις εναλλακτικές, μετά τα πλεονεκτήματα και τα 

μειονεκτήματα κάθε εναλλακτικής και τέλος να μετατρέψουμε αυτά τα πλεονεκτήματα 

και μειονεκτήματα σε κριτήρια. 

• Ξεκινάμε το Expert Choice και από το μενού επιλέγουμε File -> New 

• Πληκτρολογούμε το όνομα του αρχείου, εδώ Vehicle2. 

• Πληκτρολογούμε την περιγραφή του στόχου, πχ να αγοράσουμε το πιο 

επιθυμητό ποδήλατο. 

 

ΕΙΣΑΓΩΓΗ ΕΝΑΛΛΑΚΤΙΚΩΝ 

• Από το παράθυρο ModelView κάνουμε κλικ στο κουμπί Add Alternative.  

• Προσθέτουμε τις εναλλακτικές που επιθυμούμε (πχ. Για το συγκεκριμένο 

παράδειγμα Clydesdale, Arabian και Palomino) όπως αναπτύχθηκε σε 

προηγούμενο κεφάλαιο. 

 

ΕΙΣΑΓΩΓΗ ΠΛΕΟΝΕΚΤΗΜΑΤΩΝ ΚΑΙ ΜΕΙΟΝΕΚΤΗΜΑΤΩΝ ΤΩΝ 
ΕΝΑΛΛΑΚΤΙΚΩΝ 
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• Αυτό γίνεται κάνοντας κλικ πάνω στο button Pros / Cons pane, πάνω στο 

TreeView, διαφορετικά από το μενού επιλέγουμε View και μετά Alternative 

Pros / Cons Pane. 

Στο  παράθυρο ModelView θα εμφανιστεί το Pros / Cons pane με τρία 

κουμπάκια. 

Κάτω από το κουμπί Pros βρίσκονται τα πλεονεκτήματα και κάτω από το κουμπί 

Cons βρίσκονται τα μειονεκτήματα για την πρώτη εναλλακτική ή αντίστοιχα για αυτή 

που έχουμε επιλέξει. 

Πρέπει να σημειωθεί ότι η υπογραμμισμένη εναλλακτική φαίνεται και ως τίτλος 

πάνω στο παράθυρο των Πλεονεκτημάτων και Μειονεκτημάτων (Pros / Cons). 

Για κάθε εναλλακτική τώρα θα πρέπει να εισάγουμε τα θετικά και τα αρνητικά. 

Μπορούμε να ξεκινήσουμε με την πρώτη ή αν θέλουμε να ξεκινήσουμε με άλλη 

εναλλακτική απλά την κλικάρουμε και ξεκινάμε με αυτή. 

- Αν έχουμε επιλέξει το Clydesdale, κάνουμε κλικ πάνω στο Add Pro. Θα 

ανοίξει ένα κουτί διαλόγου, το όνομα του οποίου θα είναι Add Pro For 

Clydesdale. 

- Γράφουμε High Engine Performance και πατάμε οκ. Σε περίπτωση που 

είναι απαραίτητο σέρνουμε με το ποντίκι τα θετικά κάτω από το Add Pro για 

να μπορούμε να τα ξεχωρίσουμε. Το ίδιο ισχύει και για τα Con. 

 

 

 

Με τον ίδιο τρόπο, πάμε τώρα να καταχωρήσουμε ένα αρνητικό (Con) στοιχείο 

για Clydesdale.  

• Επιλέγουμε το button Add Con. Όταν εμφανιστεί το παράθυρο διαλόγου, 

γράφουμε “Very Expensive” και πατάμε οκ. Να σημειώσουμε ότι τα αρνητιά 

είναι με ροζ χρώμα, ενώ τα θετικά με μπλέ.  

ΣΥΜΒΟΥΛΗ: Για να επιτρέπεται η μελλοντική εισαγωγή θετικών και αρνητικών στοιχείων 
στο παράθυρο, κάνουμε κλικ με το ποντίκι εκεί όπου θα θέλαμε να μας εμφανίζει τα Pros και 
τα Cons, πριν να επιλέξουμε το κατάλληλο button. 
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• Προσθέτουμε ακόμα ένα αρνητικό με την ίδια ακριβώς διαδικασία. Το “Not 

Very Safe” . 

Ακολουθώντας την ίδια διαδικασία βάζουμε στα θετικά κριτήρια τα “stylish”, “crash 

test store” και “fast”. 

Τώρα, συνεχίζουμε προσθέτωντας ένα θετικό και ένα αρνητικό για τις άλλες δύο 

εναλλακτικές που μας απέμειναν: 

Arabian: 

Pro: Affordable 

Con: Slow Acceleration 

Palomino: 

Pro: Fuel Economy 

Con: Terrible Braking 

Για να αποθηκεύσουμε το μοντέλο μας, πριν δούμε όλη την λίστα με τα θετικά και τα 

αρνητικά, πατάμε από το Μενού:  Αρχείο και Αποθήκευση (Menu ->File ->Save) 

Μπορούμε να μετατρέψουμε τα θετικά και τα αρνητικά σε αντικειμενικές πατώντας το 

button  “All Pros/Cons πάνω από το παράθυρο με τα καταχωρημένα στοιχεία. 

 

ΧΤΙΖΟΝΤΑΣ ΤΗΝ ΙΕΡΑΡΧΙΑ 

Τώρα θα αρχίσουμε να φτιάχνουμε την ιεραρχία των θετικών και των 

αρνητικών στοιχείων, του κατά πόσο δηλαδή επηρεάζουν τον στόχο μας, σύρωντας 

τα πάνω στο Treeview. Σε περίπτωση που δεν υπήρχε ούτως ή άλλως σειρά 

προτεραιότητας ξεκινάμε από οποιοδήποτε στοιχείο της λίστας. 

Ας ξεκινήσουμε με το αρνητικό “Very Expensive” που σχετίζεται με το 

“Clydesdale” 

• Κλικάρουμε το “Very Expensive” 

• Το σύρουμε κάτω από τον στόχο στο Treeview. 
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• Επαναπροσδιορίζουμε το αρνητικό σε αντικειμενικό στόχο, γράφοντας “Low 

Cost” και πατάμε οκ. 

Η παραπάνω διαδικασία τοποθετεί τον αντικειμενικό στόχο «low cost» κάτω 

από τον στόχο στο Tree view. Τώρα είναι δυνατό να δούμε την αρχή της φόρμας της 

ιεραρχίας μας. 

Παρατηρούμε πως το αρνητικό κριτήριο “Very Expensive” είναι τώρα 

σκιασμένο. Αυτό υποδεικνύει ότι μεταλλάχθηκε σε αντικειμενικό στόχο. 

 

Συμβουλή: Αφού οι εναλλακτικές εκτιμήθηκαν με βάση την προτίμηση των 

αντικειμενικών στόχων, οι έννοιες των αρνητικών κριτηρίων πρέπει σχεδόν πάντα να 

αλλάζουν, ώστε να καθορίζουν τον αντικειμενικό στόχο στον οποίο στοχεύουν. Για 

παράδειγμα το “Expensive” στοχεύει στο “low cost” ως αντικειμενικός στόχος. 

Κοιτάζοντας την λίστα μπορεί να δούμε πολλά θετικά και αρνητικά να 

επαναλαμβάνονται εξαιτίας της συσχέτισης τους με πολλές εναλλακτικές. Σε αυτήν 

την περίπτωση δεν είναι απαραίτητο να γίνουν αλλαγές. 

 

 

 

 

 

ΜΕΤΑΤΡΟΠΗ ΤΩΝ ΥΠΟΛΟΙΠΩΝ ΠΛΕΟΝΕΚΤΗΜΑΤΩΝ – 
ΜΕΙΟΝΕΚΤΗΜΑΤΩΝ ΣΕ ΑΝΤΙΚΕΙΜΕΝΙΚΟ ΣΤΟΧΟ 

Το Expert Choice είναι ένα ευέλικτο πρόγραμμα στήριξης αποφάσεων 

σχεδιασμένο να δουλεύει με τον τρόπο που σκεφτόμαστε.  

• Αρχικά σύρουμε τα σχετικά στοιχεία στο Treeview και τα επανακαθορίζουμε 

• Με το button Clusterview τα ομαδοποιούμε. 

• Προσθέτουμε ακόμα λίγους αντικειμενικούς στόχους. 

ΧΡΗΣΙΜΗ ΠΛΗΡΟΦΟΡΙΑ: Από την άλλη μεριά, ένα μόνο μειονέκτημα ή πλεονέκτημα 

μπορεί να καθορίζεται από πολλούς αντικειμενικούς στόχους και μπορεί να χρησιμοποιηθεί 

πολλές φορές. Για παράδειγμα, το πλεονέκτημα “size” για ένα μεγάλο αυτοκίνητο, θα 

μπορούσε να σημειωθεί σε πολλούς αντικειμενικούς στόχους, όπως στο “comfort”, “carrying 

capacity”, “safety”, “fuel economy”, “ease of parking”. 
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• Επιστρέφουμε στο Treeview για να αντιστρέψουμε την παρουσίαση των 

στοιχείων. 

Ένας ακόμα τρόπος για να προσθέσουμε Αντικειμενικούς στόχους κατευθείαν 

στο Treeview είναι και από το Menu -> Edit -> Insert either Child or Sibling. 

Αφού τελειώσουμε με αυτή την διαδικασία της ιεραρχίας επιλέγουμε το 

Alts/Children/InfoDocs και αυτά που κάναμε θα αντικατασταθούν. 

Πριν ολοκληρωθεί αυτό το κεφάλαιο, πρέπει να περιγράψουμε τρία ακόμα 

χαρακτηριστικά:  

1. Αρχεία Πληροφοριών (Information Documents) 

2. Σημειώσεις (Notes)  

3. Προσθήκη και Σύνδεση Στόχων (Object Linking and Embedding) 

Θα ξεκινήσουμε με τα αρχεία πληροφοριών, τα οποία τυπικά περιλαμβάνουν 

«κείμενο», το οποίο προστίθεται από το άτομο που χρησιμοποιεί το πρόγραμμα, ή 

μέσω ενός διευκολυντή. 

Αυτός μπορεί να περιγράψει τον στόχο, να δώσει περισσότερες πληροφορίες για τον 

λόγο που επιλέχθηκαν οι συγκεκριμένοι αντικειμενικοί στόχοι και να μας πει πως 

φτιάχνονται οι ταξινομημένες κατά ζεύγη συγκρίσεις. Αυτά τα αρχεία μπορούν να 

περικλείουν αρχεία όπωςWord, Excel, Powerpoint,Access, καθώς επίσης και 

φωτογραφίες και video. 

Τα αρχεία πληροφοριών μπορούν να δημιουργηθούν για κάθε αντικειμενικό 

στόχο, για κάθε εναλλακτική και για κάθε σύγκριση της ιεραρχίας. 

Για να γράψουμε μέσα στο Αρχείο Πληροφοριών: 

• Κάνουμε κλικ στο κουμπί Information μέσα από τον στόχο και έτσι εμφανίζεται 

ένα κενό αρχείο. 

• Γράφουμε το όνομά μας. 

• Και για να το κλείσουμε πατάμε πάλι το κουμπί Information. 

Αν υπάρχει ήδη αρχείο πληροφοριών για το συγκεκριμένο στοιχείο, τότε το 

κουμπί Information θα φαίνεται σαν ένα ανοιχτό βιβλίο, ενώ σε αντίθετη περίπτωση 

φαίνεται σαν βιβλίο, αλλά κλειστό. 
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Όταν το αρχείο πληροφοριών είναι ανοιχτό, μπορούμε να σύρουμε άλλα αρχεία μέσα 

σε αυτό και/ή να δημιουργήσουμε συντομεύσεις σε άλλα αρχεία ή προγράμματα. Τα 

αρχεία πληροφοριών μπορούν επίσης να δημιουργηθούν και να έχουμε πρόσβαση 

και από άλλα παράθυρα. 

Οι σημειώσεις (Notes) , μπορούν να προστεθούν σαν στοιχεία στην ιεραρχία, 

στις εναλλακτικές και στα κελιά του data grid. Ο κάθε συμμετέχοντας μπορεί να 

εισάγει τις δικές του σημειώσεις για να εκφράσει τις απόψεις του, τις δικές του λογικές 

εξηγήσεις, ανησυχίες και τις προτιμήσεις με τα διαφορετικά κομμάτια της διαδικασίας 

αποφάσεων. 

• Για να δημιουργήσουμε μια σημείωση κλικάρουμε στο κουμπί Note. 

Εισάγουμε τα σχόλια και πατάμε πάλι το κουμπί Note για να το κλείσουμε, 

όταν τελειώσουμε. 

Αν υπάρχει ήδη σημείωση για το συγκεκριμένο στοιχείο που βρισκόμαστε το 

κουμπί Note φαίνεται κίτρινο, αντί για τελείως μαύρο που είναι όταν δεν υπάρχει 

καμία σημείωση. Όταν το παράθυρο σημειώσεων είναι ανοιχτό, μπορούμε να 

σύρουμε άλλα αρχεία μέσα σε αυτό και να δημιουργήσουμε συντομεύσεις σε άλλα 

αρχεία ή προγράμματα. Όπως τα αρχεία πληροφοριών, έτσι και οι σημειώσεις είναι 

διαθέσιμες και από άλλα παράθυρα. 

Με την προσθήκη και σύνδεση στοιχείων (object linking and embedding) 

μπορούμε να εισάγουμε συντομεύσεις (συνδέσεις) ή επιπρόσθετα αρχεία σε 

οποιοδήποτε Αρχείο Πληροφοριών του Expert Choice. Αυτό το χαρακτηριστικό μας 

επιτρέπει να αρχειοθετούμε τις λογικές εξηγήσεις κάθε μας απόφασης, καθώς 

λειτουργούμε το πρόγραμμα. 

Η διαδικασία Σύνδεσης ή Προσθήκης στοιχείων εξαρτάται από τις δυνατότητες 

του λειτουργικού συστήματος. Με συγκεκριμένο λειτουργικό σύστημα μπορούμε μόνο 

να προσθέτουμε στοιχεία. 

 

Αυτά που προτείνονται είναι τα εξής: 

1. Με ανοιχτό το αρχείο πληροφοριών ή τις σημειώσεις με τοποθετημένο τον 

κέρσορα στο σημείο εισαγωγής των αρχείων πληροφοριών ή σημειώσεων. 
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2. Με Windows Explorer 

a) Για Windows 2000 και άλλες εκδόσεις: 

Σύρουμε ένα μεγάλο αρχείο κειμένου, όπως ένα .xls, .ppt, ή .doc από τον 

Windows Explorer μέσα στο ανοιχτό παράθυρο αρχείου πληροφοριών ή 

σημειώσεων. Τότε θα δημιουργηθεί μια συντόμευση και θα δημιουργηθεί ένα 

αρχείο. Αυτό εξοικονομεί χώρο, αλλά το αρχείο δεν θα είναι διαθέσιμο – 

προσβάσιμο από άλλον υπολογιστή αν το .ahp είναι αντιγραμμένο. 

Αν θέλουμε να προσθέσουμε το αρχείο, επιλέγουμε File – Open από το Μενού, 

Αρχείο Πληροφοριών ή από τις Σημειώσεις. 

b) Για τα Windows 98 και προηγούμενες εκδόσεις: 

Σύρουμε το αρχείο μέσα στο αρχείο πληροφοριών ή τις σημειώσεις. Τότε θα 

προστεθεί το αρχείο. Διαφορετικά επιλέγουμε από το Μενού, Αρχείο 

Πληροφοριών ή Σημειώσεων File – Open. Μετά πλοηγούμε στο αρχείο που 

θέλουμε να προστεθεί και το επιλέγουμε. Μόνο τα Windows 98 υποστηρίζουν 

την προσθήκη αρχείων 

3. Και τέλος, κλείνουμε το αρχείο Πληροφοριών ή τις σημειώσεις. 

Μπορούμε να προσθέσουμε πολλά και διαφορετικά αρχεία, αναμιγνύοντας τα με 

κείμενα αν το επιθυμούμε. 

Μπορούμε με πολλούς τρόπους να δούμε και να δουλέψουμε πάνω στα 

συνδεδεμένα και τα προστιθέμενα αρχεία. 

  

3.10 ΤΟ DATA GRID ΚΑΙ ΟΙ ΕΚΤΙΜΗΣΕΙΣ 

Το Data Grid περιέχει δεδομένα σχετικά με τις εναλλακτικές αποφάσεων. Οι 

εναλλακτικές εμφανίζονται στην σειρά του Data Grid ενώ οι αντικειμενικοί στόχοι στην 

επικεφαλίδα της στήλης, όπως φαίνεται στην εικόνα 1. 

Υπάρχουν πέντε διαφορετικά είδη που μπορούν να χρησιμοποιηθούν σαν 

Data Grid.  Σε αυτό το κομμάτι, θα συζητήσουμε για ένα από αυτά που ονομάζεται 

Ratings. 
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Οι εναλλακτικές που προστίθενται στο μοντέλο από το παράθυρο 

εναλλακτικών στο Modelview, είναι γνωστές ως ενεργές εναλλακτικές και 

καταχωρούνται αυτόματα στο Data Grid. Οι εναλλακτικές μπορούν να προστεθούν 

κατευθείαν στο Data Grid. 

Οι ενεργές εναλλακτικές είναι μαρκαρισμένες, όπως ακριβώς φαίνεται και στο 

παρακάτω σχήμα. Μπορούμε να μαρκάρουμε και να ξε – μαρκάρουμε εναλλακτικές, 

να τις αποβάλλουμε για να εξευγενίσουμε / προετοιμάσουμε και ανάλυση 

ευαισθησίας. 

 

Στην παραπάνω εικόνα βλέπουμε την κάθε εναλλακτική, να φαίνεται σε κάθε 

σειρά του Data Grid, κάθε στόχος να φαίνεται στις στήλες ως επικεφαλίδα και από 

κάτω να φαίνονται οι κλίμακες που αξιολογούμε κάθε αντικειμενικό στόχο. 

Το Data Grid έχει επίσης δύο στήλες “Total” και “Cost” που μπορεί να είναι 

ορατές ή κρυφές με την εντολή από το Menu, View. 

Ητιμή στην στήλη του συνόλου της κάθε εναλλακτικής περιλαμβάνει το 

άρθροισμα των τιμών της εναλλακτικής σύμφωνα με όλους τους στόχους σε όλες τις 

στήλες. 
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Κάθε κελί στο Data Grid περιέχει μια μπάρα που αντιπροσωπεύει την αξία 

κάθε εναλλακτικής (στοιχείο σειράς) σύμφωνα με τον αντικειμενικό στόχο (στοιχείο 

στήλης). Μπορούμε να δούμε και τα δεδομένα και τις αξίες. 

Τα στοιχεία του Data Grid χωρίζονται από τα στοιχεία που βασίζονται σε έναν από 

τους 5 τύπους: 

1. Ratings (Εκτιμήσεις) 

2. Increasing Utility curve (Αύξηση Καμπύλης Χρησιμότητας) 

3. Decreasing Utility curve (Μείωση Καμπύλης Χρησιμότητας) 

4. Step function (Σταδιακή Λειτουργία) και, 

5. Direct data entry (Καταχώρηση δεδομένων) 

 

ΓΙΑΤΙ ΧΡΗΣΙΜΟΠΟΙΟΥΜΕ ΤΟ DATA GRID 

Κάποιες αποφάσεις μπορεί να περικλείουν έναν μεγάλο αριθμό εναλλακτικών. 

Αυτό μπορεί να αποδειχθεί χρονοβόρο καθώς θα έπρεπε να προετοιμάσουμε αρκετά 

μεγάλο αριθμό συγκρίσεων για τις εναλλακτικές μας. 

Αντί, λοιπόν, να καθόμαστε να κάνουμε όλες αυτές τις συγκρίσεις, μας βοηθάει πάρα 

πολύ το Data Grid.  

Το Data Grid συνδυάζει την δύναμη της ιεραρχίας και την διαδικασία της κατά 

ζεύγη σύγκρισης  με την ικανότητα να εκτιμάει εκατοντάδες, ακόμα και χιλιάδες 

εναλλακτικές. 

Η κατά ζεύγη σύγκριση χρησιμοποιείται για να εκτιμήσει ένα στοιχείο της 

ιεραρχίας, αλλά δεν μπορεί να εκτιμήσει την εναλλακτική. Οι προτεραιότητες των 

εναλλακτικών καθορίζονται σύμφωνα με τον στόχο χρησιμοποιώντας τις εκτιμήσεις ή 

κάποιο άλλο τύπο που μπορεί να χρησιμοποιηθεί. 

 

ΠΟΤΕ ΧΡΗΣΙΜΟΠΟΙΟΥΜΕ ΤΙΣ ΕΚΤΙΜΗΣΕΙΣ 

Οι άνθρωποι συχνά εκτιμούν τις εναλλακτικές χρησιμοποιώντας λέξεις όπως 

«Υψηλό», «Μέτριο», «Χαμηλό» ή με τις λέξεις «Υπέροχο», «πολύ καλό», «Καλό», 



62 
 

«Δίκαιο», «Φτωχό» κλπ. Αυτό συνήθως συμβαίνει στην περίπτωση που έχουμε να 

κάνουμε με υποκειμενικές απόψεις ή όταν δεν υπάρχουν γενικώς επαρκή στοιχεία 

για να μας οδηγήσουν κάπου.  

Πρώτα από όλα θα δούμε πως θα χωρίζουμε τις κλίμακες, οι οποίες είναι ήδη 

προκαθορισμένες μέσα σε ένα παραδειγματικό μοντέλο και θα δούμε πώς να 

προσδιορίζουμε και να βάζουμε προτεραιότητες στις δικές μας κλίμακες. 

Επίσης θα δούμε πως: 

• Αντιγράφουμε μια φόρμουλα, 

• Διαγράφουμε μια ήδη υπάρχουσα φόρμουλα, 

• Επανερχόμαστε σε μια αρχική έκδοση του μοντέλου για να αναιρέσουμε την 

διαγραφή μιας φόρμουλας, 

• Δημιουργούμε μια καινούργια φόρμουλα, 

• Τροποποιούμε μια υπάρχουσα φόρμουλα. 

 

Θα ξεκινήσουμε χρησιμοποιώντας το μοντέλο Ice Cream Site.ahp  

Η εικόνα παρακάτω μας δείχνει ένα μοντέλο. 

• Ξεκινάμε το Expert Choice όπως ακριβώς γνωρίζουμε. 

• Επιλέγουμε File -> Open. Πλοηγούμε στον φάκελο με τα παραδείγματα- 

μοντέλα του Expert Choice και επιλέγουμε το μοντέλο Ice Cream Site. ahp 

από την λίστα, το οποίο φαίνεται και στην εικόνα μας. 

 

 

 

ΣΗΜΕΙΩΣΗ: Το .ahp είναι προέκταση των αρχείων του Expert Choice. 
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Αφού θα εξηγούμε πώς να χρησιμοποιούμε τις εκτιμήσεις αλλάζοντας το μοντέλο 

μας, ας κάνουμε ένα αντίγραφο του μοντέλου μας πρώτα. 

• Επιλέγουμε File -> Save as και όταν εμφανιστεί το παράθυρο διαλόγου: 

1. Κάνουμε κλικ στο Up One Level Button για τον φάκελο του Expert 

Choice. 

2. Κάνουμε κλικ στο Create New Folder Button και βάζουμε ένα όνομα 

στο φάκελο, όπως πχ «Models». 

3. Πληκτρολογούμε «My IceCreamSite» και κάνουμε αποθήκευση. 

Το αυθεντικό μοντέλο μας θα κλείσει και το καινούργιο μοντέλο μας θα 

εμφανιστεί. Το όνομα αρχείου του καινούργιου μας μοντέλου φαίνεται στην μπάρα. 

Η εικόνα λοιπόν δείχνει το αντιγραμμένο μοντέλο με 4 αντικειμενικές, οι οποίες 

έχουν μπει με σειρά προτεραιότητας σύμφωνα με την σύγκριση ανά ζεύγη. Εδώ 

πρέπει να σημειωθεί ότι δεν έχουμε εναλλακτικές μέσα στο παράθυρο των 

εναλλακτικών μας. 

 

ΕΠΑΝΑΚΑΘΟΡΙΣΜΟΣ ΚΑΙ ΚΙΝΗΣΗ ΣΤΟ DATA GRID 

• Από το Modelview επιλέγουμε Go. Μετά επιλέγουμε Data Grid (όπως φαίνεται 

στο σχήμα που ακολουθεί). Αυτό το μοντέλο περιέχει πολλές παγκόσμιες 

εναλλακτικές και καμία ενεργή εναλλακτική. 
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Μπορούμε να χρησιμοποιήσουμε το κλειδί παραθύρου ώστε να επανακαθορίσουμε 

δεδομένα. 

 

Αν παρατηρήσουμε στην παραπάνω εικόνα, στο παράθυρο Treeview στα 

δεξιά, αν κλικάρουμε πάνω σε μια αντικειμενική της ιεραρχίας, θα μετακινηθούμε 

στην αντίστοιχη στήλη του Data Grid. 

Μπορούμε να χρησιμοποιήσουμε το κουμπί με το βέλος ή με το ποντίκι. 

 

 

 

 

Αν παρατηρήσουμε ένα βέλος προς τα κάτω ή προς τα δεξιά στο Data Grid 

σημαίνει ότι η επιλογή Autoadvance είναι ενεργή. Το βέλος υποδεικνύει την 

ΧΡΗΣΙΜΗ ΠΛΗΡΟΦΟΡΙΑ: Κλικάρωντας πάνω στο κουμπί Data Grid από το 

Modelview θα μας πάει στο Data Grid. Ή χρησιμοποιώντας την συντόμευση του 

Data Grid που φαίνεται στο Menu -> Go. 

ΣΗΜΕΙΩΣΗ: Αν το Treeview μας δεν είναι ορατό επιλέγουμε το View από το 

Menu και μετά επιλέγουμε να είναι ορατό το παράθυρο του Treeview. 
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κατεύθυνση του Autoadvance. Κάνοντας κλικ πάνω σε αυτό το κουμπί μπορούμε να 

αλλάξουμε την κατεύθυνση. 

 

ΣΤΗΛΕΣ ΤΩΝ ΣΥΝΟΛΩΝ 

• Για να μπορέσουμε να κάνουμε ορατές τις στήλες των συνόλων, επιλέγουμε 

View -> Totals column. 

Όπως αναφέραμε και νωρίτερα, η τιμή σε κάθε στήλη για κάθε εναλλακτική 

περιέχει το άθροισμα όλων των τιμών – αξιών της εναλλακτικής καλύπτοντας όλες τις 

αντικειμενικές στήλες. (Αν ένα στοιχείο στην ιεραρχία της απόφασης, δεν έχει ακόμα 

αρχειοθετηθεί, το βάρος και κατ’ επέκταση τα σύνολα θα είναι μηδενικά.)  

Στην παρακάτω εικόνα βλέπουμε ως ένα παράδειγμα προτεραιότητας το Main 

Street High Rise είναι .527, ενώ το Business District είναι .217. Από αυτό μπορούμε 

να συμπεράνουμε ότι το Main Street High Rise είναι περισσότερο από διπλά 

προτιμητέο από το Business District. 

 

Για να δούμε ένα παράδειγμα με μεγαλύτερο νόημα αποτελεσμάτων αυτού του 

μοντέλου κάνουμε: 

• Κλικ σε ένα οποιοδήποτε κελί πάνω στη στήλη των συνόλων. 
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• Επιλογή του Edit, Sort, Descending και οι προτεραιότητες των εναλλακτικών 

μας θα αρχειοθετηθούν από το ψηλότερο στο χαμηλότερο. 

 

ΠΡΟΣΘΗΚΗ ΕΝΑΛΛΑΚΤΙΚΗΣ ΣΤΟ DATA GRID 

Γι αυτό το μέρος του μαθήματος θα προσθέσουμε μια ακόμη εναλλακτική στο Data 

Grid.  

• Κάνουμε κλικ στο πρώτο ελεύθερο κελί στη στήλη Alternative (εναλλακτική) 

• Πληκτρολογούμε MyStore σαν μια λέξη, έπειτα κάνουμε κλικ στο παρακάτω 

κελί ή μετακινούμαστε προς τα κάτω με το αντίστοιχο κάτω βέλος του 

πληκτρολογίου. 

 

ΚΑΤΑΧΩΡΗΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ (για εξάσκηση): 

• Μετακινούμαστε στο κελί MyStore, και πατάμε F2 το καθιερωμένο πλήκτρο 

επεξεργασίας των Windows. 

• Μετακινούμε τον δρομέα οθόνης στο “S”. Έπειτα πατάμε το πλήκτρο 

διαστήματος μια φορά ώστε η εναλλακτική μας να έχει πληκτρολογηθεί ως 

“My Store” (δύο λέξεις) και έπειτα κάνουμε κλικ στο παρακάτω κελί ή 

πιέζουμε Enter. 

 

ΕΙΣΑΓΩΓΗ ΕΚΤΙΜΗΣΕΩΝ 

Υπάρχουν αρκετοί διαφορετικοί τρόποι εισαγωγής των εκτιμήσεων (Ratings),  

είτε με την χρήση του ποντικιού, είτε με του πληκτρολογίου. 

Με το Ποντίκι: 

• Μετακινούμαστε στο κελί Data Grid  την γραμμή My Store και στην στήλη 

Visibility. 

• Παρατηρούμε πως η διαβάθμιση των εκτιμήσεων εμφανίζεται πάνω από τις 

εναλλακτικές στο Data Grid όταν μετακινούμαστε σε ένα κελί στην στήλη 

Visibility 
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• Εφόσον πρόκειται να εισάγουμε εκτιμήσεις για κάθε κελί σε αυτή την σειρά,  

βεβαιωνόμαστε ότι το βέλος Autoadvance στην μπάρα  πλήκτρων, δείχνει 

προς τα δεξιά και όχι προς τα κάτω. Εάν δείχνει προς τα κάτω, τότε κάνουμε 

κλικ σε αυτό μια φορά. 

 

 

 

 

• Κάνουμε κλικ στο ΟΚ (το δεύτερο στοιχείο στην διαβάθμιση των εκτιμήσεων) 

και η εκτίμηση αυτή θα εισαχθεί για το My Store αναφορικά με το Visibility. 

Προσέχουμε ότι η λέξη “OK “ εμφανίζεται στο κελί. Η μπάρα στο κελί υποδηλώνει 

την τιμή προτεραιότητας που σχετίζεται με το “OK”. 

 

 

 

 

 

• Για τον διαγωνισμό καλυπτόμενων στόχων, επιλέγουμε Intense. 

• Ας υποθέσουμε ότι αλλάζουμε γνώμη και σκεφτόμαστε ότι ο ανταγωνισμός 

είναι κάπου μεταξύ μέτριο (moderate) και έντονο (intense), ας πούμε 

περίπου .33. Με το αριστερό πλήκτρο στο ποντίκι πατημένο στο κελί της 

στήλης Competition, βάζουμε την μπάρα στο κελί στην τιμή .33, 

δημιουργώντας πρακτικά μια τιμή μεταξύ moderate και intense. 

Με το Πληκτρολόγιο: 

Για τον στόχο “Customer Fit”, δοκιμάζουμε τους τέσσερεις παρακάτω τρόπους για 

την εισαγωγή εκτιμήσεων στο κελί: 

ΧΡΗΣΙΜΗ ΠΛΗΡΟΦΟΡΙΑ: Η επιλογή Autoadvance στο επόμενο κελί είναι 

ενεργοποιημένη εξ’ ορισμού. Εάν δεν βλέπουμε ένα βέλος να δείχνει κάτω ή 

δεξιά στην μπάρα πλήκτρων, ενεργοποιούμε το Autoadvance, επιλέγοντας 

Tools, Options, Calculation και έπειτα Autoadvance. 

ΧΡΗΣΙΜΗ ΠΛΗΡΟΦΟΡΙΑ: Ενόσω στο Data Grid, κάνοντας κλικ σε ένα objective 

(επιδίωξη) στο TreeView επιλέγει αυτή την στήλη στο Data Grid. Εάν υπάρχουν sub-

objectives σχετικά με αυτό το objective, θα μεταφερθούμε στο πρώτο sub-objective. 

Για να μεταφερθούμε σε ένα sub-objective θα πρέπει να κάνουμε κλικ σε αυτό, στην 

ιεραρχία (hierarchy). 
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• Για το “Customer Fit” πατάμε το πλήκτρο 1, τον αριθμό που αντιπροσωπεύει 

το πρώτο rating intensity (ένταση αξιολόγησης), “Lots”, ή 

• Πληκτρολογούμε μια τιμή μεταξύ 0 και 1, όπως για παράδειγμα .345 (εάν το 

κάνουμε αυτό η εγγραφή  θα είναι μεταξύ few (.303) και some (.550), ή  

• Πληκτρολογούμε 0 για μια μηδενική εκτίμηση, ή 

• Αφαιρούμε μια εκτίμηση πληκτρολογώντας Delete 

• Μετακινούμαστε στο κόστος και πληκτρολογούμε 2,  τον αριθμό που 

αντιστοιχεί σε ένα ποσοστό εκτιμήσεων. Πληκτρολογώντας με την χρήση 

του πληκτρολογίου είναι συνήθως ο γρηγορότερος τρόπος για την εισαγωγή 

εκτιμήσεων στο Data Grid. 

Τώρα που έχουμε μάθει πώς να εισάγουμε εκτιμήσεις, θα δούμε πώς να 

αντιγράφουμε μια formula – έναν μαθηματικό τύπο δηλαδή από έναν στόχο σε έναν 

άλλο. 

 

ΑΝΤΙΓΡΑΦΟΝΤΑΣ ΕΙΔΗ ΜΑΘΗΜΑΤΙΚΩΝ ΤΥΠΩΝ (Formula Types) 

Για να εξασκηθούμε στην αντιγραφή μιας formula όπως για παράδειγμα μια 

διαβάθμιση εκτιμήσεων από έναν στόχο σε έναν άλλο, εκτελούμε τα επόμενα 

βήματα: 

• Κάνουμε κλικ στην ετικέτα (tab)  Formula Grid Y=F(x). Ο Πίνακας 5. δείχνει 

ένα μερικό Formula grid. 

• Κάνουμε κλικ στο κελί στην στήλη Type της γραμμής Competitors. 

• Επιλέγουμε Edit, Copy, Formula 

• Κάνουμε κλικ στην γραμμή Customer Fit 

• Επιλέγουμε Edit, Paste Formula. Συγκρίνουμε τα αποτελέσματα μας με τον 

Πίνακα 5. Δείχνει το Data Grid πριν από την αντιγραφή μιας formula στο 

Customer Fit. 

• Κάνουμε κλικ στην ετικέτα Data Grid και πηγαίνουμε στο Customer Fit. Η 

στήλη αυτή θα περιέχει την αντιγραμμένη φόρμουλα και τα δεδομένα. 
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Τώρα, αν το επιθυμούμε, μπορούμε να δημιουργήσουμε καταχωρήσεις για τις 

εναλλακτικές σχετικά με την αντιγραμμένη διαβάθμιση των εκτιμήσεων (Ratings 

Scale), του Customer Fit. Πρέπει να θυμόμαστε να αλλάξουμε το δεξί βέλος 

Autoadvance έτσι ώστε να δείχνει προς τα κάτω, για να διευκολυνθεί η εισαγωγή των 

εκτιμήσεων στην στήλη αυτή και να εισάγουμε τις εκτιμήσεις μας όπως μάθαμε σε 

προηγούμενη αναφορά. 

Στην συνέχεια θα δούμε πως μπορείτε να διαγράψετε ένα formula type. 

 

ΔΙΑΓΡΑΦΟΝΤΑΣ ΕΝΑΝ ΜΑΘΗΜΑΤΙΚΟ ΤΥΠΟ (Formula Type) 

• Από το data Grid, πηγαίνουμε στην στήλη Customer Fit,  κάνουμε δεξί κλικ 

στο ποντίκι στην λέξη Ratings. 

• Από το αναδυόμενο μενού (pop-up menu) που δείχνει όλους τους τύπους 

επιλέγουμε None  

• Επιλέγουμε ΟΚ για την επιβεβαίωση της διαγραφής. 

 

ΕΝΤΟΛΗ ΕΠΑΝΑΦΟΡΑΣ 

Η εντολή επαναφοράς (revert command) μπορεί να χρησιμοποιηθεί ώστε να 

επανέλθουμε σε μια προηγούμενη έκδοση του μοντέλου σας. Για παράδειγμα, εάν 
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αποφασίσουμε να εγκαταλείψουμε ότι μόλις κάναμε, θα πρέπει να εκτελέσουμε τα 

παρακάτω βήματα: 

• Από το Data Grid, επιλέγουμε Edit, έπειτα Revert ή εναλλακτικά κάνουμε κλικ 

στο πλήκτρο revert 

• Όταν εντοπιστεί το revert από το παράθυρο, κάνουμε διπλό κλικ στην 

επιθυμητή εγγραφή. 

• Στο παράδειγμα μας, κάνουμε κλικ στο Original, και το μοντέλο μας θα 

αποκατασταθεί όπως είχε εισαχθεί αρχικά  

• Κάνουμε κλικ στο Revert ξανά. Δοκιμάζουμε μια άλλη επιλογή. 

 

 

 

 

 

ΔΗΜΙΟΥΡΓΙΑ ΔΙΑΒΑΘΜΙΣΗΣ ΕΚΤΙΜΗΣΕΩΝ 

• Από το Data Grid επιλέγουμε ένα κελί από την στήλη Customer Fit. 

• Από την μπάρα του Menu επιλέγουμε Formula Type, μετά επιλέγουμε None 

για να διαγράψουμε υπάρχουσα φόρμουλα. 

 

Σημείωση: Οι επιλογές “revert to” διαγράφονται όταν ένα μοντέλο είναι κλειστό. 
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• Όταν βγει το παράθυρο διαλόγου που μας ρωτάει αν θέλουμε να 

αντικαταστήσουμε υπάρχοντα δεδομένα πατάμε οκ. 

• Από την μπάρα του Menu επιλέγουμε Formula Type, μετά επιλέγουμε Ratings 

για να δημιουργήσουμε μια καινούργια κλίμακα. 

 

 

 

Ένα καινούργιο παράθυρο θα εμφανιστεί, όπου θα δημιουργήσουμε μια 

καινούργια κλίμακα εκτιμήσεων. 

Όταν τοποθετηθούμε με τον κέρσορα στο μαυρισμένο κελί στην αριστερή 

στήλη, μια λίστα από «Intensities», προσδιορισμένες οπουδήποτε στο μοντέλο μας 

θα εκτοπιστούν, έτσι θα μπορέσουμε, αν θέλουμε, να σύρουμε μια στην αριστερή 

στήλη από την πρώτη κενή γραμμή. 

Ουσιαστικά, θα έχουμε μόλις γράψει ένα «intensity Name». 

 

Τώρα θα ξανά δημιουργήσουμε μια διαβάθμιση εκτιμήσεων για το Customer Fit: 

• Κάνουμε κλικ στην στήλη Intensity Name στο πρώτο κενό κελί. Μετά κάνουμε 

κλικ κάπου πάνω στη λίστα από τα δεξιά. 

ΧΡΗΣΙΜΗ ΣΥΜΒΟΥΛΗ: Αντί να χρησιμοποιούμε την μπάρα του Menu, 

μπορούμε να κάνουμε δεξί κλικ πάνω στο κελί και από το μενού που 

εμφανίζεται να επιλέξουμε Ratings 
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• Προχωράμε προς τα κάτω, στην επόμενη γραμμή και κάνουμε κλικ στο «little» 

από την λίστα που βρίσκεται δεξιά. 

• Προχωράμε πιο κάτω και πληκτρολογούμε «few». 

 

 

 

 

Υπάρχουν τρία Intensity σε αυτή τη διαβάθμιση, το κάθε ένα με μηδενική 

προτεραιότητα. Για μια πιο σίγουρη λύση, πρέπει όλες οι κλίμακες να έχουν 

τουλάχιστον 5 στοιχεία. Για συντομία εδώ χρησιμοποιούμε 3 στοιχεία. 

• Κάνουμε κλικ στο κουμπί «Assess»  

 

Θα πάρουμε έναν από τους τρεις τύπους σύγκρισης ζευγών (προφορικό, 

αριθμητικό, ή γραφικό). Αν θέλουμε, μπορούμε να αλλάξουμε τους τύπους, κάνοντας 

κλικ σε ένα από αυτά. 

 

ΔΙΑΓΩΝΙΕΣ ΣΥΓΚΡΙΣΕΙΣ ΖΕΥΓΩΝ (diagonal pairwise comparison) 

Εδώ θα χρησιμοποιήσουμε τον γραφικό τύπο για να κάνουμε τις συγκρίσεις 

και θα το κάνουμε αυτό μόνο για τα κελιά με τη μικρότερη διαγώνιο. Τα στοιχεία αυτά 

μας παρέχουν τα ελάχιστα νούμερα της σύγκρισης που είναι απαραίτητα για να 

υπολογίσουμε τις προτεραιότητες.  

(Όταν το κάνουμε αυτό δεν θα έχουμε ακριβή μέτρα και οι προτεραιότητες δεν θα 

είναι όσο ακριβής όσο αν συμπληρώναμε όλες τις κρίσεις, αλλά μας είναι πιο 

γρήγορο και τα αποτελέσματα είναι ωστόσο μαθηματικά σωστά). 

• Επιλέγουμε Tools, Options, Calculation 

Παρατηρούμε ότι υπάρχουν τρεις επιλογές Next, Randomize και Diagonal. 

ΧΡΗΣΙΜΗ ΠΛΗΡΟΦΟΡΙΑ: Για να αλλάξουμε ένα Intensity Name,κάνουμε κλικ 

πάνω σε αυτό και επανακαθορίζουμε το όνομα του ή πατάμε F2 για να εισάγουμε 

standard διαδικασίες. Για να το διαγράψουμε τελείως, μετακινούμαστε σε αυτό και 

πατάμε «Delete» 
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• Αν δεν είναι επιλεγμένο το Diagonal, το επιλέγουμε. 

• Κάνουμε κλικ στο Close. 

 

• Σύρουμε τις μπάρες ώστε σχεδόν να διπλασιάσουμε τις εισόδους. 

 

Να σημειωθεί ότι το κουμπί υπολογισμού έχει μετατραπεί από κόκκινο σε 

κίτρινο μετά από την δημιουργία δύο εισόδων. 

Όταν λοιπό αυτό το κουμπί είναι κίτρινο καταλαβαίνουμε ότι δεν έχουν γίνει 

όλες οι κρίσεις, αλλά έχουν γίνει αρκετές για να βγουν οι προτεραιότητες. 

 

Σε περίπτωση που θέλουμε να συνεχίσουμε και να περάσουμε όλα τα στοιχεία: 

• Κάνουμε κλικ πάνω στο Calculate. 

• Κάνουμε κλικ στο Priorities tab ή πατάμε Enter για να επιστρέψουμε στο 

παράθυρο προσδιορισμού της κλίμακας. 

• Κάνουμε κλικ στο Close για να επιστρέψουμε στο Data Grid. 
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Τώρα πρέπει να βρισκόμαστε στη στήλη Customer Fit. Οι κλίμακες που πρέπει να 

εμφανίζονται σε αυτή τη στήλη είναι το «Some», «Little», «Few». 

 

ΤΡΟΠΟΠΟΙΗΣΗ ΥΠΑΡΧΟΥΣΑΣ ΚΛΙΜΑΚΑΣ ΑΞΙΟΛΟΓΗΣΕΩΝ 

• Δεξί κλικ στη πάνω γραμμή της στήλης Competition και επιλέγουμε Ratings. 

Μετά μπορούμε επίσης να: 

1. κάνουμε κλικ στο Assess για να επανεξετάσουμε τα στοιχεία που 

περάσαμε νωρίτερα, χρησιμοποιώντας την διαδικασία σύγκρισης ανά ζεύγη. 

2. Ή αντί να πατήσουμε το κουμπί access μένουμε στο παράθυρο 

προσδιορισμού των αξιολογήσεων και κάνουμε αριστερό κλικ σύροντας κάθε 

προτεραιότητα από αριστερά στα δεξιά. 

Σε αυτόν τον πίνακα φαίνεται ότι αντιστρέψαμε τις προτεραιότητες ώστε να 

έχει την μεγαλύτερη τιμή το intense και να ακολουθούν το moderate και το little. 
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Αφού κάνουμε οποιαδήποτε τροποποίηση, κάνουμε κλικ στο Close  για να 

επιστρέψουμε στο Data Grid. Οι αξίες στα κελιά των στηλών που αλλάξαμε θα 

αναβαθμιστούν βασισμένες στις καινούργιες προτεραιότητες που καταχωρήσαμε. 

 

ΕΠΙΛΟΓΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΑΠΟ ΤΟ DATA GRID ΓΙΑ ΝΑ 
ΣΥΜΠΕΡΙΛΗΦΘΟΥΝ ΣΤΟ MODELVIEW 

Κάθε αριθμός εναλλακτικών μπορεί να χρησιμοποιηθεί ως «ενεργός» και να 

αφαιρεθεί από το Data Grid για να εμφανιστεί στο παράθυρο Εναλλακτικών στο 

Model View.  

Αυτό γίνεται για δύο λόγους. Πρώτον, για να προετοιμάσουμε ανάλυση 

ευαισθησίας και δεύτερον για να προσδιορίσουμε προτεραιότητες κάνοντας 

συγκρίσεις ανά ζεύγη, αντικαθιστώντας τις προτεραιότητες που προέρχονται από τις 

διαβαθμίσεις ή από τα δεδομένα. Μπορούμε να επιλέξουμε και να αποβάλλουμε 

όσες εναλλακτικές επιθυμούμε. Ωστόσο, αφού μόνο 9 εναλλακτικές μπορούν να 

χρησιμοποιηθούν στην ανάλυση ευαισθησίας, προτείνουμε να ενεργοποιήσουμε 9 ή 

λιγότερες. Μπορούμε μετά να φτιάξουμε ένα άλλο σετ των 9 εναλλακτικών ή 

λιγότερων. 
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Για να αποβάλλουμε τις εναλλακτικές:  

• Από το Data Grid, κάνουμε δεξί κλικ πάνω σε κάθε εναλλακτική που θέλουμε 

να αποβάλλουμε. 

• Από το μενού, επιλέγουμε Edit, μετά επιλέγουμε Extract Selected to 

Hierarchy. 

• Όταν ερωτηθούμε αν θέλουμε σίγουρα να διαγράψουμε ενεργή εναλλακτική, 

πατάμε ναι. Μετά θα μεταφερθούμε στο Modelview και θα δούμε την 

ιεραρχία και τις ενεργές εναλλακτικές. 

 

ΠΡΟΕΤΟΙΜΑΣΙΑ ΑΝΑΛΥΣΗΣ ΕΥΑΙΣΘΗΣΙΑΣ  

• Κάνουμε κλικ στο Goal Node. 

• Επιλέγουμε Sensitivity Graphs και διαλέγουμε ένα από τα 5 γραφήματα, όπως 

το Dynamic. 

 

ΑΝΤΛΗΣΗ ΠΡΟΤΕΡΑΙΟΤΗΤΩΝ ΑΠΟ ΤΙΣ ΑΠΟΒΕΒΛΗΜΕΝΕΣ ΜΕ ΤΗΝ 
ΣΥΓΚΡΙΣΗ ΑΝΑ ΖΕΥΓΗ 

• Από το Tree View κάνουμε κλικ σε έναν από τους στόχους στο Tree View. 

• Από το Μενού, επιλέγουμε Assessment, Pairwise. Κάνουμε κλικ στο Yes όταν 

μας ζητηθεί. 
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• Αλλάζουμε σε τύπο γραφικής σύγκρισης και προσαρμόζουμε οποιαδήποτε 

υπάρχουσα κρίση που εμφανίζεται. Μετά μπορούμε να προσθέσουμε 

κιόλας. 

 

 

• Επιλέγουμε Edit και μετά Revert. 

 

ΠΡΟΣΘΗΚΗ ΜΙΑΣ ΙΔΑΝΙΚΗΣ ΕΝΑΛΛΑΚΤΙΚΗΣ 

Μια ιδανική εναλλακτική θα πρέπει να λάβει την ψηλότερη πιθανή κλίμακα. 

Πρέπει όμως να είμαστε προσεκτικοί και να εξετάσουμε πόσο απέχει η πραγματική 

εναλλακτική από την ιδεατή. Η τελευταία μερικές φορές ονομάζεται «Gap Analysis». 

Τα κενά μπορούν να φανούν είτε από τις στήλες των συνόλων, είτε από την γραφική 

παρουσίαση ευαισθησίας. 

Για να εισάγουμε μια ιδεατή εναλλακτική: 

• Από το Μενού και επιλέγουμε Tools, Options και General. 

• Επιλέγουμε Include the ideal alternative in Data Grid (εισαγωγή της ιδεατής 

εναλλακτικής). 

Αν θέλουμε να δούμε τις ίδιες πληροφορίες γραφικά: 

• Επιλέγουμε την ιδανική μαζί με τις άλλες 8 εναλλακτικές κάνοντας δεξί κλικ. 

• Τις αποβάλλουμε επιλέγοντας Edit, Extract to Select Hierarchy. 

 

Σημείωση: Αν κάνουμε ξανά δεξί κλικ, πάνω σε μια από αυτές που έχουμε μαρκάρει, 

θα ξε- μαρκαριστεί. 

• Επιλέγουμε Sensitivity Graphs και μετά Performance. 

 

ΣΗΜΕΙΩΣΗ: Δύο εναλλακτικές μπορούν να πάρουν την ίδια κλίμακα παρόλο που 

αν το σκεφτούμε η μια θα πρέπει να είναι λιγότερο επιθυμητή από την άλλη 
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3.11 OΙ ΥΠΟΛΟΙΠΕΣ ΜΕΘΟΔΟΙ ΑΞΙΟΛΟΓΗΣΗΣ ΤΩΝ 
ΕΝΑΛΛΑΚΤΙΚΩΝ ΜΕΣΩ ΤΟΥ DATA GRID 

Στο προηγούμενο κεφάλαιο εξετάσαμε την μέθοδο Ratings που 

χρησιμοποιούμε στο Data Grid για να συγκρίνουμε πολλές εναλλακτικές. Σε αυτό το 

κεφάλαιο θα μάθουμε πώς να δουλεύουμε με τις υπόλοιπες 4 μεθόδους-φόρμες που 

μας παρέχει το Data Grid. 

Γενικά, ενώ είναι πιθανό σε ένα μοντέλο να κάνουμε συγκρίσεις ανά ζεύγη των 

εναλλακτικών και ταυτόχρονα να χρησιμοποιούμε μεθόδους- τύπους (Ratings, Step, 

Utility Curves) και να εξάγουμε εναλλακτικές από το Data Grid, είναι περισσότερο 

σύνηθες στην πράξη να κάνουμε είτε τις συγκρίσεις των εναλλακτικών, είτε να 

χρησιμοποιούμε το Data Grid. 

Άλλη μια κοινή πρακτική είναι να κάνουμε τις κρίσεις μας με το Data Grid και 

μετά να εξάγουμε τις ενεργές εναλλακτικές στην ιεραρχία και εκεί να τελειοποιούμε τις 

κρίσεις μας κάνοντας τις συγκρίσεις ζευγών. 

 

Οι μέθοδοι-φόρμες με τις οποίες θα ασχοληθούμε σε αυτό το κεφάλαιο είναι: 

1. Η Step Function (Μέθοδος Φάσης, βήματος) 

2. H Increasing Utility Curve (Αύξουσα Καμπύλη Χρησιμότητας) 

3. Η Decreasing Utility Curve (Φθίνουσα Καμπύλη Χρησιμότητας) 

4. Η Direct Formula (Άμεση μέθοδος- φόρμουλα)  

 

Η ΜΕΘΟΔΟΣ STEP 

Η μέθοδος αυτή, μοιάζει με την Ratings στο ότι και εδώ κατασκευάζουμε μία 

κλίμακα με επίπεδα διαβάθμισης (Intensity Scales) στα οποία έχουν τεθεί 

προτεραιότητες. Όμως, η λειτουργία Step υπολογίζει αυτόματα τo κατάλληλο επίπεδο 

για κάθε εναλλακτική βάσει των δεδομένων που έχουν εισαχθεί στο Data Grid. Δεν 

επιστρέφουμε δηλ. στο Data Grid για να αξιολογήσουμε κάθε εναλλακτική σε κάποιο 
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κριτήριο, παρά μεταβαίνουμε στο κριτήριο που θέλουμε και εισάγουμε απλώς, τις 

πραγματικές τιμές των δεδομένων.  

Επίσης, στην λειτουργία της  Step αν και είναι παρόμοια με αυτήν της Ratings, 

καθορίζουμε ένα μικρότερο όριο τιμών σε κάθε βήμα. Δηλ., όπως και στο Ratings, 

κατασκευάζουμε μία κλίμακα διαβάθμισης (intensity scale), στην οποία θέτουμε σε 

προτεραιότητα τα επίπεδα διαβάθμισης. Αν τα επίπεδα διαβάθμισης στην κλίμακα 

ήταν Low, Medium και High, μπορεί να θέλαμε το Low να αντιστοιχεί σε λιγότερο από 

50, το Medium μεταξύ 50 και 199 και το High σε 200 και πάνω. Τα όρια των 

δεδομένων με την Step καθορίζονται με χαμηλότερες τιμές. Π.χ. εδώ: 0 για το Low, 

50 για το Medium και 200 για το High. 

 

ΔΗΜΙΟΥΡΓΙΑ ΜΙΑΣ ΦΟΡΜΑΣ STEP ΑΠΟ ΜΙΑ ΦΟΡΜΑ RATINGS 

• Από τον κατάλογο Samples Μodels Directory, ανοίγουμε το αρχείο Ice-cream 

Site. Αυτό το μοντέλο χρησιμοποιήσαμε και στο κεφάλαιο που 

αναφερθήκαμε στα Ratings μοντέλα. Δημιουργούμε ένα αντίγραφό του για 

να το επεξεργαστούμε. 

• Aνοίγουμε το αρχείο- αντίγραφο και επιλέγουμε την καρτέλα Data Grid Tab. 

• Κλικάρουμε το κριτήριο Monthly Rental Cost Column. 

• Kάνουμε δεξί κλικ στη στήλη αυτή και από το μενού που εμφανίζεται, 

επιλέγουμε Step. 

• Στο παράθυρο διαλόγου που εμφανίζεται και μας ζητά να επιβεβαιώσουμε την 

συνέχιση της διαδικασίας επιλέγουμε «ΟΚ». 

 

Τότε, θα εμφανιστεί το παράθυρο καθορισμού της κλίμακας Step όπως φαίνεται στην 

εικόνα. 
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 Παράθυρο Κλίμακας Step 

• Στην δεύτερη στήλη, εισάγουμε τις τιμές: 0, 1.000, 2.000, 3.000. 

• Μετά επιλέγουμε το Close επάνω δεξιά στο παράθυρο για να κλείσει και να 

επιστρέψουμε στο Data Grid. 

Τέλος, εισάγουμε στη στήλη του ανάλογου κριτηρίου τις τιμές ενοικίου για κάθε 

εναλλακτική: 500, 999,1.100, 3.005, 2.500, 1.000 και 3.500. 

 

ΔΗΜΙΟΥΡΓΙΑ ΜΙΑΣ STEP ΦΟΡΜΑΣ ΑΠΟ ΤΗΝ ΑΡΧΗ 

1. Επιλέγουμε μία στήλη κριτηρίου. 

2. Πατάμε δεξί κλικ και επιλέγουμε το Step. 

3. Στο παράθυρο του διαλόγου που μας ρωτά αν θέλουμε να 

συνεχίσουμε, επιλέγουμε ‘ΟΚ’. 

4. Καθορίζουμε και εισάγουμε τα επίπεδα της κλίμακας και τα 

χαμηλότερα όρια για κάθε ένα από αυτά. Μπορούμε να χρησιμοποιήσουμε και 

αρνητικούς αριθμούς. 

5. Μετά μπορούμε ‘τραβώντας’ τις μπάρες να καθορίσουμε τις 

προτεραιότητες ή να επιλέξουμε επάνω δεξιά του παραθύρου το Assess για να 
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κάνουμε τις συγκρίσεις των επιπέδων της κλίμακας και να εξάγουμε τις 

προτεραιότητες. 

6. Στο τέλος, εισάγουμε δεδομένα στο Data Grid για κάθε εναλλακτική, 

στη στήλη του κριτήριο που καθορίσαμε με την Step. 

 

ΚΑΜΠΥΛΕΣ ΧΡΗΣΙΜΟΤΗΤΑΣ 

Οι καμπύλες χρησιμότητας είναι άλλο ένα εργαλείο που μας παρέχει ο 

πίνακας Data Grid για να αξιολογήσουμε πολλές εναλλακτικές ενός προβλήματος 

απόφασης. Με το εργαλείο αυτό, μπορούμε να μεταφράσουμε τα δεδομένα σε 

προτεραιότητες. Και ενώ όπως είδαμε η Step αποτελείται από διακριτά βήματα, οι 

Καμπύλες είναι συνεχείς. Μπορούν γενικά να είναι αύξουσες, φθίνουσες, γραμμικές ή 

μη, και αν δεν είναι γραμμικές μπορούν να είναι κυρτές και τεθλασμένες. 

Γενικά, οι καμπύλες χρησιμότητας είναι ένα πολύ χρήσιμο εργαλείο, αφού 

επιτρέπουν στους αξιολογητές να επιλέξουν οποιοδήποτε σημείο πάνω σε αυτές για 

να δείξουν την κρίση τους και έτσι μπορούν να μας δώσουν πολύ ακριβή 

αποτελέσματα. 

  

ΦΘΙΝΟΥΣΑ ΚΑΜΠΥΛΗ ΧΡΗΣΙΜΟΤΗΤΑΣ 

ΕΠΕΞΕΡΓΑΣΙΑ ΜΙΑΣ ΥΠΑΡΧΟΥΣΑΣ ΚΑΜΠΥΛΗΣ 

Για να καταλάβουμε τη λειτουργία αυτή θα δούμε πρώτα ένα παράδειγμα στο 

οποίο θα παρακολουθήσουμε μία υπάρχουσα καμπύλη, πριν να μάθουμε πώς να 

την φτιάξουμε μόνοι μας. 

• Από τον φάκελο των Samples του Expert Choice επιλέγουμε το 

ΜyRetirement και δημιουργούμε ένα αντίγραφό του για να δουλέψουμε 

πάνω σε αυτό. 

• Στο νέο αρχείο, πατάμε την καρτέλα Data Grid και διαβάζουμε το περιεχόμενο 

για να εξοικειωθούμε με αυτό. Βλέπουμε ότι στο παράδειγμα αυτό 

χρησιμοποιούνται τρία διαφορετικά είδη των φορμών του Data Grid:η 

Ratings, η Increasing Utility Curve και η  Decreasing Utility Curve. Eπίσης 
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αναφέρουμε, ότι (τυχαία) σε αυτό το παράδειγμα όλες οι καμπύλες είναι 

γραμμικές. 

 

Θα ασχοληθούμε με το πρώτο υποκριτήριο του κριτηρίου Money Matters, το Income 

Taxes: 

• Κάνουμε δεξί κλικ στη στήλη State Income Taxes 

• Στο μενού που εμφανίζεται, επιλέγουμε Decreasing. 

Αμέσως θα ανοίξει το παράθυρο της Decreasing Curve, όπου θα δούμε μία γραμμική 

καμπύλη με όρια τιμών το 75 και το 200.  
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Παράθυρο Decreasing Utility Curve 

• Δοκιμάζουμε να αλλάξουμε το 200 σε 250 και το 75 σε 90. 

• Κάνουμε Apply για να αποθηκευτεί μόνιμα η αλλαγή. 

• Πατάμε Close για να επιστρέψουμε στο Data Grid. 

Αφού επιστρέψουμε, βλέπουμε ότι τα όρια της κλίμακας έχουν πλέον αλλάξει. 

Επίσης, παρατηρούμε ότι όταν αλλάζουμε την καμπύλη, οι τιμές και οι 

προτεραιότητες επαναϋπολογίζονται αυτόματα. 

• Επιστρέφουμε στο παράθυρο της Καμπύλης πατώντας την αντίστοιχη 

καρτέλα. 

• Τραβάμε κάποιο σημείο της ευθείας γραμμής προς τα κάτω και αριστερά. 

Παρατηρούμε ότι το κουτάκι ‘Linear’ αποτσεκάρεται αυτόματα, αφού πλέον η 

καμπύλη δεν είναι γραμμική. 

Για να κάνουμε αυτή την αλλαγή μόνιμη, πατάμε ‘Apply’. 

• Eπιστρέφουμε στο Data Grid και παρατηρούμε τις αλλαγές στις μπάρες 

προτεραιοτήτων. 

 

Σημείωση: Αν θέλουμε, μπορούμε να αλλάξουμε την καμπύλη από αύξουσα 

σε φθίνουσα, απλά τσεκάροντας το Increase στο παράθυρο της Decreasing 

Utility Curve. 
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ΤΑ ΒΗΜΑΤΑ ΓΙΑ ΤΗ ΔΗΜΙΟΥΡΓΙΑ ΜΙΑΣ ΝΕΑΣ ΦΘΙΝΟΥΣΑΣ 
ΚΑΜΠΥΛΗΣ ΧΡΗΣΙΜΟΤΗΤΑΣ 

1. Επιλέγουμε ένα κριτήριο και κάνουμε δεξί κλικ στη στήλη. 

2. Επιλέγουμε από το μενού που εμφανίζεται, το Decreasing. 
3. Στο παράθυρο διαλόγου που εμφανίζεται θα κάνουμε ΟΚ. 
4. Εισάγουμε τις τιμές που θέλουμε να έχουν τα όρια της κλίμακάς μας. 

(Μπορούμε να χρησιμοποιήσουμε και αρνητικούς αριθμούς. 

5. Αν η καμπύλη δεν είναι γραμμική, την ‘τραβάμε’ κάτω και αριστερά. 

6. Κάνουμε Apply. 

7. Πατάμε Close. 

8. Τέλος, εισάγουμε αριθμητικές τιμές δεδομένων για κάθε εναλλακτική 

για το κριτήριο αυτό.  

 

ΑΥΞΟΥΣΑ ΚΑΜΠΥΛΗ ΧΡΗΣΙΜΟΤΗΤΑΣ 

Συνεχίζοντας με το ίδιο παράδειγμα που χρησιμοποιήσαμε και πριν, θα δούμε 

τώρα πώς να δημιουργήσουμε μία Αύξουσα Καμπύλη. 

• Aπό το  Tree View στο Data Grid επιλέγουμε το κριτήριο Home Mortgage 
Payment and Property Taxes. 
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Παρατηρούμε στις στήλες ότι έχει χρησιμοποιηθεί η Increasing Curve. 

• Kάνουμε δεξί κλικ στη στήλη που μας ενδιαφέρει και από το μενού επιλέγουμε 

Increasing. 

• Θα ανοίξει το παράθυρο της καμπύλης, όπου οι λειτουργίες είναι ίδιες με αυτές 

της καμπύλης Decreasing: 

• Μπορούμε να κάνουμε όποιες αλλαγές θέλουμε στην καμπύλη και μετά να 

κάνουμε Apply για να αποθηκεύσουμε τις επιλογές μας. 

• Μπορούμε να αλλάξουμε την μορφή της καμπύλης σε μη γραμμική, να 

αλλάξουμε τα όρια της κλίμακας κ.λπ. 
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 Increasing Utility Curve 

 

ΑΜΕΣΗ ΜΕΘΟΔΟΣ- ΦΟΡΜΑ 

Η άμεση μέθοδος χρησιμοποιείται για να εισάγουμε απ’ ευθείας τις 

προτεραιότητες μας (οι οποίες μπορεί να προέρχονται από κάποια άλλη πηγή ή 

μπορεί να έχουν εξαχθεί από κάποιο άλλο μοντέλο) με εύρος τιμών από το 0 έως το 

1. 

Συνεχίζοντας με το παράδειγμα που χρησιμοποιήσαμε και προηγουμένως: 

• Επιλέγουμε από το Tree View pane το υποκριτήριο Movie Theaters. 

(Υποθέτουμε ότι έχουμε ήδη τις προτεραιότητες). 

• Κάνουμε δεξί κλικ επάνω στη στήλη και από το μενού επιλέγουμε Direct. 

• Στο παράθυρο διαλόγου που εμφανίζεται, θα επιλέξουμε ΟΚ. 

• Ακολούθως, θα πληκτρολογήσουμε τις προτεραιότητες για κάθε εναλλακτική 

επιλογή. 

• Κάνουμε κλικ στο πρώτο κενό κελί κάτω από το Movie Theaters. 

• Εισάγουμε τον αριθμό 0,42.  

• Πάμε στο επόμενο από κάτω κελί και εισάγουμε 0 

• Στο επόμενο 1 
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• Στο επόμενο 0,5. 

• Στο επόμενο δοκιμάστε να μεταφέρετε την μπάρα προτεραιότητας ‘τραβώντας’ 

την μέχρι να δείτε τον επιθυμητό αριθμό. 

 

ΠΕΡΙΟΡΙΣΜΟΙ  

Οι υποχρεωτικοί περιορισμοί είναι παράμετροι – τα υψηλότερα και τα χαμηλότερα 

όρια τιμών που μπορεί μία εναλλακτική να έχει. Μπορούμε να θέσουμε περιορισμούς 

για κάθε κριτήριο. 

Αυτό, γίνεται με τον εξής τρόπο: 

• Από το Data Grid  επιλέγουμε View à Formulas/ Must. Επιλέγουμε Musts 

για να ενεργοποιήσουμε την εμφάνιση όλων των τύπων φόρμας που 

φαίνονται στο Data Grid. 

• Μεταβαίνουμε στο επιθυμητό κριτήριο και εισάγουμε το όριο τιμών που 

θέλουμε. 

 

Σημείωση: Αν κάποια εναλλακτική δεν ικανοποιεί κάποιον από τους περιορισμούς, 

τότε αυτή εμφανίζεται με κόκκινο χρώμα και υπογράμμιση. Επιπρόσθετα και η τιμή 

και η προτεραιότητα του κριτηρίου εμφανίζονται κόκκινα. 

Για να επανεμφανίσουμε τις φόρμες μας, επιλέγουμε View à  Formulas/ Must και 
μετά επιλέγουμε Formulas για να εμφανίσουμε τα επίπεδα της κλίμακας ή τις 

παραμέτρους, αν έχουν εφαρμοστεί. 

3.12 ΙΚΑΝΟΤΗΤΕΣ ΟΜΑΔΑΣ ΣΤΟ EXPERT CHOICE 

Το Expert Choice μπορεί να χρησιμοποιηθεί από μια ομάδα και  να επαυξήσει 

την ποιότητα των αποφάσεων της ομάδας με το να επιφέρει δόμηση στην διαδικασία 

Σημείωση : Για να αφαιρέσουμε μία φόρμα από το Data Grid καθώς και τα 

δεδομένα του κριτηρίου στο οποίο έχει εφαρμοστεί: κάνουμε δεξί κλικ στο 

κριτήριο και από το μενού επιλέγουμε None. 
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της λήψης απόφασης προκαλώντας πρόοδο και με τη σύνθεση διαφορετικών 

απόψεων. 

 

Ο ΡΟΛΟΣ ΤΟΥ ΣΥΝΤΟΝΙΣΤΗ 

Όταν το Expert Choice χρησιμοποιείται από ομάδα, κάποιος πρέπει να δρα 

σαν Συντονιστής. Ίσως ακόμα να ήταν χρήσιμο ένα δεύτερο άτομο να δρα σαν 

τεχνογράφος ο οποίος  είναι υπεύθυνος για την λειτουργία του υπολογιστή και τα 

άλλα τεχνολογικά μέσα.   

Πριν την έναρξη εργασιών της ομάδας ο Συντονιστής με τον διοικητή της 

ομάδας, μπορούν  να χτίσουν το μοντέλο και να εισάγουν τα ονόματα των 

Συμμετεχόντων, δημογραφικά στοιχεία, κωδικούς και άλλες πληροφορίες. 

Εναλλακτικά ο Συντονιστής και η ομάδα μπορούν να χτίσουν μαζί το μοντέλο κατά τη 

διάρκεια μιας συνεδρίασης της ομάδας. 

  

ΛΕΙΤΟΥΡΓΙΕΣ ΣΥΝΤΟΝΙΣΤΗ ΕΝΑΝΤΙ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

ΛΕΙΤΟΥΡΓΙΕΣ ΣΥΝΤΟΝΙΣΤΗ 

1. Μόνο ο Συντονιστής μπορεί να δημιουργήσει / τροποποιήσει τη 

δομή ενός μοντέλου και να εισάγει πληροφοριακά έγγραφα. 

2. Η Δόμηση, η τεχνική χτισίματος ενός μοντέλου, είναι διαθέσιμα μόνο 

για τον Συντονιστή. 

3. Οι εντολές Edit, Revert που είναι  χρήσιμη για την επιστροφή σε 

προηγούμενες καταστάσεις του μοντέλου κατά την διάρκεια μιας συνόδου είναι 

διαθέσιμα μόνο για τον Συντονιστή . 

4. Ο Συντονιστής μπορεί στον πίνακα Συμμετεχόντων να  εισάγει 

συμμετέχοντες και δημογραφικά στοιχεία για τον κάθε συμμετέχοντα καθώς και 

προαιρετικούς κωδικούς.  

5. Ο Συντονιστής ορίζει τους τύπους του πλέγματος δεδομένων. 

6. Ο Συντονιστής μπορεί ακόμα να εισάγει κρίσεις και/ ή δεδομένα για 

να συνδυαστούν με τις κρίσεις και τα δεδομένα των άλλων συμμετεχόντων. 
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ΕΝΕΡΓΕΙΕΣ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

1. Οι Συμμετέχοντες μπορούν να αλλάξουν τον κωδικό τους. 

2. Οι Συμμετέχοντες μπορούν να εκφράζουν γνώμη σχετικά με τις 

διαφορές όψεις του προβλήματος απόφασης συμπεριλαμβανομένου : 

1. Να κάνουν συγκρίσεις κατά ζεύγη. 

2. Να εισάγουν εκτιμήσεις (ratings) ή δεδομένα σε πλέγμα 

δεδομένων. 

3. Να δημιουργήσουν σημειώσεις με τις οποίες εξηγούν την 

κρίση τους καθώς και αλλά θέματα ή έννοιες. 

 

3. Οι Συμμετέχοντες μπορούν να χρησιμοποιήσουν τις εντολές Edit, 

Undo, κατά την διάρκεια μιας συγκεκριμένης συνεδρίας. 

4. Οι Συμμετέχοντες μπορούν να επανεξετάσουν το δικό τους μοντέλο 

αποφάσεων, να εκτελέσουν μια σύνθεση, να παραθέσουν γραφήματα 

ευαισθησίας καθώς και να επανεξετάσουν το περιεχόμενο του πλέγματος 

δεδομένων. Όλες οι πληροφορίες μπορούν να εκτυπωθούν. 

5. Αν επιτραπεί από τον Συντονιστή οι Συμμετέχοντες μπορούν να 

εκτυπώσουν ένα ή περισσότερα από τα συγκρινόμενα αποτελέσματα. 

 

3.13 ΔΗΜΙΟΥΡΓΙΑ ΕΝΟΣ ΜΟΝΤΕΛΟΥ ΟΜΑΔΑΣ. 

Για την δημιουργία ενός μοντέλου, ο Συντονιστής ( ο χτίστης του μοντέλου) 

πρώτα χτίζει ένα μοντέλο απόφασης όπως έχει ήδη περιγραφεί σε προηγούμενα 

κεφάλαια, και μετά προσθέτει Συμμετέχοντες όπως περιγράφεται παρακάτω.  

Θα χρησιμοποιηθεί το μοντέλο Area το οποίο βρίσκεται στα δείγματα.  

• Ανοίγουμε το Expert Choice  

• File → Open → Samples → Area 

• File →Save as → Πληκτρολογούμε το όνομα του αρχείου : GroupAreas 

ΠΡΟΣΘΗΚΗ ΤΩΝ ΣΥΜΜΕΤΕΧΟΝΤΩΝ ΚΑΙ ΤΗΣ ΟΜΑΔΑΣ 
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• Για να μετατραπεί το μοντέλο σε ομαδικό : Go → Participants Table 

ή από το Participants button από την γραμμή εργαλείων    

• Edit → Group enable.  Αυτό θα προσθέσει ένα COMBINED στον 

πίνακα. 

• Για την προσθήκη  Συμμετεχόντων στο μοντέλο επιλέγεται : edit → 

Add N Participants 

• Εισαγωγή του αριθμού των Συμμετεχόντων, για παράδειγμα 4   

 

ΕΙΣΑΓΩΓΗ Ή ΑΛΛΑΓΗ ΟΝΟΜΑΤΩΝ ΤΩΝ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

Ο Συντονιστής κάνει κλικ πάνω σε έναν Συμμετέχοντα, για παράδειγμα τον P2 και 

πληκτρολογεί ένα όνομα.  

Ο Συντονιστής μπορεί ακόμα να εισάγει και  το δικό του όνομα πληκτρολογώντας την 

λέξη Συντονιστής. 

 

Εικόνα 1- Participants table 

 

ΕΙΣΑΓΩΓΗ ΔΗΜΟΓΡΑΦΙΚΩΝ ΣΤΟΙΧΕΙΩΝ 

Δημογραφικά στοιχεία όπως ηλικία, φύλο, κωδικοί και αριθμός πληκτρολογίου 

μπορούν να εισαχθούν όπως επιθυμεί ο Συντονιστής. Αν εισαχθεί ένας κωδικός, 
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κρυπτογραφείται. Οι κωδικοί μπορούν ακόμα να εισαχθούν ή να αλλαχθούν 

χρησιμοποιώντας την εντολή Edit του ModelView.   

Επιλέγεται File → close για να κλείσει ο πίνακας των συμμετεχόντων και 

επιστρέφεται  στο ModelView. 

  

ΑΝΤΙΓΡΑΦΗ ΚΡΙΣΕΩΝ ΚΑΙ/ Ή ΔΕΔΟΜΕΝΩΝ ΠΡΟΣΘΕΤΟΝΤΑΣ 
ΣΥΜΜΕΤΕΧΟΝΤΕΣ 

Ακόμα, κρίσεις και δεδομένα μπορούν να αντιγραφούν από τον Συντονιστή ή άλλον 

συμμετέχοντα στο μοντέλο όταν προσθέτονται νέους συμμετέχοντες.  

Αυτό γίνεται από τον πίνακα Συμμετεχόντων : Edit → Copy to New Participants. Οι 

Συμμετέχοντες θα προστεθούν όπως από την εντολή Add New Participants, 

αντίστοιχα οι κρίσεις και/ή τα δεδομένα από τον συμμετέχοντα επιλεγμένα 

προσεκτικά θα αντιγραφούν στους νέους συμμετέχοντες.   

 

ΔΙΑΓΡΑΦΗ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

Η διαγραφή ενός συμμετέχοντος διαγράφει τα πάντα σχετικά με αυτόν τον 

συμμετέχοντα από το μοντέλο, αυτό περιλαμβάνει όλες τις κρίσεις, τις σχετικές 

προτεραιότητες και δεδομένα που έχουν απελευθερωθεί από αυτόν τον 

συμμετέχοντα. Πριν γίνει αυτό καλό θα ήταν να δημιουργηθεί ένα αντίγραφο του 

μοντέλου για εφεδρικό και για ιστορικούς σκοπούς. 

• Από τον πίνακα συμμετεχόντων επιλέγουμε το άτομο που θέλουμε 

να διαγράψουμε.  

• Edit → Delete Participant → Yes  

 

ΕΝΕΡΓΕΙΕΣ ΠΡΙΝ ΤΗΝ ΕΝΑΡΞΗ ΕΝΟΣ ΜΟΝΤΕΛΟΥ ΟΜΑΔΑΣ 

Τα περισσότερα από αυτά αν όχι όλα θα εκτελεστούν από τον Συντονιστή.  
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1. Το μοντέλο πρέπει πρώτα να κατασκευαστεί πριν την τοποθέτηση 

του στον server.  Κατασκευή σημαίνει ότι κριτήρια, υπό – κριτήρια και 

εναλλακτικές έχουν προστεθεί στο μοντέλο. Αν το Πλέγμα Δεδομένων 

χρησιμοποιηθεί τότε τα covering objectives formulas πρέπει να οριστούν και να 

προστεθούν.  

2. Το μοντέλο πρέπει να είναι επιτρεπτό σε ομάδα με συμμετέχοντες 

πριν χρησιμοποιήσουμε ένα μοντέλο στον server. 

3. Ο Συντονιστής πρέπει να ορίσει αν νέοι συμμετέχοντες στο δίκτυο ή 

στον Ιστό θα έχουν την δυνατότητα να έχουν πρόσβαση σε μια περίπτωση του 

μοντέλου.  

4. Αν το μοντέλο θα χρησιμοποιηθεί σε δίκτυο, ο Συντονιστής πρέπει 

να παράσχει οδηγίες στη ομάδα για την εκτίμηση του μοντέλου μέσω 

ηλεκτρονικού ταχυδρομείου.  Επιπλέον ο Συντονιστής πρέπει να στείλει μέσω 

ηλεκτρονικού ταχυδρομείου τα ονόματα και τους κωδικούς. 

 

3.14 ΑΝΟΙΓΜΑ ΟΜΑΔΙΚΟΥ ΜΟΝΤΕΛΟΥ ΜΕ ΤΗΝ ΧΡΗΣΗ 
ΠΛΗΚΤΡΟΛΟΓΙΟΥ 

1. Ο Συντονιστής θα ξεκινήσει το Expert Choice και θα επιλέξει το όνομα του 

μοντέλου. 

• Αν δεν αλλαχτεί το ορισμένο όνομα του συντονιστή όπως περιγράφτηκε πιο 

πάνω, επιλέγεται OK. Αλλιώς πληκτρολογείται το όνομα του συντονιστή, 

μετά επιλέγουμε OK. 

2. Αν το μοντέλο προστατεύεται από κωδικό θα χρειαστεί να εισάγουμε τον κωδικό. 

 

ΕΝΕΡΓΕΙΕΣ ΤΟΥ ΣΥΝΤΟΝΙΣΤΗ ΟΤΑΝ ΑΝΟΙΧΤΕΙ ΤΟ ΜΟΝΤΕΛΟ  

1. Αν ο συνδυασμός δεν παρατίθεται στο ModelView ο Συντονιστής 

πρέπει να ανοίξει τον προτεινόμενο συνδυασμό του μοντέλου με το να κάνει κλικ 

στον συνδυασμό από τον αναπτυσσόμενο κατάλογο.  

2. Μετά αν είναι να πραγματοποιηθούν δυαδικές συγκρίσεις ο 

συντονιστής θα πράξει τα ακόλουθα : 

i) Assessment → Pairwise individual. Αν έχουν προηγηθεί οι 

ομαδικές συγκρίσεις θα επιστρέψουμε στο αρχικό τρόπο σύγκρισης. Ή 
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μπορούμε να κάνουμε κλικ σε μια κάρτα σύγκρισης από την οθόνη του 

ModelView και έπειτα επιλέγουμε : Assessment →  Pairwise individual 

ii) Επιλέγονται μια από τις κάρτες σύγκρισης, λεκτική, 

αριθμητική ή γραφική, από την γραμμή εργαλείων. 

iii) Αν η ομάδα εισάγει εκτιμήσεις ή τιμές δεδομένων ο 

συντονιστής πηγαίνει στο πλέγμα δεδομένων, επιλέγει : Assessment → 

Individual  

iv) Παρέχονται οδηγίες και πληροφορίες σχετικά με την πρώτη 

δυαδική σύγκριση που θα γίνει. 

v) Κατόπιν επιδεικνύεται  είτε το Poll είτε το Vote παράθυρο. 

• Το παράθυρο Poll δείχνει ποιοι αριθμοί πληκτρολογίου έχουν ψηφίσει. Αυτό 

προσφέρει στον συντονιστή να γνωρίζει ποιοι έχουν ψηφίσει από τους 

συμμετέχοντες, χωρίς αυτοί να κοιτάνε τις ψήφους που έχουν εισαχθεί. 

• Το παράθυρο Vote δείχνει τις ακριβείς ψήφους που έχουν εισαχθεί από τον 

κάθε υποψήφιο. 

vi) Ανοίγουμε το πληκτρολόγιου κάθε συμμετέχοντα, ώστε να 

εισάγει την ψήφο του.   

vii) Αφού οι συμμετέχοντες έχουν ψηφίσει ο συντονιστής 

μετακινείται στην επόμενη δυαδική σύγκριση και επαναλαμβάνει τα βήματα 

4-6. 

viii) Όταν ολοκληρωθεί η διαδικασία των συγκρίσεων, ο 

συντονιστής υπολογίζει την ατομική και την ομαδική προτεραιότητα.  

Ο συντονιστής ίσως ακόμα επιλέξει να ορίσει ένα πλήκτρο σαν πλήκτρο του 

Συντονιστή. Η λειτουργία αυτή του επιτρέπει να μετακινείται στην αίθουσα και να μην 

είναι μόνο στον υπολογιστή του. 

 

ΑΠΟΦΑΣΗ ΟΜΑΔΑΣ ΜΕ ΧΡΗΣΗ ΤΟΥ ΠΛΗΚΤΡΟΛΟΓΙΟΥ 

Αφού ο συντονιστής έχει δώσει οδηγίες στους συμμετέχοντες και έχει παραθέσει 

τα αντίστοιχα παράθυρα του Expert Choice, οι συμμετέχοντες μπορούν να πράξουν 

τα ακόλουθα : 
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1. Από το Modelview μπορούν να πραγματοποιήσουν κρίσεις ως προς 

τα κριτήρια ή τις εναλλακτικές χρησιμοποιώντας λεκτικές, αριθμητικές ή γραφικές 

κρίσεις.  

2. Από το πλέγμα δεδομένων μπορούν να εισαχθούν δεδομένα για 

Λειτουργίες (step functions) ή καμπύλες χρησιμότητας ή να κάνουν κρίσεις 

σχετικά ratings intensities με σεβασμό στα covering κριτήρια 

ΧΡΗΣΗ ΤΩΝ ΠΛΗΚΤΡΟΛΟΓΙΩΝ ΓΙΑ ΤΗΝ ΠΡΑΓΜΑΤΟΠΟΙΗΣΗ 
ΛΕΚΤΙΚΩΝ ΣΥΓΚΡΙΣΕΩΝ  

• Επιλέγουμε ένα κουμπί από το 1-9 στο πληκτρολόγιο για να 

αναπαραστήσουμε μια αριθμητική αναπαράσταση των λεκτικών 

συγκρίσεων. Αν ο συντονιστής προτείνει το παράθυρο λεκτικής σύγκρισης, 

χρησιμοποιείται η κλίμακα στο κατώτερο σημείο του παραθύρου για να 

καθοριστεί με ποιο κουμπί θα πραγματοποιηθεί η ψηφοφορία.  

• Στην κρίση, που μεταβάλει την κυριαρχία της εκτίμησης, από τα αριστερά 

προς τα δεξιά ή αντίστροφα πρέπει να επιλεχθεί * ( το πλήκτρο με τον 

αστερίσκο) είτε πριν ή αφού πιέσουμε το πλήκτρο που τον αριθμό που 

αντιπροσωπεύει την λεκτική σύγκριση.  

 

ΧΡΗΣΗ ΤΟΥ ΠΛΗΚΤΡΟΛΟΓΙΟΥ ΓΙΑ ΤΗΝ ΔΙΕΝΕΡΓΕΙΑ ΓΡΑΦΙΚΩΝ 
ΣΥΓΚΡΙΣΕΩΝ  

 Όταν πραγματοποιούνται γραφικές συγκρίσεις χρησιμοποιείται το 

πληκτρολόγιο για την μετακίνηση τις μπάρες δεξιά ή αριστερά. Κάθε πλήκτρο 

προκαλεί την μετακίνηση των μπαρών είτε προς τα αριστερά είτε προς τα δεξιά.  

• Για την αντιστροφή της εκτίμησης, αλλάζει η φορά της κρίσης, είτε από 

αριστερά προς τα δεξιά είτε αντίστροφα, για να γίνει αυτό επιλέγεται το 6. 

• Για την διαγραφή μια κρίσης επιλέγεται το 9. 

• Για την καταγραφή μια εκτίμησης επιλέγεται 3. 
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ΧΡΗΣΗ ΤΟΥ ΠΛΗΚΤΡΟΛΟΓΙΟΥ ΓΙΑ ΤΗΝ ΔΙΕΝΕΡΓΕΙΑ 
ΑΡΙΘΜΗΤΙΚΩΝ ΣΥΓΚΡΙΣΕΩΝ 

• Επιλέγετε  ένα πλήκτρο από το 1-9 για να δειχτεί πόσες φορές πιο σημαντικός 

είναι ένας παράγοντας από έναν άλλον. 

• Για την αντιστροφή μιας εκτίμησης επιλέγεται * είτε πριν είτε αφού εισαχθεί η 

λεκτική εκτίμηση. 

• Για την διαγραφή μιας κρίσης επιλέγεται 10.  

ΞΕΧΩΡΙΣΤΕΣ ΣΥΓΚΡΙΣΕΙΣ ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΤΟ DATA GRID ΜΕ 
ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ 

Από το παράθυρο του Data Grid, ο χρήστης θα προβάλλει τις εκθέσεις του 

καθενός αντικειμενικού στόχου. 

Ο χρήστης μπορεί επίσης να εκθέτει πληροφορίες σχετικά με τους 

καλυμμένους αντικειμενικούς στόχους ή να οδηγήσει την ομάδα σε συζήτηση σχετικά 

με αυτό. 

Μετά η ομάδα μπορεί να εισάγει μια εκτίμηση ή ακόμα μια αξία. 

Όταν έχουν γίνει όλες οι εισαγωγές, ο χρήστης θα μετακινηθεί στον επόμενο 

καλυμμένο στόχο για να εκτιμηθεί. Αυτή η διαδικασία θα επαναληφθεί για όλους τους 

καλυμμένους αντικειμενικούς στόχους. 

 

 

 

 

 

 

ΠΡΟΣΘΗΚΗ ΜΙΑΣ ΕΚΤΙΜΗΣΗΣ ΜΕ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ 

ΣΥΜΒΟΥΛΗ: Η επιλογή «Autoadvance» είναι ενεργή εξ ‘ορισμού. Αν δεν δούμε το βέλος να 

δείχνει κάτω δεξιά στην μπάρα του Data Grid, ενεργοποιούμε το «Autoadvance» επιλέγοντας 

Tools – Options – Calculation και μετά επιλέγουμε «Autoadvance». 

ΣΥΜΒΟΥΛΗ: Ενώ είμαστε στο Data Grid, κλικάρωντας έναν αντικειμενικό στόχο στο 

TreeView, επιλέγεται αυτή η στήλη στο Data Grid. Αν υπάρχει ένας υπό – αντικειμενικός 

στόχος σχετιζόμενος με τον αντικειμενικό στόχο, μας τοποθετεί στον πρώτο υπό – 

αντικειμενικό στόχο. Για να πάμε σε έναν άλλον πρέπει να κάνουμε κλικ πάνω σε αυτό στην 

ιεραρχία. 
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Καθώς ο χρήστης έχει επιλέξει έναν καλυμμένο αντικειμενικό στόχο προς εκτίμηση 

από το Data Grid, μπορούμε να χρησιμοποιήσουμε το πληκτρολόγιο: 

• Πιέζουμε τον αριθμό που αντιπροσωπεύει την εκτίμηση έντασης, όπως 2 για 

κάτι πολύ καλό. 

• Πιέζουμε * για να εισάγουμε δεκαδικό σημείο και μετά εισάγουμε έναν αριθμό 

όπως 345. Για να καταγράψουμε μια δεκαδική τιμή .345, πρέπει να 

πατήσουμε *. Δηλαδή *345*. 

• Για να εισάγουμε μηδενικό, πατάμε το 10. 

• Για να σβήσουμε μια εκτίμηση, πατάμε **. 

ΠΡΟΣΘΗΚΗ ΜΙΑΣ ΕΝΔΙΑΜΕΣΗΣ ΤΙΜΗΣ ΜΕ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ 

Καθώς ο χρήστης έχει επιλέξει έναν καλυμμένο αντικειμενικό στόχο μπορούμε να 

χρησιμοποιήσουμε το πληκτρολόγιο για να: 

• Πιέσουμε το νούμερο που αντιπροσωπεύει την αξία των δεδομένων όπως 25. 

Μετά πατάμε *. 

• Πρώτα πατάμε το 0 (δηλαδή το 10) μετά πατάμε * και μετά τον αριθμό όπως 

672. Για να καταγραφεί δεκαδική τιμή .672 πρέπει να πατήσουμε *. Δηλαδή 

0*672* 

Για να εισάγουμε έναν δεκαδικό στην μέση, πατάμε για παράδειγμα 56*3*, το οποίο 

μας δίνει 56,3. 

• Για να εισάγουμε μια αρνητική τιμή, πατάμε *, μετά πατάμε τον αριθμό όπως 

675 και πατάμε  * για να καταγραφεί. Δηλαδή *675*. 

• Για να εισάγουμε 0,675,9 πατάμε 0, μετά πατάμε * ακολουθούμενο από το 

675* και τέλος το 9. 

• Για να εισάγουμε μηδενική τιμή, πατάμε το 10. 

• Για να σβήσουμε μια τιμή πατάμε **. 

 

ΠΡΟΣΘΗΚΗ ΔΕΔΟΜΕΝΩΝ ΓΙΑ ΜΙΑ ΚΑΜΠΥΛΗ ΧΡΗΣΙΜΟΤΗΤΑΣ 
ΑΠΟ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ 

Ενώ έχει επιλέξει ο χρήστης το στοιχείο που θα εκτιμηθεί: 
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• Για να εισάγουμε έναν ακέραιο πατάμε την σειρά αριθμών, όπως 765 και 

μετά*. 

• Πατάμε 0 για να εισάγουμε μηδενική τιμή και * για να εισάγουμε δεκαδικό 

στοιχείο. Μετά πατάμε τον αριθμό, όπως 345. Για να καταγράψουμε την 

δεκαδική τιμή .345, πρέπει να πατήσουμε *. Δηλαδή 0*345*. 

• Για να εισάγουμε έναν δεκαδικό στην μέση, πατάμε 56*3* και θα μας βγάλει 

56,3. 

• Σημειώστε ότι ο χρήστης πρέπει να ενεργοποιήσει την επιλογή των δεκαδικών 

χρησιμοποιώντας την εντολή Options Keypad Demicals από το 

συγκεκριμένο παράθυρο. 

• Για να εισάγουμε μια αρνητική τιμή, πατάμε * , μετά τον αριθμό που θα 

ακολουθείτε πάλι από έναν *. Αν θέλουμε να εισάγουμε -0,5 πρέπει να 

πατήσουμε *0*5. 

• Για να εισάγουμε μηδενική τιμή πατάμε το 10. 

• Για να σβήσουμε μια τιμή από την καμπύλη χρησιμότητας, πατάμε **. 

 

ΕΙΣΑΓΩΓΗ ΠΡΟΤΕΡΑΙΟΤΗΤΑΣ ΜΕ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ 

• Εισάγουμε μια προτεραιότητα στην κλίμακα από το 0 στο 1. 

Για παράδειγμα, πατάμε * για να εισάγουμε δεκαδικό στοιχείο και εισάγουμε ένα 

νούμερο όπως 672. για να καταγράψουμε μια δεκαδική τιμή .672, πρέπει να 

πατήσουμε *. Δηλαδή *672*. 

 

ΠΛΗΚΤΡΟΛΟΓΙΟ ΧΡΗΣΤΗ 

Το πληκτρολόγιο του χρήστη χρησιμοποιείται από κοινού με το μενού του 

χρήστη για να βοηθήσει τον χρήστη να συνηθίσει το Expert Choice για την δική του / 

της ιδιαίτερη ανάγκη από λογικές και άνετα ομαδοποιημένες εντολές που συχνά 

χρησιμοποιούνται με το πληκτρολόγιο του χρήστη. 
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Δέκα διαφορετικά μενού μπορούν να προσδιοριστούν. Έχουμε αρκετά 

στάνταρ μενού που μπορούν να αποδώσουν κάθε στιγμή. Ο χρήστης μπορεί να 

τροποποιήσει τα δικά μας μενού και δημιουργήσει άλλα. 

 

• Από το παράθυρο του Data Grid επιλέγουμε File – Facilitator – Menus. Τα εξ’ 

ορισμού μενού θα εμφανιστούν. Μπορούμε να επιλέξουμε άλλα, αλλάζοντας 

τον αριθμό του μενού στο παράθυρο. 

• Επανεξετάζουμε τα στάνταρ μενού και εάν επιθυμούμε τα εκτυπώνουμε. Όταν 

πλέον αποκτήσουμε μεγαλύτερη άνεση στην χρήση του Expert Choice 

μπορεί να θελήσουμε να τα αλλάξουμε ή να δημιουργήσουμε νέα μενού. 

• Για να ονομάσουμε ένα μενού ή να αλλάξουμε το ήδη υπάρχον όνομα, 

κάνουμε κλικ στην γκρι μπάρα στο κέντρο και πάνω του παραθύρου και 

πληκτρολογούμε το επιθυμητό όνομα. 

• Για να προσθέσουμε μια εντολή σε ένα μενού χρήστη, μετακινούμε τον 

κέρσορα στην σειρά όπου θέλουμε να προσθέσουμε την εντολή. Μετά 

επιλέγουμε την επιθυμητή εντολή από το κουμπί εντολών. 

Επαναλαμβάνουμε αυτή την διαδικασία αν είναι απαραίτητο. 

• Όταν τελειώσουμε κάνουμε κλικ στο οκ για να κάνουμε μόνιμες τις αλλαγές. 

• Για να επιλέξουμε την χρήση ενός μενού επιλέγουμε File – Facilitator  Menus, 

μετά επιλέγουμε έναν αριθμό από την λίστα και κάνουμε κλικ στο οκ. 

 

 

 

 

 

3.15  ΑΝΟΙΓΟΝΤΑΣ ΕΝΑ GROUPMODEL  ΣΤΟ ΔΙΑΔΙΚΤΥΟ Ή ΤΟ 
INTERNET 

1. Πρώτον το μοντέλο πρέπει να τοποθετηθεί στο διαδίκτυο ή το Internet. 

ΣΥΜΒΟΥΛΗ: Χρησιμοποιούμε την εντολή File Keypad Options, για να θέσουμε σε 

λειτουργία το πληκτρολόγιο του χρήστη πριν και αφού επιλέξουμε το μενού του χρήστη. 

ΣΥΜΒΟΥΛΗ: Πατώντας 10  θα κρύψουμε ή θα εμφανίσουμε το πρόσφατο μενού στον 

υπολογιστή. Σημείωση: Το μενού δεν είναι απαραίτητο να είναι ορατό. 
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a) Για να εγκαταστήσουμε το διαδίκτυο, πρέπει να έρθουμε σε επαφή με τον 

διαχειριστή. 

b) Για το internet θα αναφερθούμε αργότερα. 

2. Σιγουρευόμαστε ότι είμαστε συνδεδεμένοι. 

3. Ξεκινάμε την λειτουργία του Expert Choice επιλέγοντας Start. Μετά επιλέγουμε 

Programs και Expert Choice. Εναλλακτικά κάνουμε κλικ πάνω στο εικονίδιο της 

επιφάνειας εργασίας «Expert Choice». 

4. α) Αν χρησιμοποιούμε ένα διαδίκτυο, επιλέγουμε File – Open.  

b) Αν χρησιμοποιούμε Internet επιλέγουμε File – Open Web Model ή File Open 

Sql Web Model. 

5. Μετά γράφουμε την διαδρομή και το όνομα του μοντέλου μας. 

6. Όταν εμφανιστεί ένα παράθυρο διαλόγου, ρωτάει αν ανοίγουμε το μοντέλο σαν 

χρήστες ή σαν συμμετέχοντες. 

 

ΣΑΝ ΧΡΗΣΤΗΣ: 

Αν δεν θέλουμε να αλλάξουμε το όνομα χρήστη, πατάμε οκ. 

Αλλιώς πληκτρολογούμε το όνομα χρήστη που θέλουμε και μετά οκ. 

Θα χρειαστεί να πληκτρολογήσουμε και κωδικό ασφαλείας. 

 

ΣΑΝ ΣΥΜΜΕΤΕΧΟΝΤΕΣ: 

Πληκτρολογούμε είτε το όνομα του συμμετέχων ή το id αριθμό του 

συμμετέχων, που αναφέρεται ως PID.  

Αν κάποιος είχε βάλει πριν κωδικό, θα μας ζητηθεί ξανά εισαγωγή. 

 

ΣΑΝ ΕΠΙΣΚΕΠΤΕΣ: 

Πληκτρολογούμε το όνομα και μετά πληκτρολογούμε τον κωδικό. (ο χρήστης 

θα μας προμηθεύσει με έναν κωδικό εγγραφής). 
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Αν θέλουμε να αλλάξουμε τον κωδικό, χρησιμοποιούμε την εντολή 

ModelViews Edit Password. 

 

Όταν ο συμμετέχων ανοίξει ένα μοντέλο, αυτός ή αυτή είναι έτοιμος/ έτοιμη να 

κάνει συγκρίσεις για στοιχεία στην ιεραρχία αποφάσεων ή να εισάγει εκτιμήσεις ή 

δεδομένα. Ο χρήστης προμηθεύει με οδηγίες. 

 

ΟΜΑΔΟΠΟΙΗΣΗ ΑΠΟΦΑΣΕΩΝ ΜΕ ΤΗΝ ΧΡΗΣΗ ΔΙΑΔΙΚΤΥΟΥ / 
INTERNET 

Είτε ο χρήστης ή ο συμμετέχων βρίσκονται στο ίδιο κτίριο, είτε σε διαφορετικό 

κτίριο, μπορούν να ομαδοποιήσουν αποφάσεις δουλεύοντας μαζί τον ίδιο χρόνο ή 

ακόμα και σε διαφορετικό χρόνο. 

Οι συμμετέχοντες μπορούν να κάνουν συγκρίσεις για τους αντικειμενικούς 

στόχους, τους υπό και τις εναλλακτικές. Ή μπορούν χρησιμοποιώντας το Data Grid, 

να εισάγουν εκτιμήσεις ή δεδομένα για τις εναλλακτικές. Ο χρήστης μπορεί να 

προτείνει στους συμμετέχοντες να κάνουν είτε και τα δύο, είτε ένα κομμάτι του 

μοντέλου την φορά ή ολόκληρο το μοντέλο. 

Καθώς εισαχθούν οι συγκρίσεις και τα δεδομένα, ο χρήστης συνδυάζει μερικά 

ή όλα τα δεδομένα όλων ή μερικών συμμετεχόντων. 

 

ΑΠΟΦΑΣΕΙΣ ΣΥΓΚΡΙΣΕΩΝ ΑΝΑ ΖΕΥΓΗ ΤΩΝ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

Οι συμμετέχοντες μπορούν να κάνουν συγκρίσεις ανά ζεύγη με έναν από τους 

τρεις τρόπους (Προφορικό, Αριθμητικό ή Γραφικό) από το ModelView. 

 

ΔΗΜΙΟΥΡΓΙΑ ΠΡΟΦΟΡΙΚΩΝ ΣΥΓΚΡΙΣΕΩΝ 

Το παράθυρο προφορικών συγκρίσεων χωρίζεται σε δύο μέρη. Δύο στοιχεία 

συγκρίνονται. 
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Αυτό που κάνει μοναδική την διαδικασία της προφορικής σύγκρισης είναι οι 

λέξεις που χρησιμοποιούνται για να παρουσιάσουν την κλίμακα. 

Η μπάρα που ανεβοκατεβαίνει στα αριστερά χρησιμοποιείται για να δείξει ποιο 

στοιχείο προτιμάται και την δύναμη της προτίμησης. 

Η αριθμητική παρουσίαση αυτών των προφορικών στοιχείων μεταφράζεται με την 

κλίμακα αριθμών από το 1 έως το 9. 

Αν προτιμώνται τα στοιχεία στα αριστερά, τότε οι κρίσεις φαίνονται με μαύρο. 

Αν προτιμώνται τα στοιχεία στα δεξιά, τότε γίνονται κόκκινες. 

 

ΚΡΙΣΕΙΣ ΠΟΥ ΜΠΟΡΟΥΝ ΝΑ ΓΙΝΟΥΝ ΜΕ ΕΝΑΝ ΑΠΟ ΤΟΥΣ ΑΚΟΛΟΥΘΟΥΣ 

ΤΡΟΠΟΥΣ: 

• Σύρουμε την μπάρα με το ποντίκι. 

• Κάνουμε κλικ πάνω στην κλίμακα στο σημείο που επιθυμούμε. 

• Δεξί κλικ πάνω στο επιθυμητό σημείο για να προχωρήσουμε αυτόματα στην 

επόμενη σύγκριση. Είναι ο πιο γρήγορος τρόπος. 

Για να προχωρήσουμε στην επόμενη σύγκριση το Expert Choice αυτόματα 

προχωράει στην επόμενη κρίση. Αν θέλουμε να το αλλάξουμε πάμε Tools – Options 

– Calculation. 

• Αν το «Autoadvance» είναι ανενεργό, κάνουμε κλικ στο κελί. 

 

ΓΙΑ ΝΑ ΑΝΤΙΣΤΡΕΨΟΥΜΕ ΜΙΑ ΚΡΙΣΗ (για να επιλέξουμε το άλλο στοιχείο της 

σύγκρισης): 

• Κάνουμε κλικ στο εικονίδιο αντιστροφής «Invert Icon» για να επιλέξουμε το 

αντίστροφο  σημείο από την κλίμακα συγκρίσεων. 

 

ΓΙΑ ΝΑ ΕΙΣΑΓΟΥΜΕ ΚΡΙΣΕΙΣ ΑΜΕΣΩΣ ΠΑΝΩ ΣΤΗΝ ΚΛΙΜΑΚΑ ΣΥΓΚΡΙΣΕΩΝ: 
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• Κάνουμε κλικ πάνω στο κελί που αντιπροσωπεύει την σύγκριση που θέλουμε 

να κρίνουμε και πληκτρολογούμε έναν αριθμό από το 1 έως το 9. 

 

ΔΗΜΙΟΥΡΓΙΑ ΑΡΙΘΜΗΤΙΚΩΝ ΣΥΓΚΡΙΣΕΩΝ 

Οι συγκρίσεις μπορούν να γίνουν με τους παρακάτω τρόπους: 

• Σύρουμε την μπάρα με το ποντίκι. 

• Κάνουμε κλικ πάνω σε ένα νούμερο της μπάρας. 

• Δεξί κλικ πάνω στο επιθυμητό σημείο για να προχωρήσουμε αυτόματα στην 

επόμενη σύγκριση. Είναι ο πιο γρήγορος τρόπος. 

Για να προχωρήσουμε στην επόμενη σύγκριση, για να αντιστρέψουμε μια 

απόφαση και για να εισάγουμε κρίσεις αμέσως πάνω στην κλίμακα, κάνουμε ακριβώς 

την ίδια διαδικασία με προηγουμένως. 

 

ΔΗΜΙΟΥΡΓΙΑ ΓΡΑΦΙΚΩΝ ΣΥΓΚΡΙΣΕΩΝ 

Δύο στοιχεία συγκρίνονται. Το μήκος της μπάρας επιδεικνύει την σχέση 

κυριαρχίας των στοιχείων. Αν δύο στοιχεία έχουν το ίδιο μήκος μπάρας, τότε είναι 

ίσης σημασίας. Αν μια μπάρα είναι διπλάσια από την άλλη, η μεγαλύτερη δείχνει ότι 

είναι διπλάσιας σημασίας. Μπορούμε επίσης να το δούμε και σε γραφήματα «πίτας». 

Οι συγκρίσεις μπορούν να γίνουν με τους ακόλουθους τρόπους: 

• Σύρουμε είτε την μπλε, είτε την κόκκινη μπάρα με το ποντίκι. 

• Με δεξί κλικ πατημένο σύρουμε μια από τις δύο μπάρες για την αυτόματη 

μεταφορά στην επόμενη σύγκριση. 

Και στην δημιουργία γραφικών συγκρίσεων, η διαδικασία της αυτόματης 

μεταφοράς στην επόμενη κρίση, η διαδικασία της αντιστροφής της κρίσης και η 

άμεση εισαγωγή κρίσεων είναι ακριβώς ίδια με την προφορική και την αριθμητική 

σύγκριση πλην μιας μικρής διαφοράς.  
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Στην άμεση εισαγωγή κρίσεων στο κελί που αντιπροσωπεύει τις συγκρίσεις 

πληκτρολογούμε 1 μέχρι 99 (και όχι 1 έως 9 όπως στα άλλα). 

 

3.16 ΕΙΣΑΓΩΓΗ ΕΚΤΙΜΗΣΗΣ ΣΤΟ DATA GRID 

Υπάρχουν πολλοί τρόποι που μπορούν να εισαχθούν εκτιμήσεις, 

χρησιμοποιώντας είτε το πληκτρολόγιο, είτε το ποντίκι. 

ΜΕ ΤΟ ΠΟΝΤΙΚΙ: 

• Μετακινούμαστε στο κελί Data Grid. 

Παρατηρούμε πως μια κλίμακα εμφανίζεται πάνω στις εναλλακτικές του Data Grid 

όταν μετακινούμαστε σε ένα κελί. 

• Κάνουμε κλικ στην ένταση των εκτιμητών (Μπορούμε να χρησιμοποιήσουμε 

είτε λέξη που βρίσκεται στην πρώτη γραμμή, είτε νούμερο στην δεύτερη). 

Μετά θα εμφανιστεί η κλίμακα που έχουμε επιλέξει στο κελί και μπορούμε να 

μετακινηθούμε στο επόμενο κελί για να εκτιμήσουμε. 

• Με αριστερό κλικ στο ποντίκι, σύρουμε την μπάρα για το κελί στην επιθυμητή 

αξία. Αυτή η λειτουργία σου επιτρέπει να δημιουργήσεις αξία εκτιμητών 

μεταξύ δύο διαφορετικών τιμών. 

 

ΜΕ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ: 

• Πληκτρολογούμε το νούμερο που αντιπροσωπεύει την κλίμακα εκτίμησης. 

• Πληκτρολογούμε μια λέξη εκτίμησης. 

• Πληκτρολογούμε μια αξία από το 0 έως το 1. 

• Πληκτρολογούμε 0 για μηδενική εκτίμηση. 

• Σβήνουμε μια εκτίμηση, πιέζοντας Delete. 

 

ΕΙΣΑΓΩΓΗ ΤΙΜΗΣ ΣΤΟ DATA GRID 

ΜΕ ΤΟ ΠΟΝΤΙΚΙ: 
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• Μετακινούμαστε στο κελί του Data Grid. 

• Σύρουμε την μπάρα στο κελί. 

 

ΜΕ ΤΟ ΠΛΗΚΤΡΟΛΟΓΙΟ: 

• Μετακινούμαστε στο κελί του Data Grid. 

• Πληκτρολογούμε μια τιμή. Μπορούμε να αναφερθούμε στην κλίμακα που 

φαίνεται στο πάνω μέρος του  Data Grid. 

Σημείωση: Για να πληκτρολογήσουμε μια τιμή μεταξύ 0 και 1, δεν πρέπει να 

ξεχάσουμε να εισάγουμε δεκαδικό στοιχείο. 

• Για να εισάγουμε 0, πατάμε 0. 

• Για να σβήσουμε μια τιμή, πατάμε Delete. 

 

ΕΝΩΣΗ ΣΥΓΚΡΙΣΕΩΝ ΚΑΙ ΔΕΔΟΜΕΝΩΝ 

Οι συγκρίσεις και τα δεδομένα των συμμετεχόντων, θα ενημερωθούν 

αυτόματα όταν χρησιμοποιείται το πληκτρολόγιο. Οι συμμετέχοντες μπορούν να 

καταχωρήσουν τα δεδομένα στο διαδίκτυο, χρησιμοποιώντας την εντολή 

«Assessment – Post». 

Ο χρήστης θα μπορούσε να συνδυάσει τα δεδομένα του συμμετέχων, 

χρησιμοποιώντας το διαδίκτυο, ιδίως εάν οι συμμετέχοντες δουλεύουν σε ένα 

διαφορετικό περιβάλλον σε χρόνο και χώρο. 

 

3.17 ΣΥΝΔΥΑΣΜΟΙ ΚΡΙΣΕΩΝ ΚΑΙ ΔΕΔΟΜΕΝΩΝ 

Κρίσεις και δεδομένα μπορούν να συνδυαστούν για ένα σετ ενεργών 

συμμετεχόντων. Ο χρήστης προσδιορίζει ποιοι είναι ενεργοί συμμετέχοντες 

εισάγοντάς τους και εφαρμόζοντας ένα sql ερώτημα. 



105 
 

Ένας τρόπος να κάνουμε το παραπάνω είναι να επιλέξουμε ποιος θα 

συμμετέχει, κλικάρωντας και ξε –κλικάρωντας, ελέγχοντας την λίστα συμμετεχόντων 

και μετά επιλέγοντας το κουμπί συνδυασμού να επικαλεστεί την επιλογή. 

Ένας δεύτερος τρόπος είναι να επιλέξουμε ένα προκαθορισμένο sql ερώτημα 

και να πατήσουμε το κουμπί συνδυασμού.  

Ένας τρίτος τρόπος είναι να προσδιορίσουμε ένα καινούργιο sql ερώτημα και 

να επιλέξουμε το κουμπί συνδυασμού. 

Επιπρόσθετα, ο χρήστης μπορεί να συνδυάσει κρίσεις από το ModelView ή 

δεδομένα από το Data Grid. Όταν μια από αυτές τις επιλογές γίνει δεκτή 

προσδιορίζεται το ενεργό ερώτημα που θα χρησιμοποιηθεί για να συνδυάσει τις 

πληροφορίες. 

Τώρα θα εξηγήσουμε μερικά ερωτήματα που ακολουθούνται από οδηγίες: 

 

All: Επιλέγουμε * για ανθρώπους που ορίζονται από PID (Person ID). Αυτή η εντολή 

περιλαμβάνει όλους τους συμμετέχοντες που είναι ή όχι μαρκαρισμένοι.  

Αυτό το ερώτημα επιλέγει όλους τους συμμετέχοντες του μοντέλου και τους 

περιλαμβάνει στην στήλη συμμετεχόντων. 

 

Participating: Επιλέγουμε *. Αυτό το ερώτημα επιλέγει μόνο τους συμμετέχοντες 

όπου η στήλη συμμετεχόντων τους έχει μαρκαριστεί. 

Ο χρήστης μπορεί να εισάγει και να εφαρμόσει οποιοδήποτε έγκυρο sql 

ερώτημα για να επιλέξει το σετ των ενεργών συμμετεχόντων. 

Τα sql ερωτήματα μπορούν επίσης να αποθηκευτούν στο μοντέλο 

χρησιμοποιώντας το κουμπί save και να γράψουμε ένα όνομα που να προσδιορίζει 

το ερώτημα. 

 

 

ΣΥΜΒΟΥΛΗ: Προτείνεται ότι ο χρήστης εξετάζει τη λίστα συμμετεχόντων να 

εξακριβώσει ότι το επιθυμητό σετ συμμετεχόντων είναι ενεργό πριν συνδυάσει κρίσεις 

και δεδομένα. 
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Όλοι οι συμμετέχοντες που εισάγονται στην βάση δεδομένων αρχικά 

θεωρούνται ενεργοί. Αν επιθυμούμε να κάνουμε κάποιον ανενεργό πρέπει να 

κάνουμε κλικ στην στήλη του / της. 

Ο συνδυασμός κρίσεων και δεδομένων μπορεί να γίνει μόνο από τον χρήστη. 

Αυτή η διαδικασία μπορεί να πραγματοποιηθεί από ένα ή τρία μενού και παράθυρα 

• Από το ModelView 

• Από το Data Grid 

• Από το παράθυρο Συμμετεχόντων. 

Οι κρίσεις, καθώς επίσης και τα δεδομένα των ενεργών συμμετεχόντων θα 

συγκριθούν και θα τοποθετηθούν στην ενότητα των «συνδυασμένων» της βάσης 

δεδομένων με PID και θα τοποθετηθούν στην μνήμη όπου τα αποτελέσματα θα 

μπορούν να επανεξεταστούν και να αναλυθούν σε διαγράμματα ευαισθησίας.  

Επιπλέον, αυτή η στήλη θα ελέγχεται για να αποφευχθεί αυτό το μοντέλο 

συνδυασμών να συμπεριληφθεί σε μελλοντικούς συνδυασμούς. 

 

 

 

 

 

 

ΣΥΝΔΥΑΣΜΟΙ ΑΠΟ ΤΟ ΠΑΡΑΘΥΡΟ ΣΥΜΜΕΤΕΧΟΝΤΩΝ 

• Κάνουμε κλικ στο κουμπί Combine Individuals, στο κάτω μέρος του 

παραθύρου συμμετεχόντων. 

• Ένα παράθυρο διαλόγου θα εμφανιστεί, ζητώντας να επιλέξουμε ένα από τα 

παρακάτω: 

o Κρίσεις μόνο, 

o Δεδομένα μόνο, 

ΣΥΜΒΟΥΛΗ: Ο χρήστης μπορεί να συνδυάζει διαφορετικά μέρη ενός μοντέλου με 

διαφορετικά σετ ενεργών συμμετεχόντων. Για παράδειγμα, άνθρωποι που έχουν 

ειδικευτεί σε έναν τομέα μπορεί να κάνει συγκρίσεις για μια ομάδα αντικειμενικών 

στόχων στην ιεραρχία αποφάσεων, ενώ μια άλλη ομάδα ανθρώπων που 

ειδικεύονται σε έναν άλλον τομέα μπορούν να κάνουν το ίδιο για μια άλλη ομάδα 

αντικειμενικών στόχων. Ακόμα, άλλο γκρουπ μπορεί να εισάγει εκτιμήσεις ή 

δεδομένα σε όλα τα μέρη ή μερικά του Data Grid. 
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o Και τα δύο 

 

ΣΥΝΔΥΑΣΜΟΙ ΑΠΟ ΤΟ MODELVIEW 

• Επιλέγουμε Combined από την λίστα του ModelView. 

• Επιλέγουμε Assessment, μετά επιλέγουμε Combine Participants Judgments / 

Data. 

• Επιλέγουμε Entire Hierarchy. Ένα παράθυρο διαλόγου θα εμφανιστεί 

ζητώντας να επιλέξουμε τα εξής: 

o Κρίσεις (μόνο στην ιεραρχία) 

o Μόνο Δεδομένα 

o Και τα δύο 

 

• Μετά διαλέγουμε την επιλογή μας. Επιλέγοντας Judgments θα συνδυάσει τις 

κρίσεις των ενεργών συμμετεχόντων του μοντέλου. Μπορούμε να 

προσδιορίσουμε τις ενεργές κρίσεις. Επιλέγοντας δεδομένα θα συνδυάζουμε 

μόνο τα δεδομένα των ενεργών συμμετεχόντων. 

 

ΣΥΝΔΥΑΣΜΟΙ ΑΠΟ ΤΟ DATA GRID 

Όταν συνδυάζουμε από το Data Grid, μόνο δεδομένα (και όχι κρίσεις) 

συνδυάζονται για την ιεραρχία αποφάσεων. 

• Επιλέγουμε Assessment, μετά Combine Data For… και επιλέγουμε μια από τις 

τρεις επιλογές: 

o Όλους τους καλυμμένους αντικειμενικούς στόχους 

o Τους καλυμμένους στόχους του επιλεγμένου Parent Plex. 

o Μόνο τους επιλεγμένους καλυμμένους αντικειμενικούς στόχους. 

 

3.18 ΒΑΣΗ ACCESS ΚΑΙ SQL 
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Ο δικός μας χρήστης Expert Choice αποθηκεύει τα μοντέλα μας σε μια βάση 

Access. Αυτά τα αρχεία έχουν κατάληξη .AHP. 

Το Expert Choice μπορεί να είναι είτε βάση Access, είτε Sql. Για να 

χρησιμοποιήσουμε sql, πρέπει να έχουμε και Microsoft Access 2000 και Microsoft 

Sql 7.0 εγκατεστημένα στον υπολογιστή μας. Ο Sql server θα προσδιορίσει την 

ονομασία των αρχείων και την κατάληξη τους. 

 

ΑΛΛΑΓΗ ΑΠΟ ΒΑΣΗ ACCESS ΣΕ SQL 

1. Ξεκινάμε MS Access 

a) Επιλέγουμε και χρησιμοποιούμε την διαδρομή που περιέχει 

το Expert Choice .AHP μοντέλο. 

b) Στο κουτί διαλόγου πληκτρολογούμε *.AHP για να δούμε όλα 

τα AHP μοντέλα. 

c) Επιλέγουμε ένα μοντέλο. Αυτό το μοντέλο είναι σε Access 

2000. 

d) Επιλέγουμε να δημιουργήσουμε καινούργια βάση και μετά 

πατάμε επόμενο. 

e) Στο επόμενο παράθυρο: 

 

i) Πληκτρολογούμε το server name της βάσης 

δεδομένων ή επιλέγουμε ένα από την λίστα. 

ii) Πληκτρολογούμε το ID (συνήθως του Administrator). 

iii) Πληκτρολογούμε τον κωδικό (συνήθως sa). 

iv) Πληκτρολογούμε το όνομα μιας καινούργιας βάσης 

δεδομένων Sql Server. 

v) Πατάμε επόμενο. Αν εμφανιστεί μήνυμα λάθους, 

πατάμε οκ. Όταν εμφανιστεί το παράθυρο διαλόγου πατάμε Trusted 

Connection και συνεχίζουμε. 

 

f) Στο επόμενο παράθυρο, όταν ερωτηθούμε «σε ποιο πίνακα 

θέλουμε να εξάγουμε τον Sql Server? », κάνουμε κλικ στο button για να 
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συμπεριλάβουμε όλους τους πίνακες των βάσεων δεδομένων και πατάμε 

επόμενο. 

g) Αν δεν χρειαστεί να αλλάξουμε κάτι στα επόμενα δύο 

παράθυρα, πατάμε δυο φορές επόμενο. 

h) Πατάμε τέλος για να ολοκληρώσουμε την μετατροπή σε sql 

7.0. 

i) Κλείνουμε την Access. 

2. Ξεκινάμε το Expert Choice. 

a) Επιλέγουμε. 

b) Πληκτρολογούμε το όνομα του Server, το όνομα του χρήστη 

(Login ID) και τον κωδικό που δίνεται στο 1f. 

ΠΡΟΣΒΑΣΗ ΣΤΗΝ ΒΑΣΗ EXPERT CHOICE ΣΕ SQL 7.0 

1. Πρώτα δημιουργούμε ένα μοντέλο Expert Choice σε Access, 

χρησιμοποιώντας την εντολή File – Open. 

2. Μετατρέπουμε την βάση από Access σε sql, όπως περιγράψαμε 

παραπάνω. 

3. Ξεκινάμε τον Sql, επιλέγοντας Microsoft’s Service Manager.  

4. Επιλέγουμε Microsoft’s Sql Enterprise Manager. Για να δούμε την 

βάση μας. 

a) Ψάχνουμε κατά όνομα να βρούμε το Sql αρχείο που 

δημιουργήσαμε. 

b) Χρησιμοποιούμε εντολές Sql. Απαιτείται να 

χρησιμοποιήσουμε το Expert Choice για να προσθέσουμε ή να διαγράψουμε 

πληροφορίες από την βάση. 

 

ΕΚΤΕΛΕΣΗ EXPERT CHOICE ΣΕ ΒΑΣΗ SQL 

1. Ξεκινάμε το Expert Choice. 

2. Επιλέγουμε File – Open a Sql Model. 

3. Μετά κάνουμε τα ακόλουθα: 

• Πληκτρολογούμε http://models.expertchoice.com 

• Το όνομα του Sql Server. 

http://models.expertchoice.com
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• Το όνομα μοντέλου 

• Τον ID χρήστη 

• Τον κωδικό. 

 

3.19 ΚΑΤΑΝΟΜΗ ΤΩΝ ΠΟΡΩΝ 

Η ενότητα κατανομής πόρων του Expert Choice παρέχει έναν τρόπο επιλογής 

ενός συνδυασμού εναλλακτικών που μεγιστοποιεί έναν στόχο χωρίς να υπερβαίνει 

έναν συγκεκριμένο προϋπολογισμό. Άλλοι περιορισμοί μπορούν επίσης να οριστούν.  

Υπάρχουν δυο τύποι κατανομής πόρων, ιδιαίτερο (discrete) και ενεργό 

επίπεδο. 

 

 

ΕΚΤΕΛΕΣΗ ΤΗΣ ΚΑΤΑΝΟΜΗΣ ΠΟΡΩΝ 

Η ενότητα κατανομής πόρων βρίσκεται στο menu του πλέγματος δεδομένων. 

Αυτή η ενότητα εξάγει πληροφορίες από το Expert Choice με την ικανότητα ομάδας 

και διατυπώνει τους τύπους σε φύλλο εργασίας το οποίο θα χρησιμοποιηθεί για την 

εκτέλεση  των υπολογισμών της κατανομής πόρων.  

Πριν χρησιμοποιηθεί η κατανομή πόρων θα πρέπει να έχει ολοκληρωθεί η 

εκτίμηση του μοντέλου. Επιπλέον θα πρέπει να εισαχθούν κόστη για κάθε 

εναλλακτική στην στήλη Κόστος του Πλέγματος δεδομένων.   

 

ΙΔΙΑΙΤΕΡΗ ΕΝΑΛΛΑΚΤΙΚΗ ΒΕΛΤΙΣΤΟΠΟΙΗΣΗ ΚΑΤΑΝΟΜΗΣ ΤΩΝ 
ΠΟΡΩΝ 

Αυτή η ενότητα χρησιμοποιεί αλγόριθμους οι οποίοι είναι εξαιρετικά γρήγοροι, 

ακόμα και για πολύ μεγάλα προβλήματα. 

1. Φορτώνεται το μοντέλο. 

2. Από το μενού του Expert Choice επιλέγεται Go – Data grid 
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3. Επιλέγετε Tools – Resource Allocation 

4. Το Expert Choice θα τυποποιήσει το αριστοποιημένο πρόβλημα και 

θα μεταφερθεί σε ένα φύλλο εργασίας του Excel όπου θα μπορεί να ελεγχθεί η 

πρόοδος της αριστοποίησης. Το  Expert Choice ορίζει αν ένα discrete ή ενεργό 

επίπεδο αριστοποίησης πρέπει να εκτελεστεί βασισμένο στην παρουσία ή την 

απουσία ενεργών επίπεδων. Αφού δεν υπάρχουν επίπεδα δραστηριότητας στο 

μοντέλο, η Ιδιαίτερη Κατανομή Πόρων των Εναλλακτικών θα εκτελεστεί και θα 

μεταφερθεί σε ένα φύλλο εργασίας του Excel που θα εμφανίζονται πληροφορίες 

που έχουν εξαχθεί από το Expert Choice.      

5. Η αρχική έκθεση παρουσιάζει μια «λύση» όπου κάθε εναλλακτική 

ορίζεται στο πιο υψηλό επίπεδο οφελών (σημειώνεται 1  στην στήλη Β), και το 

ολικό πόσο που απαιτείται για την χρηματοδότηση αυτών των επίπεδων κάτω 

από το κόκκινο/ πορτοκαλί κελί στην στήλη του Κόστους.  

 

 

6. Πληκτρολογείται ένα όριο προϋπολογισμού στο   κόκκινο/ πορτοκαλί 

κελί και πατάτε Enter. Στο παράδειγμα εισάγετε 50000. 

7. Από την γραμμή εργαλείων του Excel επιλέγεται  Resource 

Allocation. Από το μενού επιλέγεται Solve. 

8. Τα αποτελέσματα δείχνουν ότι όλες εκτός από δυο εναλλακτικές 

χρηματοδοτούνται και πόση χρηματοδότηση απαιτείται.  
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Οι στήλες Ελαχιστοποίησης και Μεγιστοποίησης στο φύλλο εργασίας. Αν 

πληκτρολογηθεί 1 στην στήλη Min σε μια εναλλακτική πρέπει να χρηματοδοτηθεί. Αν 

εισάγετε 0 για μια εναλλακτική τότε δεν θα χρηματοδοτηθεί.  

Αφού εμφανιστούν τα αποτελέσματα μπορεί να επιλεχθεί  η βελτιστοποίηση για 

την αύξηση του προϋπολογισμού ( optimize for increasing  budgets) με την επιλογή 

αυτής της επιλογής από το μενού  Resource Allocation. Μετά είτε γίνονται αποδεχτά 

τα αποτελέσματα για αυτήν την συνάρτηση είτε τα αλλάζετε. 

 

• Η στήλη Minimum χρησιμοποίει το χαμηλότερο κόστος δραστηριότητας/ 

εναλλακτικής, για παράδειγμα 1000 

• Η Minimum difference of Costs (Ελάχιστη διαφορά των δαπανών) 

χρησιμοποίει το delta (αλλαγή) για να αυξήσει το πόσον του 

προϋπολογισμού, για παράδειγμα 100. 

• Ο χρήστης προσδιορίζει την προκαθορισμένη αξία, 1000. Μπορείτε να ορίσετε 

οποιαδήποτε τιμή σε αυτό το κελί.  

• Ο κατά προσέγγιση αριθμός των προσαυξήσεων: η προεπιλογή και 

προτεινόμενη επιλογή είναι 25. Ωστόσο μπορείτε να εισάγετε έναν αριθμό 
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από το 0 ως το μέγιστο προϋπολογισμό. Ο αριθμός των προσαυξήσεων 

χρησιμοποιείται για να προσδιοριστεί το επόμενο σημείο στην καμπύλη 

Pareto.  

 

Μπορούν να προστεθούν στήλες περιορισμού ( Add constraint Columns) στο 

φύλλο εργασίας διαλέγοντας αυτήν την επιλογή από το μενού της κατανομής πόρων. 

Η παρακάτω εικόνα δείχνει μια νέα στήλη που έχει προστεθεί και επίσης εμφανίζει τα 

αποτελέσματα της αριστοποίησης βασισμένης στην νέα εισαγωγή.  

 

 

 

 

Για την προσθήκη περιορισμού ακολουθείται η διαδικασία: Από το μενού 

Resource Allocation ( κατανομής πόρων) επιλέγεται Add constraint Column 

(Εισαγωγή στήλης περιορισμού).  
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1. Όταν ζητηθεί, πληκτρολογήται ο αριθμός των στηλών που θα 

εισαχθούν, σε αυτό το παράδειγμα πληκτρολογήστε 1. οι νέες στήλες των 

περιορισμών θα προστεθούν στα δεξιά των κριτηρίων και των στηλών κόστους.  

2. Μετά θα πρέπει να εισαχθεί έναν τίτλο (επικεφαλίδα κειμένου) για 

κάθε νέα στήλη. Σε αυτό το παράδειγμα προστίθεται η κεφαλίδα Sup Wks για τις 

εποπτευόμενες εβδομάδες.  

3. Τώρα εισάγεται ο αριθμός των εβδομάδων που απαιτούνται από τον 

Επόπτη για κάθε εναλλακτική όπως φαίνεται στην εικόνα.  

4. Υποτίθεται ότι μόνο 4 εβδομάδες του χρόνου των εποπτών είναι 

διαθέσιμές, τότε εισάγεται ένα 4 στην γραμμή “max” της νέας στήλης. 

5. Από το μενού της κατανομής πόρων (resource allocation), 

επιλέγεται Solve. Τα αποτελέσματα με τους νέους περιορισμούς θα εμφανιστούν. 

Τα κελιά χρώματος ροζ δείχνουν το συνολικό κόστος και σε αυτό το παράδειγμα 

τις συνολικές ώρες των εποπτών. 

6. Όταν θα έχει ολοκληρωθεί  η αριστοποίηση δίνεται η δυνατότητα να 

αποθηκευτεί το φύλλο εργασίας.  

 

ΧΑΡΑΚΤΗΡΙΣΤΙΚΟ ΚΤΗΣΗΣ 

Χρησιμοποιείται η κάρτα Dependency (εξάρτησης) για να προσδιοριστούν οι 

εξαρτήσεις μεταξύ των εναλλακτικών στην κατανομή των πόρων.  Η κάρτα 

εξάρτησης για το μοντέλο Hawthorne, φαίνεται πιο κάτω.  
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Για να προστεθεί μια εξάρτηση από το Excel, μπορείτε είτε να κάνετε κλικ στο 

Resource Allocation / Add Dependency από το μενού ή από τον πίνακα εξάρτησης 

δεξί κλικ σε ένα κελί (γραμμή, στήλη ή στήλη, γραμμή) το οποίο θα εξαρτηθεί. 

Προτείνεται η τελευταία επιλογή δεδομένου ότι απαιτείται λιγότερη πληκτρολόγηση. 

Όταν εμφανιστούν οι επιλογές  εξάρτησης, κάντε κλικ ή πληκτρολογήστε D, M, ή X. 

D: Το στοιχείο της γραμμής εξαρτάται από το στοιχείο της στήλης.  Η αριστοποίηση 

βεβαιώνει ότι το στοιχείο της σειράς δεν χρηματοδοτείται αν δεν χρηματοδοτηθεί το 

στοιχείο της στήλης. 

M: Τα στοιχεία της γραμμής και της στήλης είναι αμοιβαία εξαρτώμενα, θα πρέπει και 

τα δυο να χρηματοδοτηθούν ή να μην χρηματοδοτηθεί κανένα.  

X: Τα στοιχεία της γραμμή και της στήλης είναι αμοιβαία αποκλειόμενα, η 

χρηματοδότηση του ενός σημαίνει την μη χρηματοδότηση του άλλου.  

 

Πιο κάτω παρουσιάζονται 3 δείγματα για το μοντέλο  Hawthorne. Τα Dairy 

chart Recorder και το Solar Greenhouse είναι αμοιβαία αποκλειόμενα. Το   Solar 

Greenhouse και το Dairy Maintenance Work είναι αμοιβαία εξαρτώμενα. Το Bulk 

Tank Frig εξαρτάται από το Dairy Structure Work.  

Για να διαγράψετε μια εξάρτηση, μετακινείστε στο κελί (γραμμή, στήλη ή στήλη, 

γραμμή) και πιεστέ Delete. 
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Για να διαγράψετε τον πίνακα εξάρτησης, από το Excel επιλέξτε Resource Allocation 

→ Clear Dependency Table.  

Activity Level Resource Allocation Optimization (Βελτιστοποίηση των επιπέδων 

δραστηριότητας της κατανομής των πόρων) 

 

Εξηγείται μέσω παραδείγματος ο τρόπος εκτέλεσης μιας βελτιστοποίησης του 

επιπέδου δραστηριότητας κατανομής των πόρων. 

1. Φορτώστε το μοντέλο Hotspots από την περιοχή Δειγμάτων του 

Expert Choice.  

2. Από το μενού του Expert Choice επιλέγετε Go → Data Grid   

3. Κάθε εναλλακτική μπορεί να έχει όσα επίπεδα χρηματοδότησης 

επιθυμούνται, κάθε μια  ξεχωριστή γραμμή στο πλέγμα δεδομένων. Το όνομα της 

εναλλακτικής ακολουθήται από  άνω και κάτω τελεία οι οποίες ακολουθούνται 

από κείμενο το οποίο περιγράφει το επίπεδο χρηματοδότησης. Για να υποδείξετε 

επίπεδα δραστηριότητας πρέπει να προσαρμοστείτε στην ακόλουθη μετατροπή :  

όνομα εναλλακτικής : επίπεδο δραστηριότητας, για παράδειγμα  Suitland 

Nuisance Abatement:3000. 

4. Το κόστος για κάθε δραστηριότητα εισάγετε στην στήλη του κόστους 

αντίστοιχα με την σειρά για το επίπεδο.  Είναι σύνηθες τα επίπεδα να εισάγονται 

στην αυξανόμενη ή στην μειούμενη ακολουθία. Συνήθως η συνολική 

προτεραιότητα για επίπεδα με περισσότερη χρηματοδότηση θα έχουν μια 

μεγαλύτερη συνολική συμβολή στα κριτήρια. 

5. Επιλέγετε Tools → Resource Allocation.  Θα μεταφερθείτε σε ένα 

φύλλο εργασίας του Excel το οποίο θα εμφανίζει πληροφορίες που έχουν εξαχθεί 

από το Expert Choice. Το Expert Choice θα διατυπώσει την βελτιστοποίηση σαν 

ένα Ενεργό Επίπεδο βελτιστοποίησης αν τα Ενεργά Επίπεδα έχουν οριστεί όπως 

πιο πάνω. Η ακόλουθη εικόνα παρουσιάζει τις εξαγόμενες πληροφορίες.  
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1. Θα ρωτηθείτε αν θα πρέπει να χρηματοδοτηθεί ένα επίπεδο για 

κάθε δραστηριότητα (must one level be funded for each activity?), επιλέξτε Yes. 

(Επιλέξτε No αν δεν θέλετε να επιτρέψετε να χρηματοδοτηθεί ένα επίπεδο για μια 

ή περισσότερες δραστηριότητες). 

2. Η αρχική επίδειξη παρουσιάζει μια «λύση» όπου κάθε 

δραστηριότητα χρηματοδοτείται (δεν υπάρχει 1 στην Στήλη Β) και το συνολικό 

πόσο που απαιτείται για την χρηματοδότηση κάθε εναλλακτικής είναι στο 

κόκκινο/πορτοκαλί κελί στην Στήλη του Κόστους.  

3. Πληκτρολογήστε το όριο του προϋπολογισμού σας, για αυτό το 

παράδειγμα 75000, στο κόκκινο κελί. Μετά πιεστέ Enter.  

4. Από την γραμμή εργαλείων του Excel, επιλέξτε Resource Allocation. 

Από το μενού που ανοίγεται επιλέξτε Solve. 

Η ακόλουθη εικόνα παρουσιάζει τα αποτελέσματα.  
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Οι στήλες Ελαχιστοποίηση (Min) και Μεγιστοποίηση 

(Max) στο φύλλο εργασίας. 

Αν εισάγετε 1 στην στήλη ελαχιστοποίησης (Min) για μια δραστηριότητα τότε 

πρέπει να χρηματοδοτηθεί. Αν εισάγετε 1 στην στήλη Μεγιστοποίησης (Max) τότε η 

δραστηριότητα δεν πρέπει να χρηματοδοτηθεί.   

Αφού δείτε τα αποτελέσματα σας μπορείτε να επιλέξετε να Βελτιστοποίηση για 

Αύξηση των Προϋπολογισμών (Optimize for Increasing Budgets), επιλέγοντας το 

από το μενού της κατανομής πόρων.  

Μπορείτε να επιλέξετε να προσθέσετε στήλες περιορισμών στο φύλλο 

εργασίας επιλέγοντας αυτήν την δυνατότητα από το μενού της κατανομής πόρων. Η 

κάτωθι εικόνα παρουσιάζει μια νέα στήλη η οποία έχει προστεθεί και επίσης 

παρουσιάζει τα αποτελέσματα της βελτιστοποίησης, βασισμένης στην νέα εισαγωγή.  
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Για να προσθέσετε έναν περιορισμό ακολουθήστε : 

1. Από το μενού της κατανομής πόρων, επιλέγετε Add Constraint 

Column. 

2. Όταν σας ζητηθεί, πληκτρολογήστε τον αριθμό των στηλών που 

θέλετε να προσθέσετε, σε αυτό το παράδειγμα πληκτρολογήστε 1. 

3. Κατόπιν πρέπει να εισάγετε έναν τίτλο για κάθε στήλη. Σε αυτό το 

παράδειγμα πληκτρολογήστε Sup wks. 

4. Τώρα εισάγετε τον αριθμό των εβδομάδων που απαιτούνται από τον 

Επιβλέποντα για κάθε δραστηριότητα, όπως φαίνεται στην εικόνα. Σημειώστε ότι 

κάποιες στήλες μπορεί να είναι κενές.  

5. Υποθέστε ότι μόνο  5 εβδομάδες του Επιβλέποντα είναι διαθέσιμες. 

Εισάγετε ένα 5 στην γραμμή “max” της νέας στήλης περιορισμών.   

6. Από το μενού του Resource Allocation επιλέξτε Solve. Αν επιθυμείτε 

μπορείτε να αυξήσετε τους προϋπολογισμούς. Θα παρατεθούν τα αποτελέσματα 

με τον νέο περιορισμό. Σημείωση : Τα ροζ κελία δείχνουν το συνολικό κόστος και 

σε αυτήν την περίπτωση τις συνολικέ επιβλεπόμενες ώρες. 
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7. Όταν τελειώσετε με την χρήση της βελτιστοποίησης σας δίνετε η 

ευκαιρία να σώσετε το φύλλο εργασίας, προτείνετε η αποθήκευση του με 

μετονομασία του εγγράφου και όχι η αυτόματη αποθήκευση.  

ΚΕΦΑΛΑΙΟ 4 : ΕΦΑΡΜΟΓΗ ΠΡΟΓΡΑΜΜΑΤΟΣ EXPERT CHOICE 

 

4.1 ΕΦΑΡΜΟΓΗ ΛΗΨΗΣ ΑΠΟΦΑΣΗΣ ΜΕ ΤΟ EXPERT CHOICE 

Η διοίκηση της εταιρείας «ΒFC Ltd. » θέλει να επανεξετάσει τον τρόπο με τον 

οποίο διαφημίζονται τα προϊόντα της. Μέχρι σήμερα η προώθηση γινόταν μέσω της 

τηλεόρασης, του ημερησίου και περιοδικού τύπου και μέσω της ιστοσελίδας της 

επιχείρησης που έχει αναπτυχθεί εδώ και δύο χρόνια. 

Όμως με την εμφανή αύξηση χρήσης του Internet, σκέφτεται να προχωρήσει 

στη δημιουργία διαφημιστικής καμπάνιας μέσω αυτού, έτσι ώστε να έχει μεγαλύτερη 

επισκεψιμότητα η ιστοσελίδα, να αυξηθούν οι πωλήσεις και να προωθήσει τα 

προϊόντα της σε νέα τμήματα της αγοράς. Πιο συγκεκριμένα, υπάρχει ενδιαφέρον για 

το τμήμα αγοράς που περιλαμβάνει άντρες και γυναίκες από 15-35 ετών και το 

μορφωτικό επίπεδο αυτών είναι μέσο ως υψηλό.  Το τμήμα marketing έκανε μία 

έρευνα και τα αποτελέσματα καταδεικνύουν τα εξής: 

• Η χρήση του Διαδικτύου από τους Έλληνες αυξήθηκε κατά 70% τα τελευταία 

τρία έτη. Τέσσερις στους δέκα πολίτες χρησιμοποιούν πλέον ηλεκτρονικούς 

υπολογιστές και ένας στους τρεις έχει πρόσβαση στο Ίντερνετ, όταν το 2004 

το αντίστοιχο ποσοστό μόλις άγγιζε το 19,7%   

• H διείσδυση του γρήγορου Ιnternet αγγίζει σήμερα το 10% του πληθυσμού 

από μόλις 0,1% το 2004, ενώ από το πρώτο τρίμηνο του 2004 έως το 

πρώτο του 2007 οι πολίτες που χρησιμοποιούν υπολογιστές αυξήθηκαν 

κατά 53%.   

• Η διείσδυση του ΑDSL στον πληθυσμό, σύμφωνα με στοιχεία της Εθνικής 

Επιτροπής Τηλεπικοινωνιών και Ταχυδρομείων (ΕΕΤΤ), στο τέλος της 

περασμένης χρονιάς έφτανε το 9%, ενώ οι συνδέσεις που έγιναν μέσω 

ιδιωτικών εναλλακτικών παρόχων (πλην ΟΤΕ) ξεπέρασαν 

τις 300.000. (στοιχεία από το  
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H διοίκηση της «BFC» αποφάσισε σύμφωνα με τα παραπάνω δεδομένα: 

a) να επιλέξει ως κύριο μέσο προβολής της πλέον το Internet με 

τη δημιουργία διαφήμισης που θα καταχωρηθεί σε κάποιο δημοφιλές site 

ή σε κάποια μηχανή αναζήτησης  

b) να μειώσει το κόστος διαφήμισης στην τηλεόραση και τον 

περιοδικό τύπο. 

To πρόβλημα απόφασης που αντιμετωπίζει, αφορά την επιλογή της 

κατάλληλης ιστοσελίδας η οποία θα φιλοξενήσει την διαφήμιση. 

Η διοίκηση της εταιρεία μας θα πρέπει να επιλέξει την πιο αποδοτική αλλά και 

οικονομικά συμφέρουσα λύση. 

Μετά από μια σχετική έρευνα στο διαδίκτυο, οι εναλλακτικές επιλογές που 

προέκυψαν, είναι οι ακόλουθες: 

1. Google  

2. Facebook 

3. Yahoo 

Τα κριτήρια με τα οποία θα ληφθεί η απόφαση, δεν είναι ακόμη απόλυτα 

καθορισμένα, γιατί οι συμμετέχοντες έχουν διάφορες απόψεις -και κάποιες 

προτιμήσεις- αφού οι ιστοσελίδες είναι δημοφιλείς και όλοι τις χρησιμοποιούν. 

Σαφώς, η εταιρεία ενδιαφέρεται για μια λύση που θα κοστίσει όσο το δυνατόν 

λιγότερο, αλλά θα συνεκτιμηθούν διάφοροι παράγοντες για την εύρεση της 

καταλληλότερης λύσης. 

Ως λογισμικό για την διεξαγωγή της απόφασης, χρησιμοποιείται το Expert 

Choice που είναι αξιόπιστο και φιλικό προς τον χρήστη.  

 

4.2 ΔΙΑΔΙΚΑΣΙΑ ΔΗΜΙΟΥΡΓΙΑΣ ΜΟΝΤΕΛΟΥ EXPERT CHOICE ΜΕ 
ΤΗΝ ΕΜΜΕΣΗ ΤΕΧΝΙΚΗ ΤΗΣ ΔΟΜΗΣΗΣ 

Η  ομάδα της εταιρίας  που θα πάρει την απόφαση, επέλεξε να δημιουργήσει 

ένα μοντέλο με την τεχνική της δόμησης (structuring) αφού δεν έχουν οριστεί ακόμη 
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σαφώς τα κριτήρια που θα χρησιμοποιηθούν. Επιπροσθέτως, κάποια κριτήρια θα 

καθοριστούν καλύτερα με τη συζήτηση μεταξύ των μελών της ομάδας. ΟΙ 

συμμετέχοντες θα εκφράσουν προτιμήσεις, απόψεις για κάθε ιστοσελίδα και θα 

εκθέσουν τα θετικά και αρνητικά σε κάθε περίπτωση .Αυτός είναι ένας πολύ καλός 

τρόπος έμμεσης εξαγωγής κριτηρίων σε περιπτώσεις σαν τη δική  μας όπου έχουμε 

βεβαίως υπ’όψιν κάποια κριτήρια όπως το κόστος, αλλά στην ουσία γνωρίζουμε πιο 

πολλά για τις εναλλακτικές. 

Γενικότερα, η εμπειρία των συμμετεχόντων έχει δείξει ότι όταν τα κριτήρια μιας 

απόφασης δεν είναι καθορισμένα εξαρχής με σαφήνεια, είναι καλύτερο να 

χρησιμοποιούμε τη μέθοδο της δόμησης του μοντέλου η οποία είναι πιο ευέλικτη, 

παρά την απευθείας τεχνική,.  

1. Δημιουργία της ιεραρχικής Δομής 

• Εισαγωγή πλεονεκτημάτων και μειονεκτημάτων των εναλλακτικών 

Η διαδικασία γίνεται ως εξής: 

• Ανοίγουμε το Expert Choice, επιλέγουμε το: 

 Δημιουργία κενού μοντέλου και το «structuring» 
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• Αποθηκεύουμε το αρχείο μας.    

• Μεταφερόμαστε στο Cluster View Pane (πλαίσιο) του Expert Choice.  

• Εισάγουμε τις εναλλακτικές λύσεις επιλέγοντας από το μενού Edità 

Alternativeà Insert. 
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Το κάνουμε μέχρι να εισάγουμε μία- μία όλες τις εναλλακτικές. 

 

• Επιλέγουμε από το μενού View-à Alernative Pro/Con Pane 

Και μεταφερόμαστε στο παράθυρο όπου οι συμμετέχοντες θα προσθέσουν τα 

θετικά και τα αρνητικά για κάθε ιστοσελίδα πατώντας το κουμπί Add Pro όταν 

πρόκειται για κάποιο θετικό στοιχείο και το Add Con όταν θέλουμε να εισάγουμε 

κάποιο μειονέκτημα. Κάθε φορά επιλέγουμε από το πλαίσιο των εναλλακτικών αυτή 

στην οποία αναφερόμαστε και εισάγουμε αντίστοιχα το σχόλιο μας. 

Τα αρνητικά και θετικά στοιχεία που προέκυψαν, φαίνονται στις επόμενες 

εικόνες: 

Για το Google: 
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Για το Facebook: 

 

Για το Yahoo: 
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• Μετατροπή των πλεονεκτημάτων και μειονεκτημάτων σε κριτήρια 

Αφού τελειώσει αυτή η διαδικασία, θα ξεκινήσουμε να χτίζουμε την ιεραρχία 

των κριτηρίων τραβώντας και αφήνοντας (drag and drop) ένα θετικό ή αρνητικό 

στοιχείο στο Tree View Pane, δηλ. στο παράθυρο που μας δείχνει την ιεραρχική 

δομή. 

Η σειρά των θετικών και αρνητικών στοιχείων δεν έχει κάποια σημασία, έτσι 

μπορούμε να ξεκινήσουμε από όπου θέλουμε. 

Ξεκινώντας, πατάμε στο πλαίσιο που βρίσκονται οι εναλλακτικές, το 

Alternative Pane, το κουμπί All Pros/ Cons Pane και μας εμφανίζονται όλα τα θετικά 

και αρνητικά στοιχεία που εισάγαμε νωρίτερα. Επίσης, στο μεγάλο πλαίσιο δίπλα, 

πατάμε το κουμπί Tree View Pane για να μεταφερθούμε στο παράθυρο που θα 

βλέπουμε την ιεραρχική δομή. Θα έχουμε λοιπόν την παρακάτω εικόνα 
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Αφού λοιπόν μεταφερθούμε σε αυτήν την κατάσταση, επιλέγουμε το πρώτο στοιχείο 

που μας ενδιαφέρει από την λίστα των θετικών και αρνητικών και το σύρουμε επάνω 

στον στόχο μας, αριστερά. 

Μόλις γίνει αυτό. Θα μας ζητηθεί να επαναπροσδιορίσουμε πλέον το στοιχείο, ως 

κριτήριο. 

Ας το κάνουμε με το πρώτο στη σειρά στοιχείο για να δούμε πώς ακριβώς γίνεται: 

Επιλέγουμε το 1 που αναφέρεται στη Google και το σύρουμε στον στόχο. 
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Δίνουμε την ονομασία που ταιριάζει στο κριτήριο που δημιουργούμε. Στην 

συγκεκριμένη περίπτωση, το θετικό στοιχείο που αφορά στο Google είναι «Η πιο 

δημοφιλής μηχανή αναζήτησης» και αποφασίσαμε ότι το κριτήριο που μας ενδιαφέρει 

για την αξιολόγηση, είναι η «Επισκεψιμότητα- Χρήση της σελίδας». 

Συνεχίζουμε με αυτόν τον τρόπο μέχρι να εξαντληθούν όλα τα πλεονεκτήματα 

και μειονεκτήματα. Προσέχουμε φυσικά όπου κάποιο από αυτά αναφέρεται στο ίδιο 

κριτήριο, να μην το εισάγουμε για δεύτερη φορά. 

Τα κριτήρια που προκύπτουν με το πέρας της διαδικασίας λοιπόν, είναι τα 

εξής: 

• Επισκεψιμότητα σελίδας 

• Αισθητική 

• Φιλικότητα σελίδας προς τον χρήστη 

• Υπηρεσίες που προσφέρει η σελίδα 

• Ηλικία χρηστών 

• Μορφωτικό επίπεδο χρηστών 

• Κόστος της υπηρεσίας “pay per click” 

• Στοχευμένη διαφήμιση 

• Εμπειρία στη διαφήμιση 

Για να τα οργανώσουμε, πατάμε το κουμπί Cluster View Pane. Αφού 

μεταφερθούμε εκεί, θα δούμε τα κριτήρια σε σειρά. Για να τα οργανώσουμε, 

ελέγχουμε ποια κριτήρια θα μπορούσαν να ενταχθούν σε ομάδες. Αφού το 

αποφασίσουμε, δημιουργούμε την κάθε ομάδα που επιθυμούμε, και εισάγουμε τα 

υποκριτήρια που ανήκουν σε αυτή. 

Για να δημιουργήσουμε μία ομάδα, πατάμε στο κουμπί “Add 

Objective/Criterion”, δίνουμε το όνομα που θέλουμε και πατάμε “enter”. Ακολούθως, 

για να προσθέσουμε τα κριτήρια που ανήκουν στην ομάδα, απλά τα επιλέγουμε και 

τα μεταφέρουμε με “drag ‘n’ drop” μέσα στο πλαίσιο της κατηγορίας που 

δημιουργήσαμε.  
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Αρχικά, θα δημιουργήσουμε μια νέα κατηγορία με την ονομασία «Προφίλ 

Χρηστών» στην οποία στη συνέχεια θα εισάγουμε τα κριτήρια «Ηλικία χρηστών» 

και «Μορφωτικό Επίπεδο». 
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Συνεχίζουμε την οργάνωση των κριτηρίων και δημιουργούμε τις υπόλοιπες 

κατηγορίες που θέλουμε: 

• Design, στην οποία ανήκουν τα κριτήρια Αισθητική και Φιλικότητα προς τον 
χρήστη  

• Ποιότητα- Απόδοση Διαφήμισης, στην οποία θα εισάγουμε τα υποκριτήρια 

Στοχευμένη Διαφήμιση και Εμπειρία στη Διαφήμιση  

Μόλις τελειώσουμε, θα έχουμε την ακόλουθη εικόνα: 
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 Τέλος, πατάμε το κουμπί “Organize” για να τοποθετηθούν σε σειρά (οριζόντια 

ή κάθετα) τα κριτήριά μας. 

 

Αφού λοιπόν γίνουν όλα τα παραπάνω, έχουμε πλέον έτοιμη την δομή των 

κριτηρίων μας και μπορούμε να συνεχίσουμε στο επόμενο στάδιο, αυτό των 

δυαδικών συγκρίσεων. 

Αν μεταφερθούμε στο Tree View Pane, μπορούμε πλέον να δούμε την 

ιεραρχική δομή: 
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2.  Συγκρίσεις ανα ζεύγη κριτηρίων και εναλλακτικών 

Οι συγκρίσεις που μπορούν να γίνουν είναι τριών ειδών: Σημαντικότητας 
(Importance), Προτίμησης (Preference) και Πιθανότητας (Likelihood). 
Γενικά, όταν θέλουμε να συγκρίνουμε τα κριτήρια ενός στόχου, η πιο κατάλληλη 

σύγκριση είναι η σύγκριση  με βάση τη Σημαντικότητα (Importance). Αντίστοιχα,  

καλύτερο είναι να επιλέξουμε την σύγκριση βάσει Προτίμησης (Preference) όταν 

θέλουμε να συγκρίνουμε εναλλακτικές λύσεις. Τέλος, χρησιμοποιούμε την σύγκριση  

Πιθανότητας (Likelihood) όταν συγκρίνουμε τις πιθανότητες αβέβαιων γεγονότων και 

σεναρίων, όπως στην Ανάλυση Ρίσκου (Risk Analysis). 

 

Οι συγκρίσεις γίνονται με τρεις τρόπους και ονομάζονται: 

• Αριθμητικές, όπου σε μία κλίμακα του 1-9 αναπαρίσταται το πόσες φορές ένα 

στοιχείο είναι σημαντικότερο από αυτό με το οποίο συγκρίνεται. 

• Λεκτικές, όπου με τη χρήση των λέξεων Equal, Moderate, Strong, Very 

Strong, Extreme εκφράζεται το αποτέλεσμα της σύγκρισης το οποίο μπορεί 

να είναι από «Equal» το οποίο σημαίνει ότι τα δύο συγκρινόμενα στοιχεία 

είναι ίσης σημασίας μέχρι και «Extreme» το οποίο σημαίνει ότι το πρώτο 

στοιχείο από τα δύο που συγκρίνονται είναι απόλυτα πιο σημαντικό από το 

άλλο. Φυσικά, μπορεί να δοθεί και οποιοσδήποτε άλλος ενδιάμεσος 

χαρακτηρισμός. 

• Γραφικές, όπου η σύγκριση γίνεται σε οριζόντιες ραβδους οι οποίες δείχνουν  

το πόσες φορές ένα στοιχείο είναι σημαντικότερο από ένα άλλο, ανάλογα με 

το που θα μετακινήσουμε το δείκτη καθεμιάς. 

Για να επιλέγεί το είδος της σύγκρισης που θα ακολουθηθεί, πρέπει να γίνει 

επιλογή στο μενού: Αssessment  Type και μετά γίνεται η επιλογή του τύπου 

που χρειαζόμαστε. 

 

 

 

Σημείωση: Κάθε φορά που θα κάνουμε μία σύγκριση, θα κλικάρουμε το 
κριτήριο ως προς το οποίο θα γίνεται η σύγκριση αυτή. Εδώ π.χ., 
ξεκινάμε την πρώτη σύγκριση έχοντας κλικαρισμένο το κριτήριο 
«Επισκεψιμότητα σελίδας». 
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4.3 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΕΠΙΛΟΓΩΝ 

Επιλέγουμε από το μενού Assesmentà Pairwise και οδηγούμαστε στο 

παρακάτω  παράθυρο: 

 

Όπως μπορούμε να δούμε έχουμε τρεις γραμμές και τρεις στήλες με τις 

εναλλακτικές επιλογές. Βλέπουμε ότι στο κελί που διασταυρώνεται η πρώτη γραμμή 

και η πρώτη στήλη, δεν μπορεί να γίνει κάποια σύγκριση γιατί φυσικά το Google δεν 

μπορεί να συγκριθεί με τον εαυτό του. Έτσι, το πρόγραμμα μας οδηγεί κατευθείαν 

στο δεύτερο κελί της πρώτης στήλης το οποίο είναι κίτρινο. Αυτό μάλιστα είναι κάτι 

που μας δείχνει το πού γίνεται η σύγκριση κάθε φορά. 

Θέλουμε λοιπόν εν προκειμένω να συγκρίνουμε το πόσο ποιο σημαντικό είναι το 

Google σε σύγκριση με το Facebook με κριτήριο την Επισκεψιμότητα- Χρήση της 

σελίδας. 

Στοιχεία έρευνας από το www.searchenginemarketing.gr αναφέρουν ότι στην 

Ευρώπη γενικότερα αλλά και ειδικότερα στην Ελλάδα, το 79,2% των αναζητήσεων 

στο Ιντερνετ γίνονται μέσω του Google,ενώ μόλις το 2% μέσω του Yahoo. Επίσης, οι 

χρήστες που έχουν προφίλ στο Facebook στην Ελλάδα ανέρχονται σε αριθμό 

http://www.searchenginemarketing.gr
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μεγαλύτερο του 1.000.000. Αυτό σημαίνει πρακτικά ότι οι χρήστες που προτιμούν την 

μηχανή αναζήτησης της Google είναι 

Έχοντας ερευνήσει αποφασίζουμε ότι το Google είναι ΠόλυΈντονα (Very Strong) 
σημαντικότερο του Facebook όσον αφορά στην επισκεψιμότητα, στον αριθμό των 

χρηστών και για να το κάνουμε αυτό στο πρόγραμμα να φανεί, μετακινουμε τον 

δείκτη της μπάρας δεξιά προς τα πάνω και την σύρουμε μέχρι το Strong, ¨όπως 

φαίνεται αμέσως παρακάτω: 

 

 

Στο κίτρινο κελί εμφανίζεται ο αριθμός που αντιστοιχεί στην έκφραση Strong 

που είναι το 5, με άλλα λόγια δηλαδή το Google είναι 5 φορές σημαντικοτερο, σε 

σχέση με το Facebook με κριτήριο τον αριθμό των χρηστών της σελίδας. 

Αμέσως μετά, συνεχίζουμε τις συγκρίσεις στο διπλανό κελί, δηλ. συγκρίνουμε 

με βάση το ίδιο κριτήριο το Google και το Yahoo. Αφού γίνει και αυτό, θα μεταβούμε 

στο τελευταίο κελί που βρίσκεται στη δεύτερη γραμμή για να συγκρίνουμε και το 

Facebook με το Yahoo.  

Μόλις τελειώσουμε, έχουμε τα ακόλουθα αποτελέσματα: 
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Μόλις γίνουν όλες οι συγκρίσεις και θελήσουμε να προχωρήσουμε στο 

επόμενο κριτήριο, θα ρωτηθούμε αν θέλουμε να γίνουν οι υπολογισμοί και να 

καταγραφούν τα αποτελέσματά μας. Συμφωνούμε και επιστρέφουμε στο Mοdel View 

για να επιλέξουμε το επόμενο κριτήριο. 

Παρατηρούμε ότι οι πρώτοι υπολογισμοί έχουν γίνει και τα πρώτα 

αποτελέσματα είναι οι αριθμοί που εμφανίζονται δίπλα από τις εναλλακτικές. 
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Επιλέγουμε το κριτήριο «Υπηρεσίες που προσφέρει η σελίδα» και με την 

διαδικασία που αναφέραμε παραπάνω, δηλ. επιλογή Assessmentà Pairwise 

μεταφερόμαστε στο παράθυρο συγκρίσεων. 

Για μεγαλύτερη ευκολία, μπορούμε να χρησιμοποιήσουμε και ένα από τα τρία 

κουμπιά που βρίσκονται επάνω αριστερά του πλαισίου Model View και μας οδηγούν 

αυτόματα. (Επιλέγουμε ένα από τα τρία, ανάλογα με το αν θέλουμε η σύγκρισή μας 

να είναι Αριθμητική, Λεκτική ή Γραφική). 

Κάνοντας τα συγκρίσεις, έχουμε την εξής εικόνα: 

 

 

Στα κελιά που ο αριθμός εμφανίζεται κόκκινος, σημαίνει ότι η σύγκριση έδειξε την 

εναλλακτική της σειράς ως λιγότερο σημαντική της εναλλακτικής της στήλης. 

Επιστρέφουμε στο Model View αφού συμφωνήσουμε να γίνουν οι υπολογισμοί και 

να καταγραφούν τα αποτελέσματα. 
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Συνεχίζουμε μέχρι να κάνουμε τις συγκρίσεις για όλα τα κριτήρια. Οι 

συγκρίσεις και τα αποτελέσματα που προκύπτουν μετά από κάθε σύγκριση, 

φαίνονται στις παρακάτω εικόνες: 

• Κόστος της υπηρεσίας «pay per click»: 
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Συγκρίσεις: 

 

Σημειώνεται, ότι σε αυτό το κριτήριο, πιο σημαντική θεωρείται η εναλλακτική η οποία 

έχει χαμηλότερο κόστος. 

Προοδευτικά αποτελέσματα: 
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• Ηλικία χρηστών 

 

 

Συγκρίσεις: 
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Στο κριτήριο ηλικία χρηστών, συγκρίνουμε λαμβάνοντας υπ’όψιν το ότι η εταιρεία 

στοχεύει σε άτομα ηλικίας 15-35. Έτσι, το Facebook προκύπτει σημαντικότερο των 

Google και Υαhoo, αφού αυτός είναι και ο μέσος όρος ηλικίας του 80% των χρηστών 

του. 

Προοδευτικά αποτελέσματα: 

 

• Μορφωτικό Επίπεδο Χρηστών 
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Συγκρίσεις: 

 

Σε αυτό το κριτήριο, η εταιρεία αντιμετώπισε το εξής πρόβλημα:δεν μπόρεσε 

να βρει κάποιο μετρήσιμο στοιχείο που να δείχνει ποιο είναι το μορφωτικό επίπεδο 

των χρηστών κάθε εναλλακτικής επιλογής. Βάσει αυτού αλλά και του γενικού προφίλ 

του χρήστη Internet στην Ελλάδα που περιγράφεται στην ιστοσελίδα Παρατηρητήριο 

για την Κοινωνία της Πληροφορίας www.observatory.gr και αναφέρει ότι το 

συντριπτικό ποσοστό των χρηστών είναι άτομα τουλάχιστον λυκειακής μόρφωσης, 

αποφάσισε ότι δεν μπορεί να θεωρήσει ότι κάποια ιστοσελίδα υπερτερεί της άλλης. 

Έτσι, σε όλες τις συγκρίσεις επιλέξαμε «equal». 

Προοδευτικά Αποτελέσματα (που τα ποσοστά είναι ίδια, σε αυτή την περίπτωση): 

 

http://www.observatory.gr
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• Αισθητική σελίδας 

 

Συγκρίσεις: 

 

Οι συγκρίσεις έγιναν κυρίως βάσει της προτίμησης των ατόμων της ομάδας 

της απόφασης. Έτσι το Facebook  φάνηκε ότι είναι το πιο ευχάριστο αισθητικά site, 

το Google δεν φάνηκε να προκαλεί κάτι με την εμφάνισή του, αφου είναι μία μηχανή 
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αναζήτησης, ενώ το Yahoo κρίθηκε ως μέτρια προτιμότερο του Google γιατί είναι ένα 

portal με καλή αισθητική και μικρό scroll σελίδας. 

Προοδευτικά αποτελέσματα: 

 

• Φιλικότητα προς τον χρήστη 
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Συγκρίσεις: 

 

Οι συγκρίσεις σε αυτό το κριτήριο ακολούθησαν την εξής λογική: το Google 

είναι μία φιλικότατη μηχανή αναζήτησης, όπου και ο πλέον αρχάριος γράφοντας 

κάποιες λέξεις κλειδιά, θα βρει πράγματα σχετικά με την αναζήτησή του. Το 

Facebook από την άλλη πλευρά, είναι μία πολύ ενδιαφέρουσα ιστοσελίδα με πολλές 

εφαρμογές, που όμως μπορεί αρχικά να μπερδέψουν κάποιον και σίγουρα χρειάζεται 

ενασχόληση αρκετών ωρών για να εξοικειωθεί κάποιος με τη χρήση αυτού. Το 

Yahoo, τέλος, είναι ένα Portal με πολλές πληροφορίες όμως είναι στην αγγλική 

γλώσσα και αυτό σίγουρα δεν ελκύει τους περισσότερους έλληνες. 

Προοδευτικά αποτελέσματα: 
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• Στοχευμένη Διαφήμιση 

 

Συγκρίσεις: 

 

To Google χρησιμοποιεί την υπηρεσία Adwords η οποία όταν κάνουμε μία 

αναζήτηση, δίπλα από τα αποτελέσματα που μας επιστρέφει, μας εμφανίζει και 

συνδέσμους διαφημιζόμενων sites τα οποία έχουν σχέση με την αναζήτηση που 

κάναμε. Το πρόγραμμα βοηθά πολύ στη στόχευση της διαφήμισης, όμως θεωρήσαμε 

το Facebook σημαντικότερο, γιατί αντλεί τεράστιο αριθμό και είδος προσωπικών 
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στοιχείων από τους χρήστες με τις πολυάριθμες εφαρμογές που διαθέτει. Τα στοιχεία 

αυτά οργανώνονται σε βάσεις δεδομένων και με την κατάλληλη επεξεργασία  μας 

εμφανίζουν διαφήμισεις απόλυτα «κομμένες και ραμμένες» στα στοιχεία κάθε 

χρήστη. Τελος, το Yahoo έχει αναπτύξει ένα πρόγραμμα ανάλογο της Google το 

Search Marketing, που είναι ίσως η δεύτερη καλύτερη επιλογή μετά την υπηρεσία 

Adwords.  

Προοδευτικά Αποτελέσματα: 

 

• Εμπειρία στη διαφήμιση 
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Συγκρίσεις 

 

Σε αυτό το κριτήριο, οι συγκρίσεις ακολούθησαν την εξής λογική: η εταιρεία 

Google είναι αδιαμφισβήτητα ο πρωτοπόρος στο χώρο της διαφήμισης, με πολύ 

αποδοτικά και ολοκληρωμένα προγράμματα. Οι διαχειριστές του κομματιού της 

διαφήμισης έχουν πολλή εμπειρία και έτσι κατάφεραν να δημιουργήσουν τα 

καινοτόμα προγράμματα που προσφέρει και να κάνουν συμφωνίες με παρα πολλά 

site για συνεργασία. Όλοι έχουμε δει σε διάφορες σελίδες να υπάρχει κάποιο πλαίσιο 

με διαφημιστικά Links της Google. Έτσι, θεωρήσαμε ότι είναι Έντονα  προς Πολύ 

Έντονα σημαντικότερο του Facebook και του Yahoo. 

Σε σχέση με το Facebook , η παραπάνω σκέψη και κρίση ενισχύεται από το 

γεγονός ότι το συγκεκριμένο site υπάρχει μόλις από το 2004 και ο δημιουργός του 

είναι μόλις 24 ετών. Αυτός έίναι ο ηγέτης που διαχειρίζεται και συντονίζει τη 

διαφήμιση στη σελίδα του με μία ομαδα συνεργατών που σίγουρα δεν θα μπορούσε 

προς το παρόν να θεωρηθεί πιο έμπειρη από τους «καρχαρίες» της Google.  

Τέλος, η Yahoo τελευταία κάνει φιλότιμες προσπάθειες. Όμως, ουσιαστικά έχει 

αντιγράψει την Google στα  προγράμματα διαφήμισης γιατί δεν υπάρχει η ανάλογη 

εμπειρία και τεχνογνωσία στο ανθρώπινο δυναμικό της διαφήμισης. Το γεγονός αυτό 
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φανερώθηκε έντονα μάλιστα, το 2008 όπου η Google θέλησε να χρησιμοποιήσει την 

«πλατφόρμα» της Yahoo και να συνεργαστεί με αυτή στον τομέα της διαφήμισης. H 

τελευταία, έδειξε έντονα ότι επιθυμεί τη συνεργασία, αφού θα της απέφερε αρκετά 

κέρδη και θα μπορούσε να εκμεταλλευτεί την εμπειρία  και την τεχνογνωσία της 

ηγέτιδας εταιρείας. 

 Η συμφωνία τελικά δεν επετεύχθη αφού η Google φοβήθηκε ότι το 

αμερικανικό υπουργείο Δικαιοσύνης θα έθετε θέμα μονοπωλιακής τακτικής εκ μέρους 

των εταιρειών και έτσι η συμφωνία ματαιώθηκε. 

Προοδευτικά Αποτελέσματα 

 

 

Τελειώνοντας με τις συγκρίσεις των εναλλακτικών ως προς κάθε κριτήριο, θα 

συνεχίσουμε στις συγκρίσεις και τον ορισμό βαρύτητας- σημαντικότητας για κάθε ένα 

κριτήριο σε σχέση με τα υπόλοιπα. Αυτό θα καθορίσει και τα αποτέλεσμα της 

απόφασης. 
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4.4 ΣΥΓΚΡΙΣΗ ΚΡΙΤΗΡΙΩΝ- ΑΝΤΙΚΕΙΜΕΝΙΚΩΝ ΕΠΙΜΕΡΟΥΣ ΣΤΟΧΩΝ 

A) Σύγκριση υποκριτηρίων: 

Επιλέγουμε (ενώ βρισκόμαστε στο Model View) το κριτήριο «Προφίλ Χρηστών» και 

από το μενού AssessmentàPairwise. 

Οδηγούμαστε στο παράθυρο των λεκτικών συγκρίσεων. 

Eναλλακτικά, μπορούμε να πατήσουμε απευθείας την καρτέλα των λεκτικών 

συγκρίσεων, που βρίσκεται πάνω αριστερά:  

 

• Ηλικία χρηστών- Μορφωτικό επίπεδο χρηστών 

Συγκρίσεις 

 

Επιστρέφουμε στο Model View για να επιλέξουμε το επόμενο κριτήριο που 

περιέχει υποκριτήρια. Μόλις πατήσουμε την καρτέλα του Model View θα μας 

εμφανιστεί το παράθυρο διαλόγου που θα μας ρωτά αν θέλουμε να καταγραφούν οι 

υπολογισμοί. Επιλέγουμε «ναι» και επιστρέφουμε στο Model View. 

• Design 

• Αισθητική σελίδας- Φιλικότητα προς τον χρήστη 
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Συγκρίσεις 

 

• Ποιότητα διαφήμισης 

• Στοχευμένη διαφήμιση- Εμπειρία στη διαφήμιση 

Συγκρίσεις 

 

Αν και στα άλλα υποκριτήρια αποδώσαμε ίση βαρύτητα μεταξύ τους, εδώ 

θεωρήσαμε το υποκριτήριο «Στοχευμένη διαφήμιση» Πολύ έντονα σημαντικότερο της 

«Εμπειρίας στη διαφήμιση» , γιατί μας ενδιαφέρει πάρα πολύ να εστιάσουμε σε 
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χρήστες με κάποια συγκεκριμένα δημογραφικά χαρακτηριστικά. Είναι οι δυνητικοί 

πελάτες στους οποίους θέλουμε να προωθήσουμε το προϊον μας. 

 

B) Σύγκριση κριτηρίων 

• Από το TreeView, την ιεραρχική δομή δηλ. που εμφανίζεται στο ModelView, 

επιλέγουμε τον στόχο (Goal). 

• Έπειτα, πατάμε στην καρτέλα των Αριθμητικών συγκρίσεων  

 

 

 

και μεταφερόμαστε στο ανάλογο παράθυρο (συγκρίσεων).  

 

 

Εδώ, εμφανίζονται όλα τα κριτήρια ή αλλιώς οι αντικειμενικοί επιμέρους στόχοι 

της απόφασης. Θα τα συγκρίνουμε όλα μεταξύ τους ανά ζεύγη για να δώσουμε στο 

καθένα την βαρύτητα- προτεραιότητα που θέλουμε, αναφορικά με τον σκοπό της 

απόφασης. 
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Συγκρίσεις ανά ζεύγη ,όλων των κριτηρίων: 

 

 

Αφού γίνουν όλες οι συγκρίσεις, παρατηρούμε ότι το κουμπί Calculate στη 

γραμμή εργαλείων, έχει γίνει πράσινο.  

Αυτό σημαίνει ότι όλες οι συγκρίσεις έχουν γίνει και μπορεί να γίνει ο 

υπολογισμός για να λάβουμε τα 

αποτελέσματά μας. 

 

Σημείωση: Αν το κουμπί υπολογισμού είναι κόκκινο, σημαίνει ότι οι συγκρίσεις 
που έχουν γίνει δεν επαρκούν για να γίνει ο υπολογισμός. Αν είναι κίτρινο, 
σημαίνει ότι δεν έχουν γίνει όλες οι συγκρίσεις, όμως ο αριθμός αυτών είναι 
ικανός για να γίνει ο υπολογισμός των προτεραιοτήτων. 

 

• Πατάμε το κουμπί Υπολογισμού 
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Αποτελέσματα 

 

• Ταξινομούμε με φθίνουσα σειρά τις προτεραιότητες: 
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Και βλέπουμε ποια κριτήρια προέκυψαν ως πιο σημαντικά. 

Παρατηρούμε όμως, ότι ο βαθμος ασυνέπειας είναι 0,2 ενώ συνήθως αποδεχόμαστε 

ασυνέπεια γύρω στο 0,1. Για να το διορθώσουμε, κάνουμε τα εξής: 

• Επιστρέφουμε στο παράθυρο λεκτικών συγκρίσεων 

• Επιλέγουμε από το μενού Inconsinstency à 1st 

• Βλέπουμε ότι το πρόβλημα βρίσκεται στη σύγκριση των κριτηρίων «Προφίλ 

Χηστών- Ποιότητα διαφήμισης». 

• Επιλέγουμε από το μενού Inconsistency à Best Fit 

 

• Tο πρόγραμμα μας υποδεικνύει ότι η αριθμητική τιμή θια έπρεπε να είναι 3,1 

αλλά αντίστροφα, δηλαδή η σύγκριση να δείξει ότι το 2ο κριτήριο είναι 3 

φορές σημαντικότερο του πρώτου.  

• Το διορθώνουμε, πατάμε το κουμπί υπολογισμού και βλέπουμε τα 

αποτελέσματα: 
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• Ο βαθμός ασυνέπειας είναι τώρα 0,08 και δεν χρειάζεται κάποια άλλη 

διόρθωση. 

• Επιστρέφουμε στο Model View 
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και βλέπουμε τις προτεραιότητες που έχουν προκύψει μετά από τις συγκρίσεις των 

κριτηρίων. 

 

4.5 ΣΥΝΘΕΣΗ- ΛΗΨΗ ΤΩΝ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

Επιλέγουμε Synthesizeà With respect to goal και θα εμφανιστεί το παράθυρο της 

σύνθεσης με τα αποτελέσματα: 

 

Βλέπουμε ότι την υψηλότερη προτεραιότητα έλαβε το Google (0,441), δεύτερο 

ήρθε το Facebook (0,418) και τελευταίο το Yahoo (0,140). 

Η εταιρεία λοιπόν θα επιλέξει να διαφημιστεί μέσω του Google, αν και η 

διαφορά με το Faebook δεν είναι μεγάλη και ίσως κάποιος να έθετε ένα θέμα 

προτίμησης προς σε αυτό, αφού είναι πολύ δημοφιλές τον τελευταίο καιρό. 

Παρατήρηση: 

• Βλέπουμε στο παράθυρο των αποτελεσμάτων ότι είναι επιλεγμένο το Ideal 

Mode και όχι το Distributive Mode. Στην περίπτωσή αυτού του προβλήματος 

επιλέγουμε το Ideal Mode γιατί μας ενδιαφέρει μόνο μία εναλλακτική λύση. 
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Αν είχαμε κάποιο πρόβλημα όπου θα μας ενδιέφερε κυρίως το να θέσουμε 

προτεραιότητες σε όλες τις εναλλακτικές για να επιλέξουμε κάποιες από 

αυτές, θα επιλέγαμε το Distributive Mode. Στην πράξη βέβαια, δεν θα 

παρατηρήσουμε ιδιαίτερες διαφορές μεταξύ των δύο τρόπων έκθεσης των 

προτεραιοτήτων. 

 

4.6 ΑΝΑΛΥΣΗ ΕΥΑΙΣΘΗΣΙΑΣ- ΔΥΝΑΜΙΚΗ ΑΝΑΛΥΣΗ 

Θα χρησιμοποιήσουμε την Δυναμική ανάλυση ευαισθησίας, η οποία μας δίνει 

τη δυνατότητα να καταλάβουμε τις αλλαγές που θα επέλθουν στις προτεραιότητες 

των εναλλακτικών, αν αλλάξουμε τις προτεραιότητες των κριτηρίων. Βλέπουμε 

δηλαδή, πόσο θα άλλαζε η απόφασή μας αν τελικά θεωρούσαμε πιο σημαντικά 

κάποια από τα κριτήρια που ήρθαν δεύτερα ή τρίτα  ή τέταρτα κ.ο.κ στην 

προτεραιότητα.     

• Από το Model View επιλέγουμε τον στόχο. 

• Από το μενού επιλέγουμε Sensitivity Graphs à Dynamic 

Εμφανίζεται το παρακάτω γράφημα: 
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Στην αριστερή πλευρά βλέπουμε τις προτεραιότητες των κριτηρίων σε 

εκατοστιαίο ποσοστό. Στη δεξιά, βλέπουμε τις προτεραιότητες των εναλλακτικών σε 

ποσοστό επί τοις εκατό και αυτές. 

Αν επιχειρήσουμε να αλλάξουμε κάποιο από τα κριτήρια, θα δούμε δεξιά και 

την αλλαγή που θα επέλθει και στις εναλλακτικές. Π.χ., αν αλλάξουμε το ποσοστό του 

κριτηρίου του «Κόστους» και το πάμε στο 43,5%, θα δούμε ότι αυτομάτως αλλάζουν 

και τα ποσοστά των εναλλακτικών και ως πρώτη εναλλακτική προκύπτει το 

Facebook με μεγάλη διαφορά από το δεύτερο. 

 

 

  

Κάνοντας ένα ακόμη παράδειγμα και αλλάζοντας όλα τα κριτήρια έτσι ώστε το 

κριτήριο «Επισκεψιμότητα σελίδας» να έχει το πιο μικρό ποσοστό, θα δούμε ότι το 

Faebook βγαίνει και πάλι πρώτο ως εναλλακτική. 
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Αν βάλουμε το κριτήριο «Ποιότητα διαφήμισης» περίπου στο 20% κι όλα τα 

άλλα κριτήρια σε σχεδόν ίσο ποσοστό μεταξύ τους, θα δούμε ότι και πάλι το 

Facebook είναι πρώτο ως εναλλακτική. Αυτό, καταδεικνύει ότι το τελικό αποτέλεσμα 

εξαρτήθηκε από το κριτήριο «Επισκεψιμότητα σελίδας» που εκτιμήθηκε από τους 

αποφασίζοντες ως πολύ σημαντικό κριτήριο. 

 

4.7 ΣΥΜΠΕΡΑΣΜΑΤΑ 

Η εταιρεία θα χρησιμοποιήσει για τους σκοπούς της διαφήμισής της, το 

Google. To Expert Choice συνδυάζοντας όλα τα στοιχεία που εισήχθησαν, μας 

οδήγησε στη βέλτιστη λύση του προβλήματος. Επίσης, σε κάθε φάση μπορούσαμε 

να γυρίσουμε πίσω και να αλλάξουμε ό,τι νομίζαμε πως δεν έχουμε εκτιμήσει σωστά. 

Ακόμη, το λογισμικό μας βοήθησε στη φάση των συγκρίσεων των κριτηρίων όπου 

παρουσιάστηκε ασυνέπεια, αφού μας έδειξε πού βρίσκεται η ασυνέπεια των 

συγκρίσεών μας και ποια είναι η πιο σωστή τιμή για τη σύγκριση αυτή.   



160 
 

Γενικότερα, το Expert Choice είναι ένα πολύ χρήσιμο λογισμικό το οποίο 

εφαρμόζει την μέθοδο της Αναλυτικής Ιεράρχησης που είναι πολύ πετυχημένη 

τεχνική στη λήψη αποφάσεων. 

Μας δίνει τη δυνατότητα να χρησιμοποιήσουμε ποιοτικές και ποσοτικές 

μεταβλητές κάτι που είναι πολύ χρήσιμο, αφού συνήθως στα προβλήματα 

αποφάσεων εμπλέκονται και των δύο ειδών οι μεταβλητές.  

Είναι ένα λογισμικό εύχρηστο και ευκολονόητο για τους περισσότερους, 

καθώς δεν χρειάζονται εξειδικευμένες γνώσεις για να το χειριστεί κάποιος. 

Τέλος, μπορεί να μας βοηθήσει να λάβουμε αποφάσεις σε πολλά θέματα, 

όπως η Αξιολόγηση Προσωπικού, η Επιλογή τοποθεσίας εγκαταστάσεων, η 

Αξιολόγηση Προμηθευτών, η Διαχείριση Χαρτοφυλακίου και σε πολλές άλλες 

πολυκριτήριες αποφάσεις που προκύπτουν σε μία επιχείρηση. Είναι ένα χρησιμότατο 

εργαλείο για κάθε επιχειρηματία και κάθε διοικητικό στέλεχος. 
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